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Introduction
Oracle's AutoVue suite of enterprise visualization solutions provides native 
document viewing, markup and real-time collaboration capabilities that enable 
Web-based document review on hundreds of native document types, including 
2D/3D CAD, EDA, Office and graphic formats. 
AutoVue enterprise visualization solutions address the challenge of accessing, 
reviewing and collaborating on documents, both internally and with globally 
dispersed teams and partners, in a secure and reliable manner without 
compromising security or precision. Improved team productivity, reduced errors, 
and accelerated innovation and time to market are just a few of the business 
benefits organizations can expect to achieve.
The following User Guide explores AutoVue's key capabilities and is designed to 
help you get the most out of AutoVue's extensive functionality. 

Oracle AutoVue
Oracle AutoVue is a viewing and markup application that has been developed 
for both business and technical users.
AutoVue is capable of displaying hundreds of file formats without the authoring 
application. Supported file types include Text, Office, Graphics, EDA, 2D 
Engineering, and 3D Models. Even contents of archive files can viewed in 
AutoVue. Moreover, when you view a file, you do not need to specify the file 
type. AutoVue automatically detects the type of file you are requesting to view, 
even if a file has an incorrect extension.

Marking Up Documents
AutoVue has the ability to create markups for all its readable file formats without 
the document's authoring application. AutoVue creates markups for different 
formats without modifying the original file.
You can attach comments, notes, and drawings to any file you display in 
AutoVue. This is called “marking up a file”, commonly known as annotating or 
redlining. A markup is an object or entity that you attach to a file. All markups 
are saved in a separate file called a Markup or a Markup file. When you display 
a file with its markups, the markups are overlaid as a layer on top of the drawing.
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AutoVue provides a variety of flexible, user-friendly entities. To name a few, 
there are circles, clouds, polygons, and leaders. You can also attach text to 
entities, insert a note for longer comments, add attachments, or add a stamp such 
as a company logo. In addition, you can create measurement markup entities and 
hyperlinks that link between the current file and other associated files or 
applications.
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File Versions Information
The About dialog box displays AutoVue version and build information. You can 
also view the version, build number, and build date of DLLs that are shipped with 
AutoVue. You can also export this information into a text file.

Viewing File Versions
1 From the Help menu, select About.

The About dialog box appears.
2 Click Version Info.

The File Versions dialog box appears listing file names, versions, and build 
dates.

3 When you are finished viewing the file version information, click Close.

Exporting File Versions
1 From the Help menu, select About.

The About dialog box appears.
2 Click Version Info.

The File Versions dialog box appears listing file names, versions, and build 
dates.

3 Click Export.
The Export dialog box appears.

4 Navigate and select the directory to which you want to export the list.
5 Enter a file name with the extension .txt (the default name is fverinfo.txt).

Note: The list can only be exported to a text file.
6 Click Save.

The list is exported to the specified file.
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AutoVue Graphical User 
Interface
This section introduces you to the basics of working with AutoVue’s graphical 
user interface (GUI). The following image displays the AutoVue GUI for a 3D 
drawing:

Menu Bar
The menu bar is the main access to all the menu commands. The selection of 
commands changes according to the tasks being accomplished by AutoVue.
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Toolbars
AutoVue has three toolbars: AutoVue toolbar, Markup Properties toolbar, and 
Markup Entity toolbar. 

AutoVue Toolbar
The AutoVue toolbar displays below the menu bar when you open AutoVue. It is 
the default toolbar and includes the most commonly used functions when 
viewing a file—open a file, create a new markup, print, zoom, and many others. 
Depending on the file that is opened, the toolbar buttons will change. For 
example, the following image shows the AutoVue toolbar when a 3D file is open: 

Markup Properties Toolbar
The Markup Properties toolbar displays below the AutoVue toolbar when you 
enter Markup mode. It includes the available property and formatting options for 
the markup entities—save markups, change font, fill type, line style, and many 
others. The following image shows the default Markup Properties toolbar: 

See Also  Markups

Markup Entity Toolbar
The Markup Entity toolbar displays on the left side of the AutoVue window when 
you enter Markup mode. It includes all the available markup entities for the 
opened file. Depending on the file that is opened, the toolbar buttons will change. 
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For example, the following image shows the Markup Entity toolbar when a 3D 
file is open:

See Also  Markups
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Navigation Panel
The Navigation Panel is displayed on the left-hand side of the AutoVue 
workspace. Depending on the type of file that is open in AutoVue, the 
Bookmarks, Components, Models, Nets, or Views tabs will display in the panel.

See Also  Working with EDA Files
Working with 3D Files

Bookmarks Tab
The Bookmarks tab includes links to specific views (Draft views, 2D plans) or 
other files with information related to the drawing. Additionally, with the 
Bookmarks tab, you can also browse through different chapters of PDFs, Excel 
worksheets, and different pages of a multi-page 2D drawing. 
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Components Tab 
The Components tab lists component instances and the associated pins. 
Note: The Components tab displays only for EDA drawings.
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Nets Tab 
The Nets tab lists nets and associated net nodes (pins connected to a net). 
Note: The Nets tab displays only for EDA drawings. 

Models Tab and Model Tree
The Models tab includes the Model Tree. The tree displays the model’s 
hierarchy, inter-relation of different parts, assemblies, bodies, and missing XRef 
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notifications. With the tree, you can select different parts and modify their 
attributes such as color, visibility, render mode or transformation.
Note: The Models tab displays only for 3D drawings.

See Also  Models Tab
Model Tree

Views Tab 
The Views tab lists all the standard, native, and user-defined views. You can 
switch to a standard, native, or user-defined view, as well as add or delete user-
defined views.
Note: The Views tab displays only for 3D drawings.

See Also  Views Tab
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Markup Navigation Tree
The Markup Navigation Tree displays when you enter Markup mode. It displays 
a hierarchy tree of markup entities or comments created by users. For example, 
the following image shows the tree with three line entities:

See Also  Markup Navigation Tree

Status Bar
In both View mode and Markup mode, there is a status bar located at the bottom 
of the main window. The fields displayed from left to right on the status bar are: 
marker, current active filename, file type, zoom factor, current page and total 
number of pages, current active file size, file creation date, and cursor’s 
coordinate position. The following image shows the status bar:

There are two markers that may be present on the Status bar: the Markup 

Indicator icon  indicates associated markups, and the Resource icon  
indicate missing resources.
The Markup Indicator indicates that the current active file has associated 

markups. While in View mode, click the Markup Indicator icon  to view 
the Markup Files dialog box, then select a Markup file or group of Markup files 
to open. 
The Resource icon indicates that some main resources required to properly read 
the current active file are not available. To identify the missing resources, click 
the Resource icon to display the Properties dialog box.
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Quick Menus
One of the quickest ways to access options is through Quick Menus or context-
sensitive shortcut menus. These are the menus you see when you right-click in 
the workspace, Markup Navigation Tree, and Model Tree. The available Quick 
Menu options depend on the location where you right-click.
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Opening Files
You can open base files and Markup files from the File menu and Markup menu, 
respectively. Additionally, you can open a file from the current active directory or 
from another directory, or manually specify the file to open by entering the URL.

Opening a Local File
1 From the File menu, select Open Local File.

The File Open dialog box appears.

Note: From the AutoVue toolbar, you can also click Open Local File .
2 Browse to locate the file that you want to open.
3 Click Open.

The file appears in the AutoVue workspace.

Opening a URL
You can open a file by specifying the URL.
1 From the File menu, select Open URL.

The File Open dialog box appears.
2 In the File Name field, enter the URL HTTP or FTP of the path, or click 

Browse to locate the file that you want to open.
3 Click OK.

The file appears in the AutoVue workspace.

Opening a File from the Server
1 From the File menu, select Open from Server from the AutoVue main 

menu.
The File Open dialog box appears.
Note: The Open from Server option is available in the File menu only if 
you have access to files on the server. Refer to the Installation and 
Administration Manual for information on setting up server directories using 
VueServer.ini.

2 Browse the directory to locate the file that you want to open.
3 Click Open.

The file appears in the AutoVue workspace.
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Archive Files
The full archive file directory displays in the AutoVue window. It is not 
necessary to decompress the file. Double-click a file to display it within 
AutoVue. If you would like to markup an archive file, the file must be accessible 
for AutoVue in a format other than archive.

Streaming File
AutoVue generates a streaming file when a native file is opened for the first time. 
The streaming file contains display information for the native file and is quickly 
accessed by AutoVue. When AutoVue accesses the file again, it loads the display 
from the streaming file instead of the native file. As a result, the loading time of 
the display decreases.
If the native file changes, the streaming file is invalid. In this case, AutoVue 
opens the display from the native file and generates a new streaming file.

Viewing File Properties
You can access the file properties from the File menu. The Properties dialog box 
provides information specific to the current active file, such as filename, file size, 
date of creation, and file type. The file properties that you can view are:

Note: The file properties can vary depending on the file format viewed.
1 From the File menu, select Properties.

The Properties dialog box appears.
2 To view file properties, click the File Properties tab.

To view resource information, click the Resource Information tab.

Property Description

File Information specific to the current active file, such as filename, file 
size, date of creation, file type, and x, y & z dimensions.

Resource 
Information

Resources specific to the current active file, such as text font, 
shape file, line style, and external reference files.

Native Custom properties for file types, such as last person who saved the 
file, signature verification, and author comments.
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To view native properties, click the Native Properties tab.
3 Click OK to close the Properties dialog box.
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Working With 2D Files
AutoVue provides easy access to entity information and displays color-coded 
comparative data for 2D drawings. You can instantly change how the current 
active file is displayed. You can also modify AutoVue to suit your needs and 
preferences through a broad range of configuration options.

Searching Text
You can perform a text search on 2D vector and text-based documents.
Note: You cannot perform a text search on raster files.
AutoVue provides search options that you can use to customize a search. These 
options are:

1 From the Edit menu, select Find Text.
The Find dialog box appears.

2 Enter the word or phrase that you want to find in the Find What field.
Note: If you are searching in a vector file, select a text string from the list.

3 You can refine your search by selecting Match Whole Word Only or 
Match Case.

4 Click Find Next.
AutoVue highlights the text and zooms into the text area.

5 Click Close to close the Find dialog box.

Option Description

Match Whole Word Only Match a complete word.

Match Case Search for a word or text string with specific 
capitalization.

Up Search backward in the document.

Down Search forward in the document.
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2D Viewing Options
From the View menu, you can change how the active file is displayed in the 
workspace. For example, you can rotate a file’s orientation clockwise, 
counterclockwise, or flip a file’s orientation along the horizontal or vertical axis.
You can access these options from the View menu. The options are:

Menu Sub-Menu Description

Zoom Zoom Box Click and drag to draw a box around an object that 
you want to enlarge to fill the window.

From the Autovue toobar, you can also click  
or right-click in workspace and select from pop-up 
menu.

Zoom In Zoom in by a factor of 2.

From the AutoVue toobar, you can also click .

Zoom Out Zoom out by a factor of 2.

From the AutoVue toobar, you can also click .

Zoom Previous Reverts to the previous zoom level.

From the AutoVue toobar, you can also click .
Note: You can also right-click the workspace and 
select Zoom - Previous.

Full Resolution Display the file at full resolution.

From the AutoVue toobar, you can also click .

Fit Horizontal Fit the image horizontally in the active window. The 
vertical dimensions of the image are zoomed 
proportionally but may be too large or small for the 
window.
Note: You can also right-click the workspace and 
select Zoom - Page Width.

Vertical Fit the image vertically in the active window. The 
horizontal dimensions of the image are zoomed 
proportionally but may be too large or small for the 
window.
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Both AutoVue finds the best fit for the current file with 
respect to both its vertical and horizontal 
dimensions.

From the AutoVue toobar, you can also click .
Note: You can also right-click the workspace and 
select Zoom - Fit.

Magnify 
Glass

Magnify an area of the file that is specified by the 
cursor location.
See  Using the Magnify Glass

Magnify 
Window

Magnify a selected area of a file and displays it in 
the Magnify Window.
See  Using the Magnify Window

Pan and 
Zoom 
Window

Display a close-up view of a particular area of a file 
while maintaining a view of the entire file.

From the AutoVue toobar, you can also click .
Note: The Pan and Zoom Window option is 
disabled for text-based documents and 
spreadsheets.
See  Using the Pan and Zoom Window

Pan Click and drag to move the drawing. To exit right-
click.

From the AutoVue toobar, you can also click .
Note: 

Note: Note: The Rotate option is disabled for text-based documents and 
spreadsheets.

Rotate Rotate Clock-
wise

Rotate the file 90 degrees clockwise.

From the AutoVue toobar, you can also click .

Rotate Counter 
Clockwise

Rotate the file 90 degrees counter clockwise.

From the AutoVue toobar, you can also click .

Menu Sub-Menu Description
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Using the Magnify Glass
The Magnify Glass view option displays the magnified area at the cursor 
location. You can view the details of a selected area of a file while maintaining a 
full view of the file.
1 From the View menu, select Magnify Glass.
2 Move the cursor to the area that you want to magnify.
3 Click and hold the left mouse button. 

The magnified area appears in the Magnify Glass.
Note: To view different areas of the file, click and drag the mouse.

4 Right-click to exit Magnify Glass view.

Using the Pan and Zoom Window
The Pan and Zoom Window view option allows a close-up view of a particular 
area of a file while maintaining a full view of the file. The Pan and Zoom 
Window displays a miniature version of the file and has a movable box frame on 
top of the miniature to indicate the area of the file displayed in the AutoVue 
workspace.

Flip Horizontal Axis Flip the drawing on its horizontal axis.

From the AutoVue toobar, you can also click .

Vertical Axis Flip the drawing on its vertical axis.

From the AutoVue toobar, you can also click .

Page Next Go to the next page of a multi-page file. 

From the AutoVue toobar, you can also click .

Previous Go to the previous page of a multi-page file.

From the AutoVue toobar, you can also click .

Page Number Go to the specified page of a multi-page file.

From the AutoVue toobar, you can also click .

Menu Sub-Menu Description
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Note: The Pan and Zoom Window option is disabled for text-based documents 
and spreadsheets.
1 From the View menu, select Pan and Zoom Window. 

The Pan and Zoom Window appears displaying a full view of the file.
Note: From the AutoVue toolbar, you can also click Pan and Zoom 

Window .
2 From the Options menu, select Dynamic to view the changes in “real time”.
3 To view a close-up of a specific area of the file in the AutoVue workspace, 

minimize the frame box by clicking and dragging the frame handles.
To view a different area of the file in the AutoVue workspace, click and drag 
the frame box to the area that you want to view.
Note: If you perform a zoom function in the AutoVue workspace, the area 
displayed in the workspace is highlighted by the frame box in the Pan and 
Zoom Window.

4 From the Pan and Zoom menu, select Exit to close the window.
The last view performed remains in the AutoVue workspace.

Using the Magnify Window
The Magnify Window option displays the magnified area in a window that 
updates dynamically. You can click and drag the window to any location on your 
screen, view the details of a select portion of the displayed file while maintaining 
the display of the full file.
1 From the View menu, select Magnify Window. 

The Magnify Window appears.
2 Move the cursor to the area that you want to magnify in the current active 

file.
3 Click once. 

The area appears magnified in the Magnify Window. 
4 Right-click to exit the Magnify Window.

Selecting Views
The Views option allows you to access different named views of a file.
1 From the View menu, select Views.

The Select a Named View dialog box appears.
2 From the list, select the view that you want to display.
3 Click OK.
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The selected view is displayed.
Note: To return to the default view, select Default View. 

Specifying a View Point
The View Point option allows you to render a drawing from a selected 
viewpoint.
1 From the View menu, select View Points.

The View Point dialog box appears.
2 Enter the X, Y and Z coordinates for the view point with which you want to 

render the drawing.
3 Click OK.

The drawing is displayed from the selected view point.

Working with 2D Vector Files
In addition to all the features that are available for generic 2D files, AutoVue 
provides the ability to access entity information, access views saved in the 
drawing, and the ability to “intelligent snap” when performing measurements.
AutoVue references various sources to obtain all data required to completely and 
accurately display vector files. These sources can be internal to the file—like 
layers, blocks, and overlays—or external reference files (XRefs) that are located 
outside the file.

Manipulating 2D Vector Files
The Manipulate menu option allows you to manipulate how the current active 
file is displayed. For example, you can select which layers, blocks, and external 
reference files (XRefs) to display.
The Manipulate menu options are:

Menu Sub-menu Description

Visibility Control Layers Select and display different layers of a drawing.
From the AutoVue toolbar, you can also click 

.

See  Layers
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Layers
Use this option to configure the layers to display of the current active file.
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Select the Layers to Display dialog box appears listing the layers and 
layer visibility for the current active file.

Note: From the AutoVue toolbar, you can also click Layers .
2 To sort the list of layers in the dialog box, click Name to sort alphabetically 

or numerically, or click Status to sort by visibility.
3 Select the check box beside the layers that you want to set visible.

Deselect the check box beside the layers that you want to hide.
4 Click OK.

The selected layers are displayed.

Blocks
Use this option to select a block to display from the current active file.
1 From the Manipulate menu, select Visibility Control, and then select 

Blocks.
The Select a Block to Display dialog box appears listing the blocks for the 
current active file.

Note: From the AutoVue toolbar, you can also click Blocks .
2 From the list, select the block that you want to display.
3 Click OK.

Blocks Select and display a block from a drawing.
From the AutoVue toolbar, you can also click 

.

See  Blocks

XRefs Select the XRefs to display in the drawing.
See  XRefs

Overlays Select an overlay to modify.
See  Modifying an Overlay

Menu Sub-menu Description
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The selected block is displayed.
4 To return to the default display, select Default View.

XRefs
AutoVue references various sources to obtain all the data required to completely 
and correctly display files. These sources can be internal to the file, like layers 
and blocks. External reference files or Xrefs are located outside the file.
Use the XRefs option to display the external references of the current active file.
Note: For AutoVue to locate a resource file, the XREFPATHS must point to the 
directory or directories where the resource files exist. For more information, refer 
to the Installation and Administration Manual.
1 From the Manipulate menu, select Visibility Controls, and then select 

XRefs.
The Select the External References to Display dialog box appears listing the 
external reference files associated with the current active file.

2 Select the check box beside the XRefs that you want to display.
Clear the check box beside the XRefs that you want to hide.

3 Click OK.
The selected XRefs are displayed.

Displaying Details About Missing Resources
The Resource icon  appears to the left of the AutoVue status bar if a file is 
missing resources. These missing resources can be XRefs, text fonts, linestyles, 
or shape files.
1 Click the Resource icon  on the AutoVue status bar.

The Properties dialog box appears.
Note: From the File menu, you can also select Properties.

2 Click the Resource Information tab to display details about missing 
resource information required to properly display this file.

A green check mark  indicates the resources that AutoVue is able to 
access.

A red  indicates the external reference files or components that are not 
accessible.

3 Click OK to close the Properties dialog box.
See Also  Missing XRef Notification Icon
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Adding an Overlay
When working with 2D files, you can overlay other files over the current active 
file. You can also adjust an overlay, move an overlay, and scale an overlay by 
defining the X and Y coordinates and the scaling factor.
Note: When working with a raster file, it should be used as the base file because 
raster formats are opaque and would hide files underneath them.
1 Open the file that you want to use as the base file for the overlay.
2 From the File menu, select Import File as Overlay.

The Overlays dialog box appears.
3 Click Add.

The Please Select an Overlay File dialog box appears.
4 Select a file to overlay and then click Open.
5 To add a another file, repeat steps 3 through 4.
6 When done, click OK.

The base file is displayed with the selected overlay files on top of it.

Modifying an Overlay
1 From the Manipulate menu, select Overlays.

The Modify Overlay dialog box appears.
2 Select the overlay that you want to modify.
3 Click the Action that you want to apply to the overlay.

•   Click Move if you want to move the overlay. 
Click a point on the base file where you want to set the lower left corner 
of the overlay. Click another point where you want to set the upper right 
corner of the overlay.

Note: As you select the point to define the position of the upper right 
corner, you can resize the destination box.
•   Click Scale if you want to resize the overlay. 

Enter the XOffset and YOffset coordinates and/or the Scale Factor.
Note: XOffset and YOffset are relative to the base drawing and all options 
are displayed at their current values.
•   Click Warp to adjust the overlay.

Click a point on the overlay and drag the cursor to where you want the 
overlay starting point. Click another point and drag the cursor to where 
you want the overlay to end.

Note: The overlay’s size is scaled to accommodate the origin and 
destination points you defined.
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4 Click OK.
The changes are applied to the selected overlay.
Note: To modify other overlays, repeat steps 2 to 4.

Removing an Overlay
1 From the File menu, select Import File as Overlay.

The Overlays dialog box appears.
2 Select the overlay that you want to remove.
3 Click Remove.

The overlay is removed from the list.
4 Click OK.

The overlay is removed from the display.

Analyzing 2D Vector Files
With the analysis functionality, you can measure entities, compare two files, or 
view drawing information. These options are available under the Analysis menu. 
The following table lists all the options from the Analysis menu: 

Menu Sub-menu Description

Measure Measure the distance, area, angle, and arc of an 
entity.
From the AutoVue toobar, you can also click 

.

See  Measuring in 2D Files

Compare Compare two files.
See  Comparing 2D Files

Show Drawing 
Information

Select Single 
Entity

Scale or translate a file in order to compare 
files accurately.
See  Viewing Details of a Single Entity

List Tags/
Attributes

List block attributes and tags.
See  Viewing Tags/Attributes
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Comparing 2D Files
AutoVue provides the ability to visually compare two files and display color-
coded comparative data. When you compare two files, AutoVue displays three 
windows, the first containing the original file, the second containing the file you 
compared the original against, and the third containing the comparison results.
In the Comparison Result window you can specify whether you want to display 
only the additions, deletions or unchanged, or any combination of the three. To 
access these options, right-click in any window and select an option from the 
pop-up menu.
The comparison results are displayed in different colors to differentiate the 
results of the file comparison. The comparison options and corresponding colors 
are:

1 View the base file in AutoVue.
2 From the Analysis menu, select Compare.

The File Open dialog appears.
3 Enter the file name or click Browse to select the file that you want to 

compare with the current active file.
4 Click OK.

AutoVue displays three windows, the first displaying the original file, the 
second displaying the compare file and the third displaying the comparison 
results.
Note: If you apply a change from the View menu, all three windows display 
the synchronized change.

Entity 
Information

View information of a set of entities.
See  Viewing Information for a Set of Enti-
ties

Option Color Description

View Additions Green Indicates that something has been added.

View Deletions Red Indicates that something has been deleted.

View Unchanged Blue Indicates that there is no change.

Menu Sub-menu Description
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5 To access the Compare options, right-click in any of the windows.
A pop-up menu appears displaying the Compare options.
Note: To maximize any of the windows, click the  button on the title bar 
of the window that you want to maximize. To minimize, click the  
button. To restore the window, click the  button.

6 When comparing AutoCAD files, you can view a file without viewports. To 
do so, from the View menu, select View Without Viewports.

7 To exit Compare mode, from the File menu, select Exit Compare.
The original file appears in the workspace.

Note: From the AutoVue toolbar, you can also click Exit Compare .

See Also  Specifying Scale and Offset for a Compare File

Specifying Scale and Offset for a Compare File
You can scale or translate a file in order to compare files accurately. With the 
Scale and Offset option you can modify the coordinates (XOffset and YOffset) 
or enter a scaling factor for the second file.
Note: XOffset and YOffset are relative to the base drawing and all options are 
displayed at their current values.
1 From the View menu, select Scale and Offset while in Compare mode.

The Scale and Offset dialog box appears.
2 Enter the required values for the Scale Options: XOffset, YOffset and 

Scale.
3 Click Apply.

The scaling/offset modifications are applied to the file in the second window.
4 Click OK to the close the Scale and Offset dialog box.

Drawing Information
Note: This feature is currently not supported with AutoVue Server running on 
Unix Platforms. 
The Drawing Information option is available with AutoCAD and MicroStation 
drawings, and is accessed from Analysis menu in both View and Markup 
modes. The Drawing Information options available are: Select Single Entity, 
List Tags/Attributes and Entity Information.
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Viewing Details of a Single Entity
Note: This feature is currently not supported with AutoVue Server running on 
Unix Platforms. 
1 From the Analysis menu, select Show Drawing Information, and then 

select Select Single Entity.
2 Click the entity for which you want to view information.

The Get Entity Info dialog box appears displaying the information for the 
selected entity.
The XData button appears if additional information exists for that entity. 
Click XData to view the information.
Note: If you did not select an entity, a message appears informing you that 
no entities were found and prompts you to select again.

3 Click OK to close the Get Entity Info dialog box.

Viewing Information for a Set of Entities
Note: This feature is currently not supported with AutoVue Server running on 
Unix Platforms. 
The Entity Information option allows you to view information of a set of 
entities contained in a specific area of a file.
1 From the Analysis menu, select Show Drawing Information, and then 

select Entity Information.
2 Click and drag to draw a box around an area for which you want to view 

entity information for the list of entities contained inside the area.
The List Entities dialog box appears displaying the information of all the 
selected entities.
Note: If there are no entities within the selected area, a message appears 
informing you that no entities were found and prompts you to select again.

3 Click OK to close the List Entities dialog box.

Viewing Tags/Attributes
Note: This feature is currently not supported with AutoVue Server running on 
Unix Platforms. 
1 From the Analysis menu, select Show Drawing Information, and then 

select List Tags/Attributes.
2 Click in the area of the file for which you want to view information on block 

attributes and tags.
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The Block Attributes dialog box appears displaying the attributes/tags for 
the selected entity.
Note: If there are no entities within the selected box, a message appears 
informing you that no entities were found and prompts you to select again.

3 Click OK to close the Block Attributes dialog box.

Measuring in 2D Files
AutoVue provides the ability to perform measurements in 2D files. Measurement 
options vary between vector and non-vector files. 
For vector files, AutoVue provides the option to “snap” to fixed points on the 
drawing. 

See  2D Vector Snapping Modes
For non-vector files, the Snapping Modes option is disabled. However, you can 
free snap to any point on the drawing.
AutoVue provides several measure options that you can choose from.You can 
access the measure options from Analysis menu and selecting Measure, or from 

the AutoVue toolbar, click Measure . 

The measure options are:

Name Description

Distance Measure the distance between two points.
See  Distance in non-Vector Files
        Distance in Vector Files

Area Measure selected area.
See  Area in non-Vector Files
        Area in Vector Files

Angle Measure the angle between selected points.
See  Angle in non-Vector Files
        Angle in Vector Files

Arc Measure an arc entity.
See  Arc in non-Vector Files
        Arc in Vector Files
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2D Vector Snapping Modes
The snapping modes available allow you to click to precise geometrical points 
on a drawing. For example, if you select Snap to end-point and you move the 
cursor over an end-point of a line, the end-point will be highlighted by a snap 
box. 
The snapping modes allow you to snap to the mid, center and end-points of an 
entity:

Distance in non-Vector Files
Use the Distance option to measure the distance between two specific points.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears displaying the measurement options.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Distance tab.
3 In the Measure Distance Units list, select a unit of measurement.

Note: If you want to measure the distance along a path, select the 
Cumulative check box.

4 Click a point on the drawing to define the starting point.
5 Click another point on the drawing to define the end point.

Note: If you selected Cumulative, continue clicking points along the path 
that you want to measure.

Button Snap to Description

End-point Geometric snap mode where a snap box appears 
when moving the cursor near a linear component’s 
end point.

Mid-point Geometric snap mode where a snap box appears 
when moving the cursor near the halfway point of 
a linear component.

Center-point Geometric snap mode where a snap box appears 
when moving the cursor near the center of an 
elliptical component.

Free snap Allow snapping at any point on the drawing.
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6 Right-click to complete the measurement.
The points are joined by a line. The measured distance, Delta-X, and Delta-
Y appear in their respective fields in Distance tab.
Note: Click Reset to take another measurement.

7 Click Close to close the Measurement dialog box.

Distance in Vector Files
Use the Distance option to measure the distance between two specific points.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also Measure .
2 Click the Distance tab.
3 Select the snapping modes that you want to use for measuring.

To select all snapping modes click All On. To clear all snapping modes click 
All Off.
See  2D Vector Snapping Modes

4 From the Measured Distance Units list, select the units of measurement.
Note: If you want to measure the distance along a path, select Cumulative.

5 Click a point on the drawing to define the starting point.
6 Click another point on the drawing to define the end point.

Note: If you selected Cumulative, continue clicking points along the path 
that you want to measure.

7 Right-click to complete the measurement.
The points are joined by a line. The Measured Distance, Delta-X, and Delta-
Y appear in the Measurement dialog box.
Note: Click Reset to take another measurement.

8 Click Close to close the Measurement dialog box.

Calibrating Distance
1 Measure distance between two points or measure cumulative distance.

See  Distance in non-Vector Files
Distance in Vector Files

2 From the Distance tab, click Calibrate.
The Distance Calibration dialog box appears displaying the measured 
distance
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3 From the Measured Distance list, select the unit to which you want to 
calibrate the distance.

4 Select Calibrate to and enter a value if you want to calibrate the distance to 
a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

5 Click OK.
The calibration result appears in the Measurement dialog box.

6 Click Close to close the Distance tab.

Area in non-Vector Files
Use the Area option to measure the area and perimeter of a region.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears displaying the measurement options.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Area tab.
3 In the Area Units list, select a unit of measurement in which to measure the 

area of the region.
In the Perimeter Units list, select a unit of measurement in which to measure 
the perimeter of the region.
Note: In the Net Area Result group, select Add to cumulate a net area result 
of different areas, select Subtract to subtract an area from the net area result, 
and select Clear to clear the Net Area Result field.

4 Click a point on the drawing to define the starting point.
5 Continue clicking points on the drawing to define the region you want to 

measure.
Each point is joined by a line. The area and perimeter measurements appear 
in their respective fields in the Area tab.

6 Right-click to complete the measurement.
Note: Click Reset to take another measurement.

7 Click Close to close the Measurement dialog box.

Area in Vector Files
Use the Area option to measure the area and perimeter of a region.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.
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Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Area tab.
3 Select Between Points if you want to measure the area between points on a 

drawing.
Note: Snapping modes are displayed.

4 Select the snapping modes that you want to use for measuring.
To select all snapping modes click All On. To clear all snapping modes click 
All Off.
See  2D Vector Snapping Modes

5 Select Shape if you want to measure the area of a predefined shape on the 
drawing. 

6 From the Measured Area Units list, select the unit in which you want to 
measure the area.

7 From the Perimeter Units list, select the unit in which you want to measure 
the perimeter.

8 To cumulate a Net Area Result of different areas, click Add. 
To subtract an area from the Net Area Result, click Subtract.
Select Clear to clear the Net Area Result.

9 If you selected Between Points, click points on the drawing to define the 
area. 
Each point is joined by a line. The area and perimeter measurements appear 
in the Measurement dialog box.

10 Right-click to complete the measurement.
11 If you selected Shape, click the edge of the predefined shape.

The shape is highlighted and the area and perimeter measurements appear in 
the Measurement dialog box.
Note: Click Reset to take another measurement.

12 Click Close to close the Measurement dialog box.

Angle in non-Vector Files
Use the Angle option to measure the angle between points on a drawing.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears displaying the measurement options.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Angle tab.
3 Select a unit of measurement from the Units list.
4 Click points on the drawing to define the angle you want to measure.
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Angle arms appear with an arc connecting them. The angle measurement 
appears in the Angle tab.
Note: Click Reset to take another measurement.

5 Click Close to close the Measurement dialog box.

Angle in Vector Files
Use the Angle option to measure the angle between points on a drawing.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Angle tab.
3 Select From 3 Points if you want to measure the angle between three points. 

Snapping modes are displayed.
4 Select the snapping modes that you want to use for measuring.

To select all snapping modes click All On. To deselect all snapping modes 
click All Off.
See  2D Vector Snapping Modes

5 Select Between 2 lines if you want to measure the angle between two lines. 
6 From the Measured Angle Units list, select the unit.
7 If you selected From 3 Points, click three points on the drawing to define 

the angle.
8 If you selected Between 2 Lines, click two lines on the drawing to define the 

angle.
Angle arms appear with an arc connecting them. The angle measurement 
appears in the Measurement dialog box.
Note: Click Reset to take another measurement.

9 Click Close to close the Measurement dialog box.

Angle in non-Vector Files
Use the Angle option to measure the angle between points on a drawing.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears displaying the measurement options.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Angle tab.
3 Select a unit of measurement from the Units list.
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4 Click points on the drawing to define the angle you want to measure.
Angle arms appear with an arc connecting them. The angle measurement 
appears in the Angle tab.
Note: Click Reset to take another measurement.

5 Click Close to close the Measurement dialog box.

Arc in non-Vector Files
Use the Arc option to define an arc in the drawing and calculate its arc center, 
radius, diameter, and arc length.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears displaying the measurement options.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Arc tab.
3 In the Arc Info section, select a unit of measurement from the Length list in 

which to measure the length of the arc.
4 In the Measured Angle section, select a unit of measurement from the Sweep 

Units list measure the angle of the arc.
5 Click points on the drawing to define the arc.

The points are joined by an arc. The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle, and sweep 
appear in the Arc tab.
Note: Click Reset to take another measurement.

6 Click Close to close the Measurement dialog box.

Arc in Vector Files
Use the Arc option to define an arc in the drawing and measure its radius, center 
and diameter.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Arc tab.
3 Select From 3 Points if you want to measure the arc between three points. 

Snapping modes are displayed. 
Click the snapping modes that you want to select as the points for the 
measurement.
See  2D Vector Snapping Modes
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Note: To select all snapping modes click All On. To clear all snapping 
modes click All Off.

4 Select Arc Entity if you want to measure a predefined arc. 
5 From the Arc Info list, select the unit in which you want to measure the 

distance.
6 From the Measure Angle Units list, select the unit in which you want to 

measure the angle.
7 If you selected From 3 Points, click three points on the drawing to define 

the arc.
The points are joined by an arc. The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle and sweep 
appear in the Measurement dialog box. 

8 If you selected Arc Entity, click the edge of the arc that you want to 
measure.
The arc is highlighted. The measurements for center point coordinates, 
radius, diameter, arc length, start and end of angle and sweep appear in the 
Measurement dialog box.
Note: Click Reset to take another measurement.

9 Click Close to close the Measurement dialog box.

Calibrating an Arc
1 Measure an arc in the drawing.

See  Arc in non-Vector Files
Arc in Vector Files

2 From the Arc tab, click Calibrate.
The Radius Calibration dialog box appears displaying the measured 
distance.

3 From the Measured Radius list, select a unit of measurement to which you 
want to calibrate the distance.

4 Click Calibrate to and enter a value if you want to calibrate to a value.
Click Set Factor and enter a value if you want to calibrate by a factor.

5 Click OK. 
The calibration results appear in the Arc tab.

6 Click Close to close the Measurement dialog box.
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Working with EDA Files
In addition to all the features that are available for generic 2D files, AutoVue also 
provides intelligent querying for EDA files; you can create/modify layer sets, 
generate BOM, verify EDA designs, perform intelligent measurements, analyze 
nets and components, and much more. For information on the available features 
for EDA files, refer to the following sections. 

Navigation Panel
The Navigation Panel is displayed on the left-hand side of the AutoVue 
workspace when you view an EDA drawing. It allows you to navigate through a 
list of component instances, nets, and the associated pins and net nodes (pins 
connected to a net) present in the current schematic drawing or PCB design.
The columns displayed in the Navigation Panel are determined by the profile of 
the entity types in the current schematic drawing or Printed Circuit Board (PCB) 
design. Lists can be sorted in order to group similar component instances.
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You can also use the Navigation Panel to select (highlight) a component or entity; 
zoom to a component or entity, and query entity information.

Components Tab
The Components tab lists component instances and the associated pins.The top 
portion of the tab lists all the instances of the currently displayed page of the 
drawing. The lower portion of the tab lists the associated pins for selected 
instances.
When you select a component, it appears highlighted on the drawing. To select 
more than one component, press the Shift or Control key while selecting. All the 
components you selected are highlighted. The associated pins for the selected 
components are displayed.
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Nets Tab
The Nets tab lists nets and associated net nodes (pins connected to a net). The top 
portion of the tab lists all the nets of the currently displayed page of the drawing. 
The lower portion of the tab lists the associated net nodes for the selected nets.
When you select a net, it appears highlighted on the drawing. To select more than 
one net, press the Shift or Control key while selecting. You can also click and 
drag in the Navigation Panel list to select multiple nets. All the nets you selected 
are highlighted. The associated net node lists for all the nets you selected are 
displayed.

Bookmarks Tab
The Bookmarks tab allows you to navigate between PCB and schematic pages 
or between the 2D and 3D view of a PCB design.

Customizing the Navigation Panel
In the Navigation Panel, you can sort a column, change column order, or hide/
show a column.
1 To sort a column, click the column heading.
2 To change the column order or to show/hide a column, right-click a column 

heading and select Customize.
The Customize Columns dialog box appears.

3 To show or hide a column, select the check box beside the column or 
columns you want to show.
Deselect the check box beside the column or columns you want to hide.
Note: To show all columns, click Show All. To hide all columns, click Hide 
All.

4 To change the column order, select the column you want to move, then click 
Move Up to move the column up in the list or click Move Down to move the 
column down in the list.

5 Click OK.
The changes appear in the Navigation Panel.
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Selecting Entities
Selecting an entity or entities is often the first step to many of the operations that 
you will perform with EDA files. You can select an entity or entities in an EDA 
file from the Navigation Panel or the workspace. You can also select entities from 
the Entity Search dialog box when you search for entities. To specify which types 
of entities you can or cannot select, use the Entity Filter dialog box. 
Once you have selected an entity, you can zoom to it in the workspace and 
perform other operations with the EDA file.

From the Navigation Panel
Click any components, nets, associated pins, or net nodes in the Navigation Panel 
to select them. To select more than one entity, press the Shift or Control key 
while selecting.
The selected entity or entities are highlighted in the workspace. If the selected 
entity is small, a flash box appears indicating the location of the highlighted 
entity in the workspace.

See Also  Zooming to a Selected Entity

From the Workspace
Click an entity in the workspace to select it. To select more than one entity, press 
the Shift or Control key while selecting.
The selected entity or entities appear highlighted in the workspace and in the 
Navigation Panel. If the selected entity is small, a flash box appears indicating 
the location of the highlighted entity in the workspace.
You can also apply selection filters when selecting entities in the workspace. 

See  Filtering Entity Types
Note: When you hover the mouse over an entity in the workspace, a tooltip with 
information about the entity’s attributes appears. The tooltip displays whether or 
not you select the entity.

See Also  Zooming to a Selected Entity

From the Entity Search Dialog Box
1 Perform an attribute-based or entity type-based search using the Entity 

Search dialog box.
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See  Searching Using Entity Search
2 Select an entity or entities from the Entity Types list or the Attributes list of 

the Entity Search dialog box.
Note: To select more than one entity, press the Shift or Control key while 
selecting.
The selected entity or entities appear highlighted in the workspace and in the 
Navigation Panel.
Note: If the selected entity is too small, a flash box appears indicating the 
location of the highlighted entity in the workspace.
See Also  Zooming to a Selected Entity

Filtering Entity Types
With the Entity Filter option, you can display certain entity types while hiding 
others, without having to hide an entire layer. For example, you might want to 
turn off all entities and display only the component instances.
You can also limit the types of entities you can select in the workspace.
1 From the Manipulate menu, select Visibility Control, and then select 

Entity Filter.
The Entity Filter dialog box appears.

2 Under the Visibility column, select the check box beside the entity types you 
want to display in the workspace.
Deselect the check box to hide the entity types.

3 Under the Selection column, select the check box beside the entity types that 
you want to be able to select in the workspace.
Deselect the check box beside the entity types that you do not want to select.
Note: To select all entity types, select the check box in the column header. 
Deselect the check box to deselect all entity types.

4 Click Apply to apply the changes.
5 Close OK to close the Entity Filter dialog box.

Only the selected entity types remain displayed in the workspace.
When you click in the workspace, only the entity types checked in the Entity 
Filter dialog box will be highlighted.

Zooming to a Selected Entity
1 In the workspace or Navigation Panel select the entity, then right-click and 

select Zoom Selected.
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2 In the Entity Search dialog box, select the entity from the Entity Types list or 
the Attributes list, then right-click and select Zoom Selected.
AutoVue zooms to the selected entity in the workspace.

Entity Properties
The Entity Properties dialog box displays detailed information about any 
selected entity in the current schematic drawing or PCB design. To open the 
Entity Properties dialog box, you can double-click or right-click an entity in the 
workspace, Navigation Panel or Entity Search dialog box, then select Show 
Entity Properties.

On the left side of the Entity Properties dialog box, a navigation tree displays all 
the entities associated with the entity you selected. The entity you selected is the 
root of the tree, and all the associated entities (grouped by their type) are shown 
as its children.
The attributes of the entity display to the right of the tree under Entity Info. In 
the tree, select any associated entity to display its attributes under Entity Info.
You can also view entity attributes in the workspace. When you hover the mouse 
over an entity in the workspace, a tooltip with commonly used entity information 
appears. You can turn these tooltips off or on from the Configuration dialog box. 

See   Configuring AutoVue
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Viewing the Properties of an 
Entity
The Entity Properties dialog box displays detailed information about any selected 
entity in the current schematic drawing or PCB design.
1 Select the entity in the workspace or from the Navigation Panel or Entity 

Search dialog box.
See  Searching Using Entity Search

2 Right-click and select Show Entity Properties.
The Entity Properties dialog box appears displaying the selected entity and 
its associated entities under Associations, and its attributes under Entity 
Info.
Note: You can also double-click the entity in the workspace to view its 
entity information.

3 Select any associated entity in the tree to display its attributes under Entity 
Info.

4 To view all associated entities for any given entity in the tree, select the 
entity and click Expand.
Note: To view the entity properties for the previous entity, click the back 

 arrow. To return to the entity properties displayed before you clicked 
the back arrow, click the forward  arrow.

5 Click OK to close the Entity Properties dialog box.

Showing Net Connectivity
You can view the net connectivity of an entity such as a pin, via, or trace with the 
Show Net Connectivity option.
Note: Show Net Connectivity is disabled when more than one entity is selected.
1 Select an entity such as a pin, via, or trace from the workspace or the 

Navigation Panel.
The corresponding entity is highlighted in the workspace and in the 
Navigation Panel.

2 From the workspace or Navigation Panel, right-click the selected entity, and 
then select Show Net Connectivity.
The graphical entities belonging to the connected nets are highlighted.
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Displaying the Entity Properties of a Net
You can view the properties of a net via the Show Entity Properties option.
Note: The Show Entity Properties is disabled when more than one net entity is 
selected.
1 Select an entity such as a pin, via, or trace from the workspace or the 

Navigation Panel.
The corresponding net is highlighted in the workspace and in the Navigation 
Panel.

2 From the workspace or Navigation Panel, right-click the selected net, and 
then select Show Entity Properties.
The Entity Properties dialog box appears displaying the properties of the 
selected net.

3 Click OK to close the Entity Properties dialog box.

Showing Net Instances
You can display the instances of a net in a multi-page file.
1 From the Navigation Panel, click the Nets tab and select the net you want to 

view.
The net is highlighted in the Navigation Panel and in the workspace.

2 From the View menu, select Go to Net Instances, or right-click the 
highlighted net from the Navigation Panel or workspace and select Go to 
Net Instances.
AutoVue highlights the instance or instances of the selected net.
If the selected net appears on multiple pages the Go to Net Instances dialog 
box appears.

3 Select the page on which you want to view the net instance, then click OK.
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The selected page is displayed and the instance of the selected net is high-
lighted.
Note: If there are no instances for the selected net, the option is disabled.

Navigating Design Hierarchy 
AutoVue supports navigation through the hierarchical structure of a schematic 
drawing. A hierarchical block in a schematic is a symbol that refers to a child 
schematic. With the Descend Hierarchy option, you can navigate to a child 
schematic. With the Ascend Hierarchy option, you can navigate from the child 
schematic to the parent page.

Navigating using Descend Hierarchy
On the parent page of your schematic’s design hierarchy, select any hierarchical 
block in the workspace or in the Navigation Panel, then right-click and select 
Descend Hierarchy.
AutoVue opens the page with the selected child schematic.
Note: You can also select the hierarchical block in the Entity Search dialog box, 
then right-click and select Descend Hierarchy.

See  Searching Using Entity Search

Navigating using Ascend Hierarchy
On the child page of your schematic’s design hierarchy, right-click an entity in 
the workspace or in the Navigation panel and select Ascend Hierarchy.
AutoVue returns to the parent page.
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If you select an entity that has multiple parents, the Ascend Hierarchy dialog box 
appears displaying the parent pages.

Select the Parent page you want to go to, then click OK.
AutoVue returns to the selected parent page.
Note: You can also select the entity in the Entity Search dialog box, then right-
click and select Ascend Hierarchy.

See  Searching Using Entity Search

Layers
When working with EDA files, AutoVue lets you view all the physical layers and 
associated logical layers of the EDA drawing; you can view all layer sets for that 
file, or create your own. Additionally, you can manipulate certain layer attributes, 
such as visibility, color, and ordering. The layer settings are accessed via the 
Layers option. 
Note: For drawings which do not contain layers, the Layers menu option and 
button are disabled.
From the Manipulate menu, select Visibility Control, and then select Layers.
The Layers dialog box appears.

Note: From the AutoVue toolbar, you can also click Layers .

The Layers dialog box has a Physical Layers section and a Logical Layers 
section. You can display and hide these sections by clicking Expand  and 

Collapse , respectively.
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Physical and Logical Layers Sections
The Logical Layers section displays the layers in the order they display in the 
workspace. The Physical Layers section displays the layers in the order they 
appear in the layer stackup when manufactured.
The Physical Layers section displays a matrix with a mapping of physical layer 
names to entity types. Each row in the matrix corresponds to a physical layer in 
the board. Each column in the matrix lets you control the visibility of an entity 
type, such as pin, via, or trace. The entity types that display depend on the entities 
available in the open file. Select a physical layer to change its visibility, layer 
order, and color. Select or deselect the entity type of a physical layer to affect its 
visibility separately from the other entities of the layer.
When you select a physical layer from the Physical Layers section, the associated 
logical layers are also selected in the Logical Layers section. You can also select 
individual logical layers from the Logical Layers section, or press the Shift or 
Control key to select multiple logical layers.
Note: One physical layer can be selected at a time.
The Logical Layers section displays a list of logical layers and the layer attribute 
options you can modify: visibility, order, and color.
To modify these attributes for both physical and logical layers, first select the 
layers you want to modify, then use the settings to make the changes you want.
When you select physical or logical layers and modify settings from the Layers 
dialog box, a message displays at the bottom of the dialog box to indicate your 
last action.
When you are satisfied with the changes, click Apply to make the changes in the 
workspace. You can also create layer sets to save your modified layer settings to 
reuse them later.
When you open a file, it displays all layer sets for that file. You can choose the 
layer set you need, or create your own.

See  Changing the Order of Layers
Modifying Layer Visibility
Changing Layer Color
Sorting Logical Layers
Creating User-Defined Layer Sets
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Changing the Order of Layers
You can change the order in which layers display in the workspace. Specifically, 
you can change the z-order of layers.
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .

2 If the Logical Layers section is not open, click Expand .
3 Select the layer or layers that you want to move. To do so, you can do one of 

the following:
•   Select a physical layer from the Physical Layers section. 

Logical layers associated with the selected physical layer are also 
selected. When you make changes to a selected physical layer, the logical 
layers associated with it are also affected.

•   Select one or multiple logical layers from the Logical Layers section. To 
select multiple logical layers, press the Shift or Control key while 
selecting.

4 Click one of the following buttons:

•   Click Bring to Front  to move all selected layers to the front in the 
workspace. In the Logical Layers section, these layers move to the top of 
the list.

•   Click Up  to move selected layers up one layer.

•   Click Down  to move selected layers down one layer.
Note: You can also drag and drop selected logical layers in the Logical 
Layer section.

5 Click Apply to see the changes in the workspace.
The file now displays according to the layer scheme you arranged. Also, 
logical layers are renumbered in the Order column of Logical Layers section.

6 You can now save your changes as a user-defined set.
See  Creating User-Defined Layer Sets

7 Click Close to close the Layers dialog box.

Modifying Layer Visibility
Use the Layers dialog box to hide or display specific physical and logical layers 
in the workspace.
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Modifying Visibility for Physical Layers
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .
2 In the Physical Layers section, you can show or hide the following:

•   All physical layers: Click the All column header.
•   One physical layer: Select the check box to the left of the layer name.

•   You can also select a layer and click Visibility .

•   One entity type for all physical layers: Click the column header.
For example, click the Trace column header to show or hide all trace 
entities of all physical layers.

•   One entity type for one physical layer: Click a specific check box.
3 Click Apply to view the changes in the workspace.
4 You can now save your changes as a user-defined set.

See  Creating User-Defined Layer Sets
5 Click Close to close the Layers dialog box.
Note: Check boxes for physical layers can have four states: checked, unchecked, 
gray checked, and gray unchecked. Check boxes that are checked and gray 
indicate that the entities of a physical layer are neither all visible nor all hidden. 
Gray check boxes that you cannot select indicate that there is no entity of that 
type for that layer.

Modifying Visibility for Logical Layers
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .

2 If the Logical Layers section is not open, click Expand . 
The Logical Layers section lets you show or hide the following:
•   One logical layer: Select the layer’s check box in the Visibility column 

.

•   Multiple logical layers: To select more than one layer, press the Shift or 
Control key while selecting, and then click Visibility .
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3 Click Apply to view the changes in the workspace.
4 You can now save your changes as a user-defined set.

See  Creating User-Defined Layer Sets
5 Click Close to close the Layers dialog box.

Changing Layer Color
You can modify the color of any physical or logical layer from the Layers dialog 
box.
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .

2 If necessary, click Expand  to open the Logical Layers section.
Select the layer or layers for which you want to change the color. 
You can select a physical layer from the Physical Layers section; logical 
layers associated with the selected physical layer are also selected. You can 
also select individual logical layers from the Logical Layers section, or press 
the Shift or Control key while selecting.to select multiple layers.

3 Once you have selected a layer, you can do one of the following modify its 
attributes:

•   Click Modify Color . Use this button if you want to change the color 
of all logical layers associated with a selected physical layer, or to change 
the color of many selected logical layers at the same time.

•   Double-click a square in the Color column  of the Logical Layers 
section. Use this option to change the color of individual logical layers.

Note: Do not click the Color column heading unless you want to sort the 
layers in the Logical Layers section according to color.

4 Select the color that you want from the menu.
The color of all selected layers changes in the Color column.

5 Click Apply to save the changes.
The display updates in the workspace based on the changes you made to the 
layer color. 

6 You can now save your changes as a user-defined layer set
See  Creating User-Defined Layer Sets

7 Click Close to close the Layers dialog box.
Oracle Corp.



AutoVue 67
Sorting Logical Layers
You can sort the list of logical layers in the Logical Layers section by name, 
visibility, color, or physical layer.
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .

2 If the Logical Layers section is not open, click Expand .
3 Click the column header of an attribute. 

Layers are sorted according to the attribute header you click.
For example, clicking the Color column header  sorts all logical layers 
in the section according to their color.
Note: To restore the original sort order, click the Order column header.

Layer Sets
A layer set is comprised of all the physical and logical layers in the drawing. 
Layer sets differ in the attributes of the different layer or layers; for example, z-
order, visibility, and color. You can also define your own layer sets to control 
which layers you can view and print.

Viewing Layer Sets
AutoVue lists top, bottom, and default layer sets, as well as any layer set that is 
stored in the file. You can choose to display any layer set you need. You can also 
create user-defined layer sets and display them later. To view a layer set, take the 
following steps:
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .
2 From the Layer Set list, select the layer you want to display. 
3 Click Apply.

The selected layer set displays in the workspace.
4 To restore the default layer set, from the Layer Set list, select (Default).
5 Click Close to close the Layers dialog box.
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Note: You can also view the layer sets from the Layers list beside the Layers 

button  on the AutoVue toolbar.

See  Creating User-Defined Layer Sets
Deleting User-Defined Layer Sets
Saving User-Defined Layer Sets with Markups

Creating User-Defined Layer Sets
You can define a layer set and save it for the duration of the session. The layer set 
you defined is added to the Layer Set list in the Layers dialog box and to the 
Layers list on the AutoVue toolbar.
By default the Top, Bottom and Default layer sets and any other layer sets 
belonging to the file are listed in the Layer Set list.
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .
2 Click Add.

The Add Layer Set dialog box appears.
3 Enter the layer set name.
4 Click OK.

The new layer set appears in the Layer Set list.
5 To modify the attributes of the new layer set, select one or more layers and 

change the Visibility, Order, or Color.
See  Changing the Order of Layers

Modifying Layer Visibility
Changing Layer Color

6 Click Apply to save the changes and to display the new layer set in the 
workspace.

7 To define more layer sets, repeat steps 2 to 6.
8 Click Close to close the Layers dialog box.

The new layer set appears in the Layers list beside the Layers Control 

button  on the AutoVue toolbar.
See  Viewing Layer Sets

Deleting User-Defined Layer Sets
Saving User-Defined Layer Sets with Markups
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Deleting User-Defined Layer Sets
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Layers dialog box opens.

Note: From the AutoVue toolbar, you can also click Layers .
2 From the Layer Set list, select the user-defined layer set you want to delete.

Note: You can only delete user-defined layer sets.
3 Click Delete.

Note: The layer settings of the deleted layer set remain displayed on the 
screen until you select another layer set.

4 Click Apply to save the changes.
5 Click Close to close the Layers dialog box.

See  Creating User-Defined Layer Sets
Viewing Layer Sets
Saving User-Defined Layer Sets with Markups

Saving User-Defined Layer Sets with 
Markups
You can save user-defined layer sets using Markup files.
1 Create custom layer sets.

See  Creating User-Defined Layer Sets
2 From the Markup menu, select New.

Note: From the AutoVue toolbar, you can also click Markup .
3 Create any markup entities that you need.
4 From the Markup menu, select Save As.

The Save Markup File As dialog box appears.
5 Enter the markup information and click OK.

The Layer sets you created are saved with the Markup file. When you reopen 
the file during a different session, you can view the Layer sets when you 
open the Markup file.
See  Creating User-Defined Layer Sets

Viewing Layer Sets
Deleting User-Defined Layer Sets
Markups
Oracle Corp.



70 AutoVue
Manipulating EDA Views
With the View options you can instantly manipulate how the current active file is 
displayed. You can rotate a file’s orientation clockwise or counter-clockwise by 
90 degrees, and flip a file’s orientation horizontally, vertically or both 
simultaneously.
AutoVue provides several ways to change the view size of a selected area of a 
file, display different views, layers and blocks of the current active file. You can 
also navigate from one page to another page of a multi-page file.

See  2D Viewing Options

3D View
For some ECAD formats, AutoVue supports 3D views of PCB boards.
1 In the Navigation Panel, click the Bookmarks tab.
2 Select 3D View from the navigation tree.

The 3D view of the PCB board is displayed in the workspace.
Note: 3D view can also be accessed from the View menu, selecting Page, 
and then selecting Next, or from the AutoVue toolbar and then clicking Next 
Page .

Cross Probing
Cross probing is the ability to select elements in the schematic and have them 
mapped to the corresponding components in the layout drawings and vice versa. 
You can also cross probe between the 2D and 3D view of the same file.

See  Cross Probing Between Two or More EDA Files
Showing the Net Connectivity when Cross Probing
Cross Probing Between 2D and 3D Views of the Same File
Zooming when Cross Probing

Cross Probing Between Two or More EDA 
Files
The Cross Probe option lets you select entities in the schematic drawing or the 
PCB and AutoVue highlights what you selected in all the open files.
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1 Open a file you want to cross probe.
2 From the Analysis menu, select Cross Probe.

The Select files for cross-probing dialog box appears.

Note: From the AutoVue toolbar, you can also click Cross Probe .
3 Click Add File. 

In the File Open dialog box that appears.
4 Enter the path and file name of the file you want to cross probe, or click 

Browse to locate the file, then click OK.
5 Repeat steps 3 and 4 for each additional file that you want to open.
6 In the Select files for cross-probing dialog box, click OK.

Each file you selected appears in a new window. A dialog box appears for 
each new window which lets you change the view or page for each file.
Each dialog box has the Automatic option selected by default. When the 
Automatic option is selected for each dialog box, you see different behavior 
depending on the files you cross probe, as follows:
•   If you cross probe a schematic and PCB, one window automatically 

displays a 2D PCB and the other window displays a schematic. The same 
is true if either file contains a PCB and a schematic. For example, if files 
A and B contain both a schematic and a PCB and they are cross probed, 
one of the files displays the schematic page and the other displays the 2D 
PCB.

•   If you cross probe two PCBs, one window automatically displays a 2D 
PCB and the other window displays a 3D PCB.

•   If you cross probe two schematics, both are set to schematic.
7 If necessary, resize the windows so that you can see all the open files.
8 To change the view of a file in a window, take the following steps:

a.  Deselect the Automatic option in the dialog box for the window you 
want to change.

b.  Select Schematic, PCB, or PCB 3D View from the Type list. These 
options are available in the Type list only when the views are present in 
the file.

The view of the file changes in the window.
9 To switch between multiple occurrences of a selected component, take the 

following steps:
a.  From the Navigation panel, select a component in one file that has 

multiple component occurrences in the other file.
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b.  From the dialog box of the file with multiple component occurrences, 
select one of the components from the Occurrence list or click Next 

 or Previous  to switch between component occurrences.

10 Select any entity in the schematic drawing.
The same entity is highlighted in the PCB designs.

Cross Probing Between 2D and 3D Views 
of the Same File
11 From the Analysis menu, select Cross Probe.

The Select files for cross-probing dialog box appears.

Note: From the AutoVue toolbar, you can also click Cross Probe .
12 Click Add File.

The File Open dialog box appears
13 Select the same file, then click OK.
14 In the Select files for cross-probing dialog box, click OK.

The file appears in a new AutoVue window. The views that display in each 
window depend on the contents of file you are cross probing.

15 If the file does not contain a schematic, one window shows the 2-
dimensional view of the PCB and the other shows the 3-dimensional view of 
the PCB.

16 If the file contains a schematic as well as a PCB, the schematic view displays 
in one window and the 2D PCB view displays in the other window. In this 
case, take the following steps to see the 2D and 3D views of the PCB:
a.  In the window’s dialog, deselect the Automatic option.
b.  Select a different view from the Type list. For example, you can switch 

between Schematic and PCB 3D View.
17 Resize the windows so that you can see both views of the file.
18 Select an entity in the 3D view.

The same entity is highlighted in the 2D view of this file.
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Note: You can select entities in the 2D view or 3D view of the file. The 
selected entities are highlighted in both open views of this file.

Showing the Net Connectivity when Cross 
Probing
1 Select an entity or entities in any open file.
2 Right-click and select Show Net Connectivity.

The net connectivity for the entity or entities that you selected are 
highlighted in all the files.

Zooming when Cross Probing
When you are cross probing files, you can zoom in on the entities you select. 
Zoom in on a selected entity or entities:
• When cross probing between a schematic drawing and a PCB design.
• When cross probing between the 2D and 3D views of the same file.
To zoom in on a selected entity:
1 Select an entity or entities in either one of the open files or views.

Note: If you are cross probing between a schematic drawing or a PCB 
design, you can select entities in either file. You can also select entities in 
any open file when cross probing the 2D view and 3D view of the same file.

2 Right-click and select Zoom Selected from the pop-up menu.
AutoVue zooms to the same entities in all the open files.

Comparing a PCB with Artwork
In AutoVue, you can visually compare PCB designs or schematic drawings. In 
Compare mode for EDA files, EDA options such as Select Entity, Entity Search 
dialog box, and Entity Type Filter are available.
To compare a PCB with artwork:
1 Open the PCB file that you want to compare with artwork.
2 From the Analysis menu, select Compare.

The File Open dialog appears.
3 Enter the path and file name or click Browse to select the artwork file that 

you want to compare with the PCB file.
4 Click OK.

The PCB-Artwork Comparison dialog appears.
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5 From the list, select the PCB physical layer that represents the artwork, then 
click OK.
AutoVue displays the selected layer in the first window, compares it with the 
Artwork in the second window and displays the results in the Comparison 
Result window.

6 To exit Compare mode, from the File menu, select Exit Compare.
The original file appears in the AutoVue workspace.

Note: From the AutoVue toolbar, you can also click Exit Compare .

Generating a Bill of Material
For EDA files, you can obtain a list of the components and parts required for 
manufacturing the item featured in the schematic drawing or PCB design.
The Bill of Material (BOM) report produces a count of the unique components 
or parts needed for manufacturing. It lists the quantity required, component 
name, reference designators, value (for resistors and capacitors), size, and 
descriptions. When determining the uniqueness of a component, the count 
considers only the attributes chosen for inclusion in the report output. It includes 
only those attributes that provide the most accurate and unique component 
quantities.
To generate a BOM, do the following:
1 From the Analysis menu, select Generate Bill of Material.

Note: If you are generating a BOM for a schematic with multiple pages, a 
dialog box appears prompting you to select the BOM scope: Current page 
or Entire design. 

Click OK after making your selection.
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Note: The Generating BOM dialog box appears listing the attributes of the 
file.

2 Select the attributes that you want to appear in the report
3 Click Generate.

The Bill of Material dialog box appears listing the count for each component 
or part possessing the attributes you selected. There are also columns 
displaying the values of the attributes you selected.
Note: To sort a column by alphanumerical or alphabetical order, click on the 
column heading.

4 To save the BOM, click Export.
The Export BOM dialog box appears.

5 Specify the directory where you want to store the file, the file name and 
extension, then click Save.
Note: You can specify either .pdx (Product Data Exchange) or .csv 
(Common Separated Values) for the extension.
AutoVue automatically saves the results in a file with the format you 
specified.

6 Click Close to close the Bill of Material dialog box.

Design Verification
Design verifications are operations that check the electrical design of a PCB 
against a set of rules defining physical and electrical design limitations. 
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Performing these checks will prevent short circuits and process errors. The types 
of design rules are as follows:
• Clearances - The minimum spacing (air gaps) allowed between two sets of 

entities in the design. These sets can belong to the same type of entity or to 
different types.

• Electrical - Targets certain properties of the nets
• Manufacturing - Targets the physical properties of a particular entity.

Design Rule Checks
For design rule checks that have values, you can change the unit of measure and 
change the value of each check. The available design rule checks are:

Type # Design Rule 
Check Description

Clearance 1 Min.Clearance
(Pad > Pad)

Specify the minimum pad to pad clearance 
on the same physical layer.
Note: Only the pad outline is considered.

2 Min.Clearance
(Pad > Trace)

Specify the minimum pad to trace 
clearance and pads on the same physical 
layer.
Note: Only the pad outline is considered. 
Does not take into account traces 
connected to a pin (pad) on the same net.

3 Min.Clearance
(Trace > Trace)

Specify the minimum trace to trace 
clearance on the same physical layer.
Note: Does not take into account directly 
connected traces.
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4 Min. Clearance
(Comp > Comp)

Specify the minimum component to 
component clearance on the same physical 
layer (component top side or component 
bottom side).
Note: Only the logical layer that defines 
the actual outline of the component is 
considered.
Note: A component entity is usually 
made up of geometrics on different logical 
layers (silkscreen, keepout, and so on.), 
but only the logical layer that defines the 
actual outline of the component is 
considered.

Manufacturing 5 Min. Annular 
Ring

Specify the distance between the pad out-
line and the outline of its drill hole on all 
physical layers.
Note: The two outlines (geometries) are 
part of the pin (pad) entity but on different 
logical layers.

6 Min. Pad 
Diameter

Specify the minimum diameter of a pad.
Note: Only applicable to rounded pads.

8 Acute Angle
(in deg.)

Specify the minimum acute angle between 
connected traces on the same physical 
layer.
Note: Only two traces belonging to the 
same net should be considered.

9 Min. Drill Hole 
Size

Specify the minimum diameter of the drill 
hole size allowed.
Note: Only applicable to rounded pads.

10 Max. Drill Hole 
Size

Specify the maximum diameter of the drill 
hole size allowed.
Note: Only applicable to rounded pads.

Electrical 7 Max. Via Count Specify the maximum via count allowed 
for a net.

Type # Design Rule 
Check Description
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Verifying a Design
1 From the Analysis menu, select Verify Design.

The Verify Design dialog box appears.

11 Min. Route 
Width

Specify the minimum route (trace) width 
allowed in the design.

12 Max. Route 
Width

Specify the maximum route (trace) width 
allowed in the design.

13 Min. Route 
Length

Specify the minimum route (trace) length 
allowed in the design.

14 Max. Route 
Length

Specify the maximum route (trace) length 
allowed in the design.

15 Empty Nets Select this check box if you want to check 
for any nets that are not connected to any 
pin, via, trace and power/ground plane.

16 Un-routed 
Traces

Select this check box if you want to check 
for any trace segment that is not connected 
to another trace segment, pin, via on either 
end.

17 Single 
Connection

Select this check box if you want to check 
for a net connected to only one pin.
Exception:  power and ground nets.

18 Short Circuit Select this check box if you want to check 
for intersections (on the same layer) of 
traces that belong to different nets.
Note: Trace entities will be divided into n 
sets where n is the number of nets in the 
design.

19 Unconnected 
Pin

Select this check box if you want to check 
for any pin (pad) that is not graphically 
intersected with any traces on the same 
physical layer.

Type # Design Rule 
Check Description
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2 To enable a design rule, select the associated check box in the Design Rules 
section of the dialog box.
To disable a design rule, deselect the check box.
Note: You can sort the design rules by clicking the column headings for 
Enabled, Description, or Value.

3 To add a value to the selected design rule, double-click in corresponding row 
of the Value column and enter a value.
Note: The selected design rule must be enabled to be able to add a value.

4 In the Maximum Violations field, enter the maximum number of results 
you want to display in the Results list.

5 From the Distance Units list, select the unit you want to use as the unit of 
measure.

6 Click Verify.
Note: The Verify button changes to Stop. To stop the Design Verification 
process at any point, click Stop. 
When the process is complete, the total number of errors found during the 
Design Verification process, up to the maximum number specified in the 
Maximum Violation field appear in the Results list.

7 To view the description of a violation result, select the violation from the 
Results list.
The description appears in the Description field. The description includes 
information such as the type of violation, the location where it occurs (x- and 
y-coordinates), the component or entity it affects, and the actual value 
measured.
Note: When you select a violation result, AutoVue zooms to the entity or set 
of entities that were affected and highlights them on the drawing.

8 Continue to select violation results to view its description.
Note: Click Reset to restart a new check.

9 Click Close to close the Verify Design dialog box.

Exporting the Design Verification Results
You can export the design verification results into a text file.
1 Verify a design.

See  Verifying a Design
2 In the Verify Design dialog box, click Export.

The Export Results dialog box appears.
3 Navigate and select the directory where you want to export the results.
4 Enter a file name.
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5 Click Save.
AutoVue saves the design verification results in a .txt (text) or a .csv 
(Common Separated Values) file listing each violation result and its 
description.

6 Click Close to close the Verify Design dialog box.

Searching Using Entity Search
You can search for an entity in a schematic drawing or a PCB design using the 
Entity Search option. To filter entities, apply attribute, or entity type filters as 
search criteria. You can select entities from the results list to highlight them in the 
workspace and the Navigation Panel. You can also export the search results to a 
.txt file.
Note: If the selected entity is small, a flash box appears indicating the location 
of the highlighted entity in the workspace.
To open the Entity Search dialog box, from the Edit menu, select Entity Search. 

From the AutoVue toolbar, you can also click Entity Search .
If your schematic has multiple pages, a Defining Scope dialog box appears. 

Select Current Schematic Page to browse through only one page. Select Entire 
Schematic Design to browse through all schematic pages.
Click OK after making your selection.
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The Entity Search dialog box appears.

Performing an Entity Type-based Search
1 From the Edit menu, select Entity Search.

The Entity Search dialog box appears.

Note: From the AutoVue toolbar, you can also click Entity Search .
2 Click the Entity Types tab.
3 From the Entity Types list, select an entity type.

A list of attributes for the selected entity type appear.
Note: To sort the list by attribute, click the attribute column heading that 
you want to sort by.

4 If you want to search by attribute, select an attribute from the Attribute list.
If you want to search by value, select a value from the Value list.

5 Click Add Filter.
The selected attribute and its corresponding value appear in the list.

6  Repeat steps 4 and 5 until you have all the filters you want.
7 Click Apply Filter(s).

A list of entities matching the search criteria appear showing the column 
headers for the entity’s available attributes.
Note: To remove a filter, select the line in the list containing the attribute 
and value you do not want to use as a filter, then click Remove Filter.
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8 To save the results, click Export Result.
The Save As dialog box appears.

9 Specify the file name and the directory where you want to store the file, then 
click Save.
AutoVue saves the results in a .csv (Comma Separated Values) file.

10 To view the properties of an entity, select the entity from the Entity Types list 
or the Attributes list, then right-click and select Show Entity Properties.
The Entities Properties dialog box appears and displays the properties for the 
selected entity.

11 To show the net connectivity, click the Attributes tab, select the entity from 
the list, then right-click and select Show Net Connectivity.
The net connectivity for the selected entity is highlighted in the workspace.

12 Click Close to close the Entity Search dialog box.

Performing an Attribute-based Search
1 From the Edit menu, select Entity Search.

The Entity Search dialog box appears.

Note: From the AutoVue toolbar, you can also click Entity Search .
2 Click the Attributes tab.
3 From the Attributes list, select an attribute.

The Owner, Type, and Value of the selected attribute appear in the list.
Note: To sort the list by Owner, Type, or Value, click the column heading 
that you want to sort by.

4 If you want to search by owner, select an owner from the Owner Filter list.
If you want to search by value, select a value from the Value Filter list.
Note: You can also enter an Owner Filter or Value Filter in the text box.

5 Click Apply Filter(s).
A list of entities matching the search criteria appear displaying the Owner, 
Type, and Value columns.
Note: Select an item in the result list and right-click to access options like 
Zoom Selected and Show Entity Properties.

6 To save the results, click Export Result.
The Save As dialog box appears.

7 Specify the file name and the directory where you want to store the file, then 
click Save. 
AutoVue saves the results in a .csv (Comma Separated Values) file.

8 Click Close to close the Entity Search dialog box.
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Measuring in EDA Files
In EDA files, you can take measurements of distances, areas, arcs, and so on. 
When measuring, you have the option to “snap” to geometrical or electrical 
points on the drawing.
From the Analysis menu, select Measure to access the Measurement options. 

Note: From the AutoVue toolbar, you can also click Measure .
The following table outlines the available measuring options:

EDA Snapping Modes
The snapping modes allow you to click to precise geometrical or electrical 
points. For example, when you select Snap to Pin, move the cursor over the pin 
you want to select until the pin is highlighted, then click. Highlight and click a 
second pin to measure the distance between them. 
The snapping modes allow you to snap to the mid, center, and end-points of an 
entity, as well as a pin, via, and symbol. The following table outlines the 
available snapping modes:

Name Description

Angle Measure the angle between selected points.

Arc Measure an arc entity.

Area Measure a selected area.

Distance Measure the distance between two points.

Minimum Distance Measure the minimum distance between entities.

Button Snap to Description

End-point Geometric snap mode where a snap box appears 
when moving the cursor near the component’s end 
point.

Mid-point Geometric snap mode where a snap box appears 
when moving the cursor near the halfway point of a 
linear component.
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Measuring Distance
Use the Distance option to measure the distance between two specific points.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Distance tab.
3 Select the snapping modes that you want to use for measuring.

To select all snapping modes click All On. 
To deselect all snapping modes click All Off.
See  EDA Snapping Modes

4 From the Measured Distance Units list, select the unit in which you want to 
measure the distance.
Note: If you want to measure the distance along a path, select Cumulative.

5 Click a point on the drawing to define the starting point.
6 Click another point on the drawing to define the end point.

Note: If you selected Cumulative, continue clicking points along the path 
that you want to measure.

7 Right-click to complete the measurement.
The points are joined by a line. The measured distance, Delta-X, Delta-Y 
and the “Manhattan Distance” appear in the Measurement dialog box. 
Note: Click Reset to take another measurement.

Center-point Geometric snap mode where a snap box appears 
when moving the cursor near the center of an ellipti-
cal component.

Pin Electrical snap mode where a snap box appears 
when the cursor touches a pin.

Via origin Electrical snap mode where a snap box appears 
when the cursor touches a via.

Symbol origin Electrical snap mode where a snap box appears 
when the cursor touches the entire component.

Free snap Allows snapping at any point on the drawing.

Button Snap to Description
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8 Click Close to close the Measurement dialog box.

Calibrating Distance
1 Measure the distance between two points or measure cumulative distance.

See  Measuring Distance
2 In the Measurement dialog box, click Calibrate.
3 The Distance Calibration dialog box appears displaying the measured 

distance.
4 From the Measured Dist. list, select the unit to which you want to calibrate 

the distance.
5 Select Calibrate to and enter a value if you want to calibrate the distance to 

a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

6 Click OK. 
The calibration results appear in the Measurement dialog box.

7 Click Close to close the Measurement dialog box.

Measuring Minimum Distance
Use the Minimum Distance option to measure the minimum distance between 
entities. The available entities for snapping are nets, pins, vias, and traces.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Min. Distance tab.
3 Select Set 1  to select the entities that you want to measure from.
4 Select the snapping modes that you want to select as the entities for the 

measurement.
See  EDA Snapping Modes
Note: If you click Select Nets, you cannot select any other type of entity.

5 Click the first set of entities on the drawing.
The entities are highlighted.
Note: To clear the last set of entities you selected, click Clear Set.

6 Select Set 2  to select the entities that you want to measure to.
7 Click the second set of entities on the drawing.

The entities are highlighted in a different color.
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8 From the Measured Min. Distance Units list, select the unit in which you 
want to measure the distance.
Note: Select Zoom to Result, if you want to zoom into the measurement on 
the drawing.

9 Click Compute.
The minimum distance from the first set of entities to the second set is 
highlighted by a line. The minimum measured distance, Delta-X, Delta-Y, 
and the Manhattan Distance appear in the Measure Min. Distance section of 
the dialog box.

10 Click Close to close the Measurement dialog box.

Measuring Area
Use the Area option to measure the area and perimeter of a region.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Area tab.
3 Select Between Points if you want to measure the area between points on a 

drawing. The snapping modes are displayed.
Select the snapping modes that you want to use for measuring.
To select all snapping modes click All On. 
To deselect all snapping modes click All Off.
See  EDA Snapping Modes

4 Select Shape if you want to measure the area of a predefined shape on the 
drawing; the snapping modes are disabled.

5 From the Measured Area Units list, select the unit in which you want to 
measure the area.

6 From the Perimeter Units list, select the unit in which you want to measure 
the perimeter.

7 In the Net Area Result section of the dialog box, select Add to cumulate a 
net area result of different areas. 
To subtract an area from the Net Area Result, select Subtract. 
Select Clear to clear the Net Area Result.

8 If you selected Between Points, click points on the drawing to define the 
area.
Each point is joined by a line. The area and perimeter measurements appear 
in the Measurement dialog box.
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9 If you selected Shape, click the edge of the predefined shape that you want 
to measure.
The shape is highlighted. The area and perimeter measurements appear in 
the Measurement dialog box.
Note: Click Reset to take another measurement.

10 Click Close to close the Measurement dialog box.

Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Angle tab.
3 Select From 3 Points if you want to measure the angle between three points. 

Snapping modes are displayed. 
Select the snapping modes that you want to use for measuring.
To select all snapping modes click All On. 
To deselect all snapping modes click All Off.
See  EDA Snapping Modes

4 Select Between 2 lines if you want to measure the angle between two lines.
5 From the Measured Angle Units list, select the unit in which you want to 

measure the angle.
6 If you selected From 3 Points, click three points to define the angle.
7 If you selected Between 2 Lines, click two lines to define the angle.

Angle arms appear with an arc connecting them. The angle measurement 
appears in the Measurement dialog box.
Note: Click Reset to take another measurement.

8 Click Close to close the Measurement dialog box.

Measuring an Arc
Use the Arc option to define or select an arc in the drawing and measure its 
radius, center and diameter.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
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2 Click the Arc tab.
3 Select From 3 Points if you want to measure the arc between three points. 

Snapping modes are displayed. 
Select the snapping modes that you want to use for measuring.
To select all snapping modes click All On. 
To deselect all snapping modes click All Off.
See  EDA Snapping Modes

4 Select Arc Entity if you want to measure a predefined arc.
5 From the Arc Info list, select the unit in which you want to measure the 

distance of the arc.
6 From the Measured Angle Units list, select the unit in which you want to 

measure the angle.
7 If you selected From 3 Points, click three points to define the arc.

The points are joined by an arc. The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle and sweep 
appear in the Measurement dialog box.

8 If you selected Arc Entity, click the edge of the arc that you want to 
measure.
The arc is highlighted. The measurements for center point coordinates, 
radius, diameter, arc length, start and end of angle and sweep appear in the 
Measurement dialog box.
Note: Click Reset to take another measurement.

9 Click Close to close the Measurement dialog box.

Calibrating an Arc
1 Measure an arc in the drawing.

See  Measuring an Arc
2 In the Measurement dialog box, click Calibrate.

The Radius Calibration dialog box appears and displays the measured 
distance.

3 From the Measured Rad. list, select the unit to which you want to calibrate 
the distance.

4 Select Calibrate to and enter a value if you want to calibrate to a value.
Select Set Factor and enter a value if you want to calibrate by a factor.

5 Click OK.
The calibration results appear in the Measurement dialog box.

6 Click Close to close the Measurement dialog box.
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EDA Terms and Definitions
Annular ring
A circular strip of conductive material that remains after a hole has been drilled 
through the pad of a printed circuit board.

Anti-copper
An area within a fill zone in which copper cannot be placed.

Aperture
An opening, similar to the aperture of a camera, that is used for photo-plotting. 
Apertures are available in various sizes and shapes.

Aperture list
A text file containing the dimensions for each of the apertures used to photo-plot 
PCB artwork.

Clusters
Components that are grouped according to their interrelationships and placed in 
close proximity on the board. This keeps the connections on the PCB short so 
that the board is easier to work with.

Component
An element or a part of a PCB.

Component density
The quantity of components on a unit area of a PCB.

Component hole
A hole in the printed circuit board that corresponds to a pin or wire of a 
component. This hole serves the dual function of attaching the component to the 
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board and establishing the electrical connection between the pin or wire and the 
remainder of the board circuitry.

Component library
A computer data file that contains the footprint patterns for a number of 
components.

Component side
The uppermost or top layer of a board on which most components are placed.

Component silkscreen
The silkscreen markings of the printed circuit board that appear on the 
component side. The silkscreen is applied over the solder mask.

Component solder mask
The colored, usually translucent, coating applied to the board over the etched 
copper. It protects the selected areas from the soldering process.

Connection
An unrouted, partially routed, or completely routed path between two pads. In a 
net with n pads, there are exactly n–1 connections.

Copper pour
A method by which a copper zone is filled with a specified pattern, with objects 
that cross the zone or lie within the zone being avoided.

Copper zone
An area on a board designed to be covered by a layer of copper when 
manufactured. Also known as a "metal zone".

Cross hatching
The breaking up of large conductive areas by the use of a pattern of lines and 
spaces in the conductive material.
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Datum
A specific location (a point) that serves as a reference to locate a PCB pattern or 
layer for manufacture.

Density
On a PCB, the degree to which components are packed on the board. Generally, 
the density is given as the number of square inches per equivalent, i.e., a lower 
number indicates a more dense board.

Discrete components
Components with three or fewer electrical connections (for example, resistors or 
capacitors).

Electrical check
The process of checking the PCB to ensure that the connections they are on 
match those specified in the net list.

Fill zone
A zone that defines an area to be filled with copper.

Fine pitch
A class of surface-mount components that is characterized by pins measuring 
0.025 inches or less from pad center to pad center.

Footprint
The physical description of a component. It consists of three elements: 
padstacks, representing the pads of the component; obstacles, representing 
among other things, the physical outline of the component, silkscreens, keepouts/
keepins, and assembly drawing data; and text documenting the footprint 
information (for example, the component name). You may want each project to 
have its own footprint library containing all the footprints used in that project. 
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Ground plane
A large area on the PCB, usually an entire layer, that provides a common ground 
connection for all component ground pins and other ground connections.

Heatsink
A mechanical device made of a high thermal conductivity material that dissipates 
heat generated by a component or assembly.

Heuristics
A method of routing that consists of repeated attempts to apply very simple 
routing patterns to unrouted connections in order to complete the routing quickly 
and cleanly. Typically, heuristics are used for memory and short point-to-point 
routing.

Hole
The area where board material must be removed by drilling or milling.

Isolation
The clearance around a pad, track, zone, or via that defines the nearest approach 
allowed by conductors of another signal set.

Jumper wire
A discrete electrical component or wire used to make electrical connections 
between points that have no copper etch due to board density or some other 
factor. 

Keepout
An area fill within which no routing is allowed.

Land
The copper pad needed for a surface mount pin.
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Layer
One in a series of planes in a PCB design on which tracks are arranged to connect 
components. Vias connect tracks and zones between layers.

Manual routing
Individual connections, in the form of traces, vertices, arcs, and so on, which are 
entered manually into the PCB design.

Mounting hole
A hole used for the mechanical support of a PCB or for the mechanical 
attachment of components to a PCB.

Multi-layer board
A PCB that has multiple layers, separated by dielectric material, with 
connectivity between layers established by vias or through-holes. This term 
usually refers to a board with more than two layers.

Net
A logical construct (circuit) that originates in a schematic and is transferred to a 
board to describe required electrical connections. The connections may be 
completed by using vias, tracks, or zones.

Net list
List of names of symbols or parts and their connection points which are logically 
connected in each net of a circuit. A net list can be extracted electronically on a 
computer from a properly prepared schematic.

Obstacle
An outline representing an object on the board. It must be taken into account 
during routing, placement, or copper pour.
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Pad
On a PCB, a copper shape on one or more layers (there may be a hole and an 
isolation surrounding the copper) used for connecting a component pin to the 
PCB. The pad indicates where pins of a component are placed.

Padstack
A numbered list of pad descriptions. Each description contains a pad definition, 
including layer, style, drill diameter, size, offset, and solder mask guard width. 

PCB - Printed Circuit Board
A PCB is a board made up of components affixed to a common surface and 
connected by copper tracks.

Pin
The portion of a component to which an electrical connection can be made.

Ratsnest
A number of unrouted straight-line connections between two or more pads that 
represent the electrical connections in the netlist. The ratsnest serves as a 
reminder that the pads must be connected, and that, currently, there is no track on 
the board to make that connection.

Reference designator
A character string denoting the type of component and a number that is specific 
to that component.

Routing
Placing conductive interconnects between components on a PCB layout. The 
process of turning nets into tracks.

Schematic
A graphical description of an electrical circuit.
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Segment
The partial track that exists between two adjacent vertices or between a vertex 
and a pin. Sometimes the track between two pins is also called a segment, 
although connection is usually the more appropriate term here.

Signal
An electrical impulse of a predetermined voltage, current, polarity, and pulse 
width.

Silkscreen
Text or outlines (in ink) on the solder mask, on the top, and sometimes on the 
bottom of board modules. A silkscreen is used for component and identification 
placement on a PCB and usually includes component outlines, reference 
designators, polarity indicators, pin one markings, part numbers, the company 
name, and copyright info.

SMT - Surface Mount Technology
PCB technology whereby the leads on the chips and components are soldered 
onto the surface of the board rather than inserted into it. The use of SMT results 
in smaller and faster printed circuit boards.

Solder mask
A negative plot of pads with a guard band around the pads. Also, a lacquer 
applied to prevent solder from adhering to unwanted areas on the PCB.

Solder paste
A pattern that serves as a template for solder paste application when the board is 
manufactured.

Solder side
The PCB surface opposite the one on which most components are mounted 
(component side). Also, the bottom layer of the board.
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Test point
A special point of access to an electrical circuit that is used for electrical testing 
purposes.

Through-hole via
A via that connects the surface layers on a PCB.

Trace (Track)
The copper trails (electrical connection between two or more points) on the PCB 
and the onscreen representation of that copper.

Venting patterns
Patterns etched in the board that allow gases formed during fabrication to escape.

Vertex
A logical point at which a track is ended and restarted. A vertex is located at each 
change of direction on the track.

Via (feed-through hole)
A hole connecting layers of a PCB. A through-hole via connects the surface 
layers of a board. On multilayer boards, a via not reaching a surface layer on one 
side is called a blind via, and a via not reaching a surface layer on either side, 
thus being externally invisible, is called a buried via.

Viastack
A numbered list of via descriptions. Each description contains a via definition, 
including layer, style, drill diameter, size, offset, and solder mask guard width.

Via stringer
The copper etch that exists between a SMT pad and a corresponding fanout via.
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Zero-length connection
An unrouted connection between layers where the end points in the connection 
have the same X- and Y- coordinates.

Zone
An area on a PCB layer designated as copper or anti-copper. Copper zones may 
have net names, while anti-copper zones may not.
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Working with 3D Files
From AutoVue’s 3D mode, you have many ways in which to manipulate the 
model. For example, you can select model parts to transform independently from 
the rest of the model, as well as modify the selected model part’s visibility and 
attributes. 3D mode also gives you the ability to perform an entity and mass 
properties search, and it allows you to import 3D models into the current window 
and export files to other formats. Additionally, the Global Axes inform you of 
where the X, Y and Z axes are positioned throughout all the operations you 
perform in AutoVue.
The Perspective option shows objects in three dimension with distances, planes 
and curved surfaces adjusted to give a sense of depth. You have lighting options 
where you can adjust the overall lighting surrounding a model or just its source 
light.
You can also customize operations to suit your needs. For example, you can 
create and save your own views. Define cross sections and cut-throughs of 3D 
models. Create a customized three-axis coordinate system that you can set as the 
active coordinate system for your 3D files.
There are also features like Bill of Material (BOM), Interference Checking and 
Product and Manufacturing Information (PMI) Filtering.

Models Tab
The Models tab includes the Model Tree. The tree displays the model’s hierarchy, 
inter-relation of different parts, assemblies, bodies, and missing XRef 
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notifications. With the tree, you can select different parts and modify their 
attributes such as color, visibility, render mode or transformation.

Views Tab
The Views tab lists all the standard, native, and user-defined views. You can 
switch to a standard, native, or user-defined view, as well as add or delete user-
defined views.
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Bookmarks Tab
The Bookmarks tab lists links to specific views (Draft views, 2D plans) or other 
files with information related to the model. 

Navigate between these files and views by clicking the appropriate link. 
Bookmarks lead to various views of CAD files such as CATIA file Model Space, 
the 3D model of a file and associated 2D engineering drafts.
If a plus sign appears to the left of a bookmark, click it to expand and view the 
lower bookmark levels. If a minus sign appears to the left of the bookmark, click 
it to collapse the lower bookmark levels.
To go to a destination specified by a bookmark, click the bookmark text or the 
page icon located to the left of the bookmark text.

Global Axes
By default, there is a three-axis representation in the lower left corner of the 
workspace. The X-axis is red, the Y-axis is green and the Z-axis is blue. When 
transforming a model or defining a viewpoint, all operations are applied with 
respect to these axes.

Selecting Model Parts
In AutoVue, you can select model parts from the Model Tree or from the 
workspace and have them appear highlighted in the Model Tree and on the 
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model. You can also select a model part and have all its identical parts appear 
highlighted on the model and in the Model Tree.

See Also  Model Tree
Note: In AutoVue, you can configure the Selection Highlight.

See  Configuring AutoVue for 3D Files

Select Model Parts from the Workspace
1 Select a part or parts on the model in the workspace.

Note: To select more than one model part, press the Shift or Control key 
while selecting.

2 To select the parent entities of a selected part, press the Shift key and select 
the part again.
A pop-up appears listing the parent entities of the selected part. Select an 
entity from the pop-up list.
The selected part or parts appear highlighted on the model and in the Model 
Tree.

3 To select a group of parts, from the Edit menu, select Select, then click and 
drag the mouse around the parts. 
The entities within the box are selected and highlighted in the Model Tree.
Note: If the selected entity is hidden in the Model Tree, the Model Tree 
expands to display the selected entity.
See  Selecting Model Parts from the Model Tree

Selecting All Identical Parts of a Model
1 Select a model part in the workspace or from the Model Tree, then right-

click and select Select Identical Parts.
All identical parts are highlighted on the model and in the Model Tree.
If there are no identical parts found, a message appears indicating “No 
identical parts found”.
Note: You can also select sub-assemblies and Select Identical Parts to 
display all identical sub-assemblies.

Re-Centering
The Re-center option repositions the model back to the center of the View 
window. You can use a model part as a central reference point to reposition a 
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model. You can select several model parts to use as one collective central 
reference point.

Re-Centering a Model to a Selected Model 
Part
1 Select the model part or parts that you want to use.
2 From the View menu, select Re-Center, and then select Selected.

The model is repositioned using the selected model part or parts as the 
central reference point.
Note: The Selected option is only available when one or more model parts 
are selected. 

Re-Center All
The Re-Center All option repositions the entire model back to the center of the 
AutoVue workspace.
1 From the View menu, select Re-Center, and then select All.

The model is repositioned to the center of the workspace.

Re-Centering a Model to an Entity
You can use an entity as a central reference point to reposition a model. The 
entities are as follows:

Entity Description

Vertex All vertices are highlighted. Select a vertex to use as the central refer-
ence point.
Note: A snap box appears when moving the mouse over a vertex.

Edge All edges are highlighted. Select an edge to use as the central reference 
point.
Note: A snap box appears when moving the mouse over an edge.

Midedge Highlight all edges in the model. Select a mid-edge to use as the central 
reference point.
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1 From the View menu, select Re-Center, and then select Entity.
The Re-Center dialog box appears.

2 Select the entity that you want to use as the central reference point.
All instances of the entity are highlighted.

3 Click an instance of the entity.
The model is repositioned using the selected entity as the central reference 
point.

4 Close the Re-Center dialog box.

Model Tree
The Model Tree displays the model’s hierarchy, inter-relation of different parts, 
assemblies, bodies, and missing XRef notifications. With the tree, you can select 
different parts and modify their attributes such as color, visibility, render mode or 
transformation.

Expanding/Collapsing the Model Tree
You can expand the Model Tree to display child entities of a selected node or 
nodes. 
Note: You can also can configure the level you want to expand the Model Tree.

See  Configuring AutoVue for 3D Files
1 Click the Models tab.
2 From the Model Tree, select the node or nodes that you want to expand, then 

right-click and select Expand All Children.
Note: To select more than one node, press the Shift or Control key while 
selecting.

Arc Center Highlight all arcs and circles in the model. Select an arc center to use as 
the central reference point.
Note: A snap box appears when moving the mouse over an arc or 
circle, indicating the center of the arc.

Face Select a face to use as the central reference point.
Note: When moving the cursor along a model face, the face is 
highlighted.

Entity Description
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The selected entities are highlighted. The Model Tree expands displaying the 
child entities of the selected nodes.

3 To collapse a node, select the node, then right-click and select Collapse All 
Children.
The Model Tree collapses the selected node.

You can also expand a node by clicking . To collapse a node click .

Missing XRef Notification Icon
If there are missing XRefs, the Missing XRef Notification icon  appears in 
the Model Tree to the left of the missing XRef. To view the missing XRefs, do 
the following:

1 From the status bar, click the Resource icon .
The Properties dialog box appears.
Note: You can also view the missing XRef from the File menu, and then 
selecting Properties. 

2 Click the Resource Information tab.
The missing XRefs appear in the External Reference File Reference File 
Resources section of the dialog box.

3 Click OK to close the dialog box.
See  Displaying Details About Missing Resources

Selecting Model Parts from the Model Tree
1 Click the Models tab.
2 Select the part or parts from the Model tree.

Note: To select more than one model part, press the Shift or Control key 
while selecting.

The selected part or parts appear highlighted on the model and in the Model Tree.

Hiding Model Parts
You can hide specific parts of a model or display specific parts and hide the rest 
of the model.
1 Select the part or parts on the model or from the Model Tree.

Note: To select more than one model part, press the Shift or Control key 
while selecting.
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The selected part or parts appear highlighted on the model and in the Model 
Tree.

2 To hide the selected part or parts, right-click a selected part on the model or 
from the Model Tree and select Hide.
The selected part or parts are hidden on the model.

3 To display the selected part or parts and hide the rest of the model, right-
click a selected part on the model or from the Model Tree and select Hide 
Rest.
The selected parts are displayed in the workspace and the rest of the model is 
hidden.

Creating 3D Mockups
In AutoVue you can import other 3D Models into the current active file.
Note: The imported files must be 3D and have similar dimensions.
1 From the File menu, select Import File for Mockup.

The Mockup dialog box appears.
2 Click Add.

The File Open dialog box appears.
3 Enter path and file name, or click Browse to locate the file you want to 

import.
4 Click OK.

The file appears in the Mockup dialog box.
Note: To import more than one file, repeat steps 2 to 4.

5 Click OK.
The files you imported appear in the workspace and in the Model Tree.
Note: Once open, you can position these models in the desired manner 
using the Transformation tool, or align the models using Part Alignment, 
or run interference checks. 
See Also  Transformation

Part Alignment
Interference Checks

Deleting Models from a Mockup
1 From the File menu, select Import File for Mockup.

The Mockup dialog box appears.
2 Select the files that you want to remove.
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3 Click Remove.
The files are removed from the list.

4 Click OK.
The files disappear from the workspace and from the Model Tree.

Converting 3D Models to Other 
Formats
Sometimes you need to translate a 3D model to be able to use it with an 
application it was not created from. AutoVue provides several conversion file 
formats for you.

Conversion Options
Depending on the conversion type being performed, the available options in the 
Convert dialog box will vary. These options are:

Option Description

Save As Specify the name and path of the file in which the con-
version is to be stored. This file is also known as the out-
put file. You can use Browse to provide AutoVue with 
the file’s path.

Convert to Format A list of all the possible types of output file formats 
currently available for conversion. The available formats 
are:
• CALS GP4
• Encapsulated Postscript (Raster)
• HP Laserjet Printer (PCL)
• Run Length RLC File
• PCX Bitmap
• PDF
• Stereolithography (STL)
• TIFF
• Virtual Reality Modeling Language (VRML)
• Windows Bitmap
Oracle Corp.



108 AutoVue
Sub-Format The Sub-Format list appears when you select TIFF or 
STL from the Convert to Format list. 
Select the Sub-Format from the list.

Color Depth Select an option from the list:
• 1 = Black and white
• 4 = 16 colors
• 8 = 256 colors
• 24 = True color
• auto = AutoVue selects the color depth that best 

matches the original file.
Note: Option is not available for STL and VRML 
formats.

Positive Triangle Values When selected, the model is translated so that all the ver-
tex coordinate values are positive.
Note: Option is only available when Convert to 
Format is set to STL.

Convert Region The area of the file to be converted. The available 
options are:
• All - converts the entire file
• Display - converts the image to fit on the output 

page
For example, if you zoomed in on a particular 
region of the file, the zoomed portion of the file is 
converted.

• Extent - converts the entire extents of the file
• Selected - converts the selected model parts in the 

file
Note: Options vary depending on the selected format.

Convert Pages The number of pages to be converted. The available 
options are:
• All - converts all pages of the file
• Current - converts the current page of the file
• Range - converts the pages of the file indicated in 

the range
Note: Option is only enabled when converting to TIFF.

Option Description
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Converting a 3D Model
1 From the File menu, select Convert.

The Convert dialog box appears.
2 In the Save As field, enter the path and filename or click Browse to locate 

the directory where you want to convert the file to, then enter a file name.
3 From the Convert to Format list, select the format you want to convert the 

file to.
Note: The Output and Convert area options change according to the type of 
format you choose.

4 Select the output and convert options that you want to set for the file.
See  Conversion Options

5 Click OK.
The Conversion in Progress dialog box appears. The dialog box disappears 
when the file is converted successfully.

Manipulating Views
AutoVue provides the flexibility to manipulate the display of a 3D model. You 
can rotate, scale, or translate a model or any selection of model parts. You can 
also navigate from one page to another page of a multi-page file.
You can access these options from the View menu. The options are:

X and Y Specify X and Y to define the resolution for the con-
verted file.
• X indicates the number of horizontal pixels
• Y is the number of vertical pixels for the current 

active file contents
Note: At times, AutoVue presets X and Y to match the 
specifications of the selected conversion file format.

Menu Sub-Menu Description

Zoom Zoom In Zoom in by a factor of 2. 
From the Autovue toobar, you can also click 

.

Option Description
Oracle Corp.



110 AutoVue
Zoom Out Zoom out by a factor of 2.
From the Autovue toobar, you can also click 

.

Previous Return to the previous zoom level.
From the Autovue toobar, you can also click 

 or right-click in workspace and select from 
pop-up menu.

Selected Resize the object so that the objects selected fill 
the window.

Dynamic Zoom Click and drag the cursor up to zoom in or down 
to zoom out.
From the Autovue toobar, you can also click 

.

Zoom Box Click and drag to draw a box around an object 
that you want to enlarge to fill the window.
From the Autovue toobar, you can also click 

 or right-click in workspace and select 
from pop-up menu.

Zoom Fit Resize object to fit window.
From the Autovue toobar, you can also click 

 or right-click in workspace and select from 
pop-up menu.

Pan Click and drag to reposition the model, then 
release the mouse button.
From the Autovue toobar, you can also click 

 or right-click in the workspace and select 
from the pop-up menu

Menu Sub-Menu Description
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Rotate Click and drag to rotate the model on all three 
axes, then release the mouse button.
From the Autovue toobar, you can also click 

 or right-click in workspace and select 
from pop-up menu.

Spin Click and drag the object in the direction you 
want the object to spin continuously, then release 
mouse button. To stop the object from spinning, 
click once anywhere in the workspace.
Note:  The spin velocity is determined by the 
speed at which you drag the mouse.
From the Autovue toobar, you can also click 

. 

Re-Center All Reposition the entire model back to the center of 
the AutoVue workspace.
See  Re-Centering

Selected Only available when one or more model parts 
are selected. The selected part or parts are con-
sidered as the central reference point by which 
the model is repositioned.
See  Re-Centering

Entity Select a model part or entity as a central 
reference point to reposition a model.
See  Re-Centering

Camera Views Displays different views of 3D models: 
Isometric, Top, Bottom, Front, Back, Left, Right, 
and View Points.
Right-click in workspace and select the view 
from the pop-up menu.
See  3D Views

Views Create your own views of 3D models.
Right-click in workspace and select the view 
from the pop-up menu.
See  3D Views

Menu Sub-Menu Description
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Display Attributes
AutoVue provides several different render methods to display a 3D CAD model. 
You can also adjust the degree of transparency, change color, or visibility to suit 
your preferences.

Render Modes
The choice of render mode varies between the level of detail and the render speed 
of the model. For example, a shaded model is three-dimensional and highly 
detailed but requires more time to render. The different render modes are as 
follows:

Page Next Page Go to the next page of a multi-page file. 
From the Autovue toobar, you can also click 

. 

Previous Page Go to the previous page of a multi-page file.
From the Autovue toobar, you can also click 

. 

Page Number Go to the specified page of a multi-page file.
From the Autovue toobar, you can also click 

. 

Method Description

Wireframe A skeletal model constructed using lines and curves that represent 
the model's "true" edges. All internal lines are visible.

Shaded A solid model constructed of planes and surfaces. These surfaces 
are shaded to increase the illusion of three dimensions.

Hidden Line A wireframe constructed with all internal lines hidden.

Menu Sub-Menu Description
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Changing the Render Mode
Note: A check mark beside the attribute indicates the current render mode.
1 From the Manipulate menu, select Visual Effects, and then select 

Rendering.
Note: You can also change the render mode for selected model parts.

Note: From the AutoVue toolbar, you can also click Render Mode . 
The model or selected model parts change to the selected render mode.

Changing the Visibility
You can choose to show or hide selected parts; this can be done from either the 
Model Tree or the workspace.

See Also  Model Tree
1 From the Model Tree, deselect the check box beside the model part or parts 

that you want to hide.
2 Select the check box beside the model parts that you want to set visible.

The selected model parts appear or disappear from the model.
Note: You can also hide model parts by selecting them on the model or from 
the Model Tree, then right-clicking and select Hide. Selecting Hide Rest 
displays the selected model parts and hides the rest of the model.

Silhouette A wireframe constructed with all internal lines visible but 
including additional silhouette edges. These are not "true" edges 
but help to visualize the model.

Wire Polygons A skeletal model constructed of unfilled polygons.

Shaded Wire An outlined solid model constructed of planes and surfaces. The 
outline is a solid line and the model's surfaces are shaded to 
increase the illusion of three dimensions.

Reflective A solid model constructed of planes and surfaces. These surfaces 
are have a reflective sheer to accentuate the model’s shadows.

Reflective Wire An outlined solid model constructed of planes and surfaces. The 
outline is a solid line and the model's surfaces have a reflective 
sheer to the model’s shadows.

Method Description
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Changing Model Color
You can change the color of a specific model part or selected model parts.
1 Select the model or model parts whose color you want to change.

Note: If no part is selected, the change is applied to the entire model.
2 From the Manipulate menu, select Visual Effects, and then select Color.

The Color dialog box appears.

Note: From the AutoVue toolbar, you can also click Color .
3 Select the color that you want to change to.
4 Click Apply.

The selected part or parts change to the selected color.
Note: To set the model color to its default color, repeat steps 1 to 2 and click 
Reset in the Color dialog box.

Adjusting the Transparency
You can adjust the degree of transparency of a model. This function only applies 
to shaded and shaded wire models.
1 Select the model or model parts whose transparency you want to adjust.
2 From the Manipulate menu, select Visual Effects, and then select 

Transparency.
The Set Transparency dialog box appears.

Note: From the AutoVue toolbar, you can also click Transparency .
3 To adjust the transparency, move the slider left or right.

Select Apply Dynamically if you want the transparency to simultaneously 
change with the movement of the slider.
Note: Alternatively, to adjust the transparency level, you can enter in the 
Value field a value from 0 to 1. Where 0 renders the model opaque (default 
state) and 1 renders it transparent.

4 Click Close to apply the changes and close the Set Transparency dialog box.

Light Settings
The default light setting consists of a white light at the 10 o’clock position with 
respect to the model. In the Lighting dialog box, it appears as a grey ball of white 
light at the 10 o’clock position along the circumference of the larger sphere.
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Ambient lighting is the overall lighting that surrounds an object. It provides 
constant illumination to every surface of the model. This type of lighting is 
particularly effective as a fill-light for surfaces not directly illuminated by a 
directional light source. You can set the intensity or source position; too high a 
setting tends to saturate the image and reduce its clarity.
Using the Directional lighting option, you can adjust the position of the light 
source on an object. 
You can make the following modifications via the Lighting dialog box:
• Set the intensity and source position of the ambient light.
• Set the direction of light.
• Add and remove a light source.
• Change light color, brightness, and specularity.

See  Removing a Light Source

Setting Ambient Lighting
1 From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog box appears.
2 Click and drag the Ambient Light sliding bar until you achieve the desired 

lighting.
The lighting automatically changes with the movement of the sliding bar.
Note: The Custom option is selected when you modify the ambient light.

3 To set the ambient lighting to its default setting, select Default.
4 Click Close to close the Lighting dialog box.

Setting Directional Lighting
Setting the directional lighting adjusts the position of the light source on the 
model. You can also add a new light source.
1 From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog box appears.
2 To change the direction of the light, click and drag the small ball until you 

achieve the desired lighting.
Note: You can also drag the white ball outside of the large ball.
The direction of the light reflected on the 3D model automatically changes 
with the movement of the white ball.
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Note: The Custom option is selected when you adjust the position of the 
light.

3 To set the light direction to its default setting, select Default.
4 Click Close to close the Lighting dialog box.

Adding a New Light Source
1 From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog box appears.
2 Select the Two lights option.

A new light source appears as a black ball in the 5 o’clock position.
3 To add more light sources, right-click inside the square surrounding the ball 

and select Create New Light Source from the pop-up menu.
The Custom option is selected and the new light source appears as a white 
ball.

4 Click and drag the small ball until you achieve the desired lighting.
5 To restore the light source to its default setting, select Default.
6 Click Close to close the Lighting dialog box.
Note: You can have a total of eight light sources at a time.

Changing the Light Properties
1 From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog box appears.
2 To change the properties of the light, such as color or brightness, right-click 

directly on the small ball and select Light Properties.
The Light Property dialog box appears.

3 Select a color from the Color menu.
Additionally, you can drag the Brightness and Specularity slide bars to 
modify the brightness of the source and the brightness of the model’s 
reflection to light, respectively. 

4 Click OK.
The light properties modifications are applied.
Note: To set the light properties to its default setting, select Default.

5 Click Close to close the Lighting dialog box.

Removing a Light Source
1 From the Manipulate menu, select Visual Effects, and then select Lighting.
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The Lighting dialog box appears.
2 Right-click directly on the small ball that you want to remove and select 

Remove Light.
The small ball disappears and the light change is reflected.

3 You can also select Default to restore the lighting properties to its default 
setting.

4 Click Close to close the Lighting dialog box.

3D Views
You can display different views of 3D Models or create your own views.

Default View
The Default View is the isometric view for three-dimensional CAD models. This 
viewpoint has the viewing camera positioned at an equal distance from all three 
axes and pointing directly at the origin.

Setting Standard or Camera Views
Rather than entering Rotation mode, you can view various predefined rotations 
with the Camera Views option from View and Markup modes.
From the View menu, select Camera Views, and then select pre-defined view 
you want to display. The view options are Isometric, Top, Bottom, Front, Back, 
Left, and Right.
The model changes to the selected view.
Note: You can also click the Views tab, then click the view from the Standard 
Views tree, or right-click in the workspace and select Camera Views.

Setting Native Views
AutoVue displays views for a 3D file as saved in its native application.
Note: Native views are present only if the file contains saved views.
From the View menu, select Views, and then select Native Views.
The model re-orients to the selected view.
The view options vary depending on the file. Examples of the view options are 
Last Saved View, Presentation, Front, Back, Left, Right, Top, Bottom, Isometric, 
Trimetric, and Dimetric.
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Note: You can also click the Views tab, and then click the view from the Native 
Views tree, or right-click in the workspace and select Views, and then select 
Native Views.

Creating a User-Defined View
You may want to create and save your own views. AutoVue allows you to define 
a view and add it to the User Defined Views.
Note: You can define a customized view in View or Markup mode. Any views 
you apply to displayed models during Markup mode are saved as part of the 
Markup file.
1 Apply your own views or transformation to the displayed model.

Note: The view states that you can apply and save for your defined view are 
Extents, Rotation, Model Transformation, Explosion, Render Modes, Color, 
Transparency, Visibility, Sectioning, Camera Settings and views involving 
Mockups.

2 From the View menu, select Views, select User Defined Views, and then 
select Add View.
The Add User Defined View dialog box appears.
Note: You can also click the Views tab, then right-click User Defined 
Views and select Add View, or right-click in the workspace and select 
Views, select User Defined Views, and then select Add View.

3 Enter a view name for the view that you want to define.
4 Click OK.

To see the view you defined, click the Views tab and select it from the User 
Defined Views tree or select Views, select User Defined Views. 
Note: You can also alternate between User Defined Views and Standard 
Views without affecting your personalized views.

Deleting a User-Defined View
1 Under the User Defined Views tree, select the view that you want to delete, 

then right-click and select Delete.
A confirmation prompt appears.

2 Click Yes.
The view disappears from the tree.
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Displaying the Perspective Projection of a 
3D Model
The Perspective option shows objects in three dimensions with distances, planes 
and curved surfaces adjusted to give a sense of depth that reflects the desired 
perspective to the eye.
Note: You can use the Perspective option in any of the 3D Views since it is a 
projection mode rather than a viewpoint.
From the Manipulate menu, select Visual Effects, and then select Perspective.
The depth of the model changes.

Viewing a Model from a Particular 
Viewpoint
To view a model from a particular point, you can specify a viewpoint.
1 From the View menu, select Camera Views, and then select View Points.

The View Point dialog box appears.
Note: You can also right-click in the workspace and select Camera Views, 
and then select View Points.

2 Enter the coordinates for X, Y and Z:
•   In the Camera Position fields, enter the coordinates to determine the 

position of the camera lens.
•   In the Target Position fields, enter the coordinates to determine the 

position of the 3D model viewed through the camera lens.
•   In the Up Direction fields, change the coordinates to values between 0 

and 1 to determine the upward orientation.
3 Click OK.

The entity moves to the defined viewpoint. The Global axes and the User 
Coordinates System change position to reflect the viewpoint.

Layers
Use this option to configure the current active file’s layers to display.
1 From the Manipulate menu, select Visibility Control, and then select 

Layers.
The Select the Layers to Display dialog box appears listing the layers and 
layer visibility for the current active file.
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Note: From the AutoVue toolbar, you can also click Layers .
2 To sort the list of layers in the dialog box, click the Name column header to 

sort alphabetically or numerically, or click the Status column header to sort 
by visibility.

3 Select the check box beside the layers that you want to set visible.
Deselect the check box beside the layers that you want to hide.

4 Click OK.
The selected layers are displayed.

Entity Properties
You can view properties such as visibility, colors, transparency, mass properties, 
and extents of a model or model parts.

Viewing Attributes
The Attributes tab displays a model or model part’s attributes. The list of 
attributes will vary depending on the model. Some of the viewable General 
attributes are:

Attribute Description

Color Color of the selected model part.

Density The density of the model or selected model part(s).

Mesh Resolution The number of polygons drawn when displaying a model.

Name The model part name or the displayed page name of the  
model.

Render Mode The dynamic rendering used for displaying model or model 
part. For example, Shaded, Shaded Wire and Wireframe.

Transparency The value between 0 and 1 representing the model or model 
part’s degree of transparency.
0 = opaque
1 = transparent

Visibility The value True (visible) or False (invisible) for a model or 
model part.
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If you are displaying the 3D view of an EDA, AutoVue displays the general 
attributes mentioned above. In addition, displays attributes specific to the Printed 
Circuit Board (PCB), such as component name, board side, component class and 
device type. 
If a 3D file has Product and Manufacturing Information (PMI) and a PMI entity 
selected, the PMI attributes are displayed along with the above general attributes 
and attributes specific to the PCB board. Some of the viewable PMI attributes are 
X-Axis, Y-Axis, font color, text font name, and tolerance type.
1 To view the attributes of specific model parts, select the parts from the 

model.
To view the attributes of the entire 3D model, make sure that no parts are 
selected.

2 From the Analysis menu, select Show Entity Properties.
The Entity Properties dialog box appears.
Note: You can also right-click in the workspace and select Show Entity 
Properties, or in the Model Tree, select the model part or parts, then right-
click and select Show Entity Properties.

3 Click the Attributes tab.
The attributes of the selected model parts are displayed in a hierarchical tree.

4 Click Close to close the Entity Properties dialog box.

Viewing Mass Properties
The Mass Properties tab displays the precise measurements for mass, volume, 
area, center of gravity, moments of inertia, and inertia tensor for any model or 
selection.
1 Select the part or parts for which you want to calculate the mass properties. 

To select multiple parts, press the Shift or Control key while selecting. 
To view the mass properties of the entire 3D model, make sure no parts are 
selected.
Note: You can also make your selection after you open the Entity Properties 
dialog box.

2 From the Analysis menu, select Show Entity Properties.
The Entity Properties dialog box appears.
Note: You can also right-click in the workspace and select Show Entity 
Properties, or in the Model Tree, select the model part or parts, then right-
click and select Show Entity Properties.

3 Click the Mass Properties tab to view the properties of the selected mass. 
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Note: When a mass property cannot be calculated, “N/A” displays in red for 
that property. When this is the case, you can also click Error Report for a 
list of mass properties that could not be calculated.

4 To change the density, change measurement units, or configure computation 
of inertia tensor, click Options.
The Options dialog box appears.
See  Configuring Mass Properties

5 Click OK to close the Options dialog box.
6 Click Close to close the Entity Properties dialog box.

Configuring Mass Properties
From the Mass Properties tab, you can change the density, the measurement 
units or configure the reference point of inertia tensor.
7 From the Analysis menu, select Show Entity Properties.

The Entity Properties dialog box appears.
Note: You can also right-click in the workspace and select Show Entity 
Properties, or in the Model Tree, select the model part or parts, then right-
click and select Show Entity Properties.

8 Click the Mass Properties tab.
9 Click Options.

The Options dialog box appears.
10 To change the density, enter a value in the Density field.

To change the density units, select the unit for Mass and Length from their 
respective lists in the Units section.

11 To apply the density to model parts with unknown density, select Use Only 
for Parts with Unknown Density.
To apply the density to all model parts, select Use for All Parts.

12 To change the display units, select the unit for Mass and Length from their 
respective lists in the Display Units section.

13 To compute the inertia tensor based on output coordinate system, select 
Output Coordinate System Origin.
To compute the inertia tensor based on the center of gravity, select Center of 
Gravity. 

14 Click OK.
Mass properties are instantly calculated and displayed in the Mass 
Properties tab.
Note: When a mass property cannot be calculated, “N/A” displays for that 
property. When this is the case, you can also click the Error Report button 
for a list of Mass properties that could not be calculated.
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15 To save the changes, click Save As. 
The Save Mass Properties As dialog box appears.

16 Specify the path where you want to store the file and enter the file name, 
then click Save. 
AutoVue saves the results in a .txt file.

17 Click OK to close the Entity Properties dialog box.

Viewing Extents
The Extents tab displays the orientation coordinates and center coordinates of 
the X, Y, and Z axes for any model or selection, as well as the width, height, and 
depth measurements.
1 Select the part or parts for which you want to view Extents. To select 

multiple parts, press the Shift or Control key while selecting. 
To view the Extents of the entire 3D model, make sure no parts are selected.
Note: You can also make your selection after you open the Entity Properties 
dialog box.

2 From the Analysis menu, select Show Entity Properties.
The Show Entity Properties dialog box appears.
Note: You can also right-click in the workspace and select Show Entity 
Properties, or in the Model Tree, select the model part or parts, then right-
click and select Show Entity Properties.

3 Click the Extents tab.
You have three extents options:
•   Select Transformed if you want to view the extents after you have 

transformed the model.
•   Select UnTransformed if you want to view the extents of the model 

without transformation.
•   Select Oriented if you want to view the X, Y, and Z coordinates of the 

reoriented model or selection.
4 Click Close to close the Entity Properties dialog box.

PMI Entities
A 3D file's Product and Manufacturing Information (PMI) is composed of 
annotations that are included in design files. These annotations indicate the limits 
and constraints that must be observed during the production of the object 
displayed in the 3D model.
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At the highest level, PMI provides information about dimensions, feature control 
frames, weld specifications, and surface finishes. This information is based upon 
key design features which are specified through datum targets, measurement 
points, reference geometry (for example, construction lines, surfaces, and 
objects), or the geometry inherent in the object.
The following terms can be used interchangeably with the term PMI:
• Datums Cosmetics
• Dimensioning Cosmetics
• Geometric Tolerances (GTOLs)
• Geometric Dimensioning and Tolerance (GDT or GD&T)
• Functional Tolerance Annotation (FTA or FTA&A)

PMI Filtering
Use PMI Filtering to select which types of product and manufacturing 
information to display.
1 From the Manipulate menu, select Visibility Control, and then select PMI 

Filtering.
The PMI Filtering dialog box appears displaying all PMI types.

Note: From the AutoVue toolbar, you can also click PMI Filtering .
2 In the Tree column, select the check box beside the items that you want to 

show in the Model Tree.
In the View column, select the check box beside the items that you want to 
show on the 3D model.
Deselect the check box beside the items that you want to hide.
Note: Click All to show all items, or click None to hide all items.

3 Click OK.
Only items selected in the Tree column are displayed in the Model Tree.
Only items selected in the View column are visible on the 3D model.
Note: Visibility settings are saved and will be restored the next time you 
open the PMI filtering dialog box. 

4 AutoVue supports default PMI visibility as saved in the file. To restore 
default PMI visibility, click Default in the PMI Filtering dialog box.

Aligning to a PMI Entity
From the Model Tree, right-click the PMI item that you want to align to and 
select Align To.
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AutoVue aligns to the selected PMI item.

Go to a Displayed PMI Entity
From the Model Tree, right-click the PMI item that you want to go to on the 
model and select Go To.
AutoVue zooms to the selected PMI item.

PMI Configuration Entities
The Views, Captures, Reference/Grouping entities refer to specific 
configurations of the model. These PMI configuration entities are listed in the 
Model Tree and are activated by right-clicking the entity and then selecting 
Activate. 

Views
The View configuration entity displays predefined views, and highlights 
associated PMI entities.
1 Expand the Views tree to display the defined views.
2 Right-click the selected view, and then select Activate.

The model and PMI entities display in the workspace as defined in the 
selected view. 
Note: The PMI entities are also highlighted in the Model Tree.

Captures
The Captures configuration entity displays predefined views.
1 Expand the Captures tree to display the defined captures.
2 Right-click the selected captures, and then select Activate.

The model and PMI entities display in the workspace as defined in the 
selected capture.

Reference Frames
The Reference Frames configuration entity highlights the grouped PMI entities.
1 Expand the Reference Frames tree to display the predefined reference 

frames.
2 Right-click the selected reference frame, and then select Activate.
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The grouped PMI entities are highlighted in the Model Tree.

PMI Hyperlinks
PMI entities can also include hyperlinks.To fire a PMI hyperlink, do the 
following:
1 From the Model Tree or workspace, right-click the PMI hyperlink entity.
2 From the menu, select Follow Hyperlink.

The 3D Hyperlink dialog box appears if there are multiple hyperlinks 
associated with the selected PMI entity. 

3 From the 3D Hyperlink dialog box, select a link and then click Fire.
The selected link opens.

Manipulate Mode
You can rotate 3D CAD models along a specific axis. You can scale a model part 
up and down, as well as translate the model.
In Manipulate Mode, you can resize, translate, and/or rotate selected parts of the 
model. When you select one or more model parts, AutoVue displays a model-size 
representation of the Global Axes going through the selected part or parts of the 
3D model.

Panning a Model Along the X, Y and Z-Axis
1 From the Manipulate menu, select Manipulate. 

You are now in Manipulate mode.

Note: From the AutoVue toolbar, you can also click Manipulate .
2 Select the model part or parts that you want to move.

Note: To select more than one part, press the Shift or Control key while 
selecting.
A model-size representation of the Global Axes appears through the model 
part or parts and are encased by a three-dimensional box.

3 Click and hold the mouse button on the arrow at the end of the axis that you 
want to pan.

4 Drag the mouse to where you want to move the part or parts.

5 To exit Manipulate mode, click Manipulate , or from the Manipulate 
menu, select Manipulate. 
Oracle Corp.



AutoVue 127
Note: To restore the default state of a part of the model, from the Manipulate 
menu, select Transform, and then select Reset Selected. To restore the default 
state for the whole model, select Reset All.

Rotating a Model Along the X, Y and Z-Axis
1 From the Manipulate menu, select Manipulate. 

You are now in Manipulate mode.

Note: From the AutoVue toolbar, you can also click Manipulate .
2 Select the model part or parts that you want to manipulate.

Note: To select more than one part, press the Shift or Control key when 
selecting.
A model-size representation of the Global Axes appears through the model 
part or parts and are enclosed by a three-dimensional box.

3 Click and hold the mouse button on the sphere at the end of the axis you 
want to rotate. 
Clicking on an axis sphere allows rotation around one of the other two axes. 
Note: The initial mouse movement determines which of the two axes will 
mark the site of rotation. If the axis you chose does not rotate around the 
right axis for the rotation that you want to make, click the sphere again and 
move the mouse in a different direction.

4 Move the mouse to rotate the model by the selected axis. 
Note: If you want to rotate the selection freely, as done in Rotate Mode, 
press the Control key during rotation.

5 To exit Manipulate mode, click Manipulate , or from the Manipulate 
menu, select Manipulate. 

Note: To restore the default state of a part of the model, from the Manipulate 
menu, select Transform, and then select Reset Selected. To restore the default 
state for the whole model, select Reset All.

Scaling a Model Along the X, Y and Z-Axis
1 From the Manipulate menu, select Manipulate. 

You are now in Manipulate mode.

Note: From the AutoVue toolbar, you can also click Manipulate .
2 Select the model part or parts that you want to scale.
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Note: To select more than one part, press the Shift or Control key while 
selecting.
A model-size representation of the Global Axes appears through the model 
part or parts and are encased by a three-dimensional box.

3 Click and drag a corner cube of the box up or down to scale the selected 
model part.

4 To exit Manipulate mode, click Manipulate , or from the Manipulate 
menu, select Manipulate. 

Note: To restore the default state of a part of the model, from the Manipulate 
menu, select Transform, and then select Reset Selected. To restore the default 
state for the whole model, select Reset All.

Part Alignment
With the Part Alignment option, you can select a point on a model’s vertex, 
edge, or face to align to a another model or model part.
The Mobile point determines the precise point of alignment for the model part. 
The Fixed point on the model determines the precise fixed point to which the 
mobile part will align.
When aligning models parts, you can choose from one of the following 
Constraint Types:

Option Type Description

Constraint Coincident The Mobile part is positioned so that the 
selected point on the mobile part coincides 
with the selected part on the Fixed part.

Parallel Align the Mobile point so that it is parallel to 
the Fixed point.

Perpendicular Align the Mobile point so that it is 
perpendicular to the Fixed point.

Concentric Align the Mobile point so that it has the same 
center as the Fixed point
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Part Alignment Constraints
The table below lists the available Constraint Types for different combinations 
of part alignment.

Note: The letters in the table indicate the Constraint Type:
Where:
Coin - Coincident
Par - Parallel
Per - Perpendicular
Con - Concentric

Aligning Model Parts
Note: To see a preview of the alignment before applying the change, select the 
Show Preview check box.
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1 From the Manipulate menu, select Align Parts.
The Part Alignment dialog box appears.

Note: From the AutoVue toolbar, you can also click Align Parts .

2 Select the Constraint Type that you want to perform.
See  Part Alignment Constraints

3 Select the Alignment Type:
•   Select Aligned if you want to align the Mobile point on the model part to 

the Fixed point on the model.
•   Select Anti-Aligned if you want to align the Mobile point on the model 

part so that it is opposite to the Fixed point on the model.

4 Select a model part. The Mobile arrow  is enabled.
Oracle Corp.



AutoVue 131
5 Click Vertex , Edge , or Face  to select the type of 
geometrical point you want to click on the model part to be aligned.
All instances of the selected geometrical point appear highlighted.

6 Click the geometrical point on the selected model part.
The geometrical point is highlighted. 

The Fixed arrow  is enabled.

7 Click Vertex , Edge , or Face  to select the type of 
geometrical point you want to click on the model part to remain fixed.

8 Click the geometrical point on the model.
9 Click Apply.

The model part is aligned according to the chosen options. The Constraint 
Type and the types of geometrical points aligned appear under Constraints 
section of the dialog box.
Note: To remove a constraint, select the Constraint that you want to 
remove, then click Remove. To remove all part alignments, click Remove 
All.

10 Click Close to close the Part Alignment dialog box.
Note: A prompt will appear if you did not apply the changes before clicking 
Close.

11 To restore the default state of a part of the model, from the Manipulate 
menu, select Transform, and then select Reset Selected. To restore the 
default state for the whole model, select Reset All.

Transformation
With the Transformation option, you can rotate, scale, or translate a model or 
any selection of model parts, by using the illustrated buttons or by entering X, Y 
or Z values.
From the Manipulate menu, select Transform, and then select Define.
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The Transformation dialog box appears as below.

Note: From the AutoVue toolbar, you can also click Transform .

In the Transformation dialog box, the buttons on the left correspond to the 
rotational moves along the three axes, and the buttons on the right correspond to 
the translational moves along the three axes and the scaling up and down.

Transforming a Model Using Illustration 
Buttons
1 From the Manipulate menu, select Transform, and then select Define.

The Transformation dialog box appears.

Note: From the AutoVue toolbar, you can also select Transform .
2 Select the model part or parts that you want to rotate, translate, or scale.
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Note: To select more than one model part, press the Shift or Control key 
while selecting. If no part is selected, transformation is applied to the entire 
model.

3 Use the rotate or translate buttons to transform the model.
See  Rotate Buttons

Translate Buttons
4 To set the translate, rotate and scale increments, click Options. The Options 

dialog box appears.
a.  Enter the Translate Increment value in inches.
b.  Enter the Rotate Increment value in degrees.
c.  Enter the Scale Increment value, then click OK.
When you click a rotation, translation or scale button, the model transforms 
in increments of the values entered in the Options dialog box.

5 Click Reset to set the model to its original transformation.
6 Click Close to close the Transformation dialog box.

The transformation state remains displayed.
7 To restore the default state of a part of the model, from the Manipulate 

menu, select Transform, and then select Reset Selected. To restore the 
default state for the whole model, select Reset All.
See Also  Resetting the Transformation of a 3D Model
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Rotate Buttons
The following diagram identifies the function of each rotate button.

Note: To repeat a transformation, continue clicking the button.
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Translate Buttons
The following diagram identifies the function of each translate button.

Note: To repeat a transformation, continue clicking the button.

Transforming a Model by Setting Values
1 From the Manipulate menu, select Transform, and then select Define.

The Transformation dialog box appears.

Note: From the AutoVue toolbar, you can also select Transform .
2 Select the model part or parts that you want to rotate, translate or scale.

Note: To select more than one model part, press the Shift or Control key 
while selecting.

3 To rotate the model by set values, enter the X, Y and Z value.
To translate the model by set values, enter the X, Y and Z value.

4 To view a mirror image, in the Mirror section of the dialog box, select a 
check box.

5 To scale the model by a factor, in Factor field, enter a scale factor.
6 Click Apply.

To apply absolute transformation instead of incremental, select the Absolute 
check box.
Oracle Corp.



136 AutoVue
7 Click Apply.
8 To repeat a transformation, deselect Absolute, then continue clicking Apply.

Note: Click Reset to set the model to its original transformation.
9 Click Close to close the Transformation dialog box.

The transformation state remains displayed.
Note: To restore the default state of a part of the model, from the Manipulate 
menu, select Transform, and then select Reset Selected. To restore the default 
state for the whole model, select Reset All.

See Also  Resetting the Transformation of a 3D Model

Resetting the Transformation of a 3D 
Model
You can reset a model or selected parts to their original transformation. 
1 View the transformed 3D Model.
2 To reset the entire model to its original transformation, from the Manipulate 

menu, select Transform, and then select Reset All.
3 To reset selected model parts to their original transformation, from the 

Manipulate menu, select Transform, and then select Reset Selected.
The model or selected parts changes to their original transformation.
Note: You can also reset selected model parts. To do so, from the Model 
Tree, deselect the check box beside the parts in the Transformation column 

.

Sectioning
With Sectioning feature, you can view the cross-section and cut-through of 3D 
models. In the Define Section dialog box, you can define the section plane 
position, section plane orientation, and the cut-through.
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Section Plane Options
In the Define Section dialog box, you can use the following options to define the 
orientation of the section plane:

Cut Options
In the Define Section dialog box, you can use the following cut options to define 
the cut-through of an object:

Option Description

XY Plane Section plane is oriented along the XY plane.

YZ Plane Section plane is oriented along the YZ plane.

XZ Plane Section plane is oriented along the XZ plane.

From 3 Vertices Select three vertices on the object to define the orienta-
tion of the section plane.

From Face Normal Select a face on the object to define the orientation of the 
section plane perpendicular to the face.

From Edge Tangent Select an edge on the object to define the orientation of 
the section plane perpendicular to the edge’s tangent.

Define a Plane Define X, Y and Z coordinates to orient the section 
plane.

Option Description

Don’t Cut Display the object without a cut.

Cut Object displayed is cut along the section plane.

Invert Reverse the selection, display the other part of the 
object.

Show Both Restore the cut part of the object. 

Edges Only Display only the edges of the object along the section 
plane.
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Defining the Section Plane and Cut-
through
1 From the Manipulate menu, select Section, and then select Define.

The Define Section dialog box appears.

Note: From the AutoVue toolbar, you can also click Sectioning .
2 From the Section Plane list, select the orientation for the section plane.

See  Section Plane Options
3 From the Cut Options list, select the cut option that you want.

See  Cut Options
4 To define the plane position, click and drag the Plane Position slider to the 

position you want.
Select Dynamic, if you want the plane to move simultaneously with the 
slider.

5 Select Show Plane, if you want the section plane visible.
6 Select Fill, if you want the section plane filled.

The section plane is displayed as filled and the Section Area is calculated.
Note: The fill color can also be set from the Configuration dialog box.
See  Configuring AutoVue

7 From the Measured Units list, select the unit in which you want to measure 
the section surface.

8 Click Close to close the Define Section dialog box.
Note: Once you have defined the section plane and closed the Define 
Section dialog box, among other options, you can choose whether to enable, 
remove, or invert a defined section from the Section menu.

Exploding
You can use the Explode option to better understand the structure of an assembly 
and to analyze the dismount capability. You can also save the exploded view, as 
well as obtain a printed document of the exploded product for further analysis.
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Explode Options
From the Explode dialog box, you can define how the explosion is to be 
performed and to visually explode or implode a model. The options that you can 
set are:

Exploding a 3D Model
1 From the Manipulate menu, select Explode.

Note: From the AutoVue toolbar, you can also select Explode .
The Explode dialog box appears.

Option Description

Maximum Depth Define up to which level you want to explode. All entities 
from the root level to the specified level are exploded. All 
entities on the other levels will not be exploded. 
If you are exploding:
• Whole model - the number of available levels depends 

on how many explodable levels exist in the model. For 
example, if there are four levels, with level 2 being the 
first level under the main assembly, then level 3 and 
level 4 are added to the list.

• Selected parts - the number of available levels to be 
added to the list depends on the selected virtual tree.

Animated When selected, animation is shown while exploding or 
imploding the model.

Show Arrows When selected, arrows are displayed in an explosion assem-
bly. The arrow starts from an exploded entity and points to the 
center point of its parent.

Scroll Explode Dragging the slider gradually displays the progression of the 
explosion to show the explosion dynamics.

• Explode - pressing the  button brings the 
explosion level to the (n-1) level if current explosion 
level is between n-1 (inclusive) and n level (exclusive).

• Implode - pressing the  button brings the 
explosion level to the n level if current explosion level is 
between n-1 (exclusive) and n level (inclusive).
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2 Select the parts that you want to explode.
Note: To select more than one model part, press the Shift or Control key 
while selecting. To explode the entire model, ensure that no parts are 
selected.

3 From the Maximum Depth list, select the level to which you want the model 
to explode.

4 Select Animated if you want to see an animated view of the explosion. 
Note: This option is selected by default.

5 Select Show Arrows if you want to display the arrows.

6 To explode the model, click the  button. 
The whole model or the select model parts explode.
See  Saving an Exploded View of a 3D Model

To implode the model, click the  button. 
Note: To manually change the explosion state, click and drag the scroll bar.

7 Click OK to close the Explode dialog box.

The explode state remains displayed, and the Transformation column  
in the Model Tree is updated indicating the exploded parts.
See Also  Resetting the Transformation of a 3D Model

Saving an Exploded View of a 3D Model
From the Explode dialog box, you can save the exploded view of the 3D model.
1 Explode a 3D Model.

See  Exploding a 3D Model
2 Click Save View in the Explode dialog box.

The Add User Defined View dialog box appears.
3 Enter a view name.
4 Click OK.

The view is saved and appears in the Views tab under the User Defined 
Views tree.

5 Click OK to close the Explode dialog box.
The exploded state is saved.
See Also  Resetting the Transformation of a 3D Model
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User-Defined Coordinate Systems
You have the option of creating customized three-axis coordinate systems. As 
with the Global Axes and the World Coordinate System, the user-defined axes 
are represented by a red X-axis, a green Y- axis, and a yellow Z-axis.

See  Global Axes
When you set a User-Defined Coordinate System (UCS) as the active axes, 
operations such as measuring, transforming a model, or defining a viewpoint are 
applied with respect to these axes.
You can create multiple UCS’s for a 3D file. For multiple-page 3D files, you can 
even set active a different UCS for each page.

Position Options
When defining a UCS, you can define the point where you want to place the user 
coordinate system. The options are:

Position Description

(x, y, z) Coordinates If selected, enter a value to specify where the three axes 
are positioned.

Vertex If selected, all vertices are highlighted on the model. A 
snap box appears when you move the cursor on a vertex. 
Click the vertex point where you want to place the user 
coordinate system. The x, y and z coordinate values for 
the vertex are displayed. The UCS axes move to the new 
position.

Edge If selected, all edges are highlighted on the model. A 
snap box appears when you move the cursor near an 
edge. Click at a point on an edge where you want to 
place the user coordinate system. The x, y and z 
coordinate values for the edge point are displayed. The 
UCS axes move to the new position.
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Orientation Options
When defining a UCS, you can define the orientation for the coordinate system. 
The options are:

Midedge If selected, all edges are highlighted on the model. A 
snap box appears when you move the cursor near the 
halfway point of an edge. Click at the mid-edge point 
where you want to place the user coordinate system. The 
x, y and z coordinate values for the mid-edge point are 
displayed. The UCS axes move to the new position.

Arc Center If selected, all arcs and circles are highlighted on the 
model. A snap box appears when you move the cursor 
near the center of a circle or arc. Click on the arc center 
where you want to place the user coordinate system. The 
x, y and z coordinate values for the arc center are 
displayed. The UCS axes move to the new position.

Face If selected, when you move the cursor along a model 
face, the face is highlighted. Click at a point on the face 
where you want to place the user coordinate system. The 
x, y and z coordinate values for the arc center are 
displayed. The UCS axes move to the new position.

Position Description

(x, y, z) Coordinates If selected, enter a value to specify the UCS orientation 
according to one or more of the three axes.

Edge Tangent If selected, all edges are highlighted on the model. A 
snap box appears when you move the cursor near an 
edge. First select the axis that will determine the UCS 
orientation. Click at a point on an edge to define the 
orientation. The x, y and z values for the edge point are 
displayed. The UCS axes are reoriented to the selected 
edge.

Position Description
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Defining a User Coordinate System
1 From the Analysis menu, select Set User Coordinate System.

The User Coordinate Systems dialog box appears.
2 Click New.

The name of the User-Defined Coordinate System (UCS1 for the first one) 
appears in the Coordinate Systems list.

3 To change the name that you want for the UCS, in the Name field, enter a 
new name.

4 Click the Position tab to define the origin of the UCS.
5 From the Define From list, select the point where you want the UCS axes to 

appear.
See  Position Options

6 Click Apply.
7 Click the Orientation tab to define the orientation of the UCS.
8 From the Define From list, select the point where you want to orient the 

UCS.

Face Normal If selected, when you move the cursor along a model 
face, the face is highlighted. First select the axis that will 
determine the UCS orientation. Click at a point on an 
face to define the orientation. The x, y and z values for 
the face point are displayed. The UCS axes are reori-
ented to the selected face.

2 Vertices If selected, all vertices are highlighted on the model. A 
snap box appears when you move the cursor on a vertex. 
First select the axis that will determine the UCS 
orientation. Click two vertex points to define the 
orientation. The x, y and z values for the vertices are 
displayed. The UCS axes are reoriented to the selected 
vertices.

3 Vertices If selected, all vertices are highlighted on the model. A 
snap box appears when you move the cursor on a vertex. 
First select the axis that will determine the UCS orienta-
tion. Click three vertex points to define the orientation. 
The x, y and z values for the vertices are displayed. The 
UCS axes are reoriented to the selected vertices.

Position Description
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See  Orientation Options
9 Click Apply.
10 To hide the UCS axes on the model, deselect the Show Trihedron check 

box. 
Note: This option is selected by default. 

11 Click OK to close the User Coordinate Systems dialog box.
Note: If there is more than one coordinate system for this file, select which 
coordinate system the new UCS will be relative to from the Relative To list. 
Otherwise, the new UCS will be calculated with respect to the World 
Coordinate System.
The newly active trihedral coordinate system appears bolder and larger. 
See  Activating a Coordinate System

Modifying a User-Defined Coordinate 
System
1 From the Analysis menu, select Set User Coordinate System.

The User Coordinate Systems dialog box appears.
2 From the Coordinate Systems list, select the UCS that you want to modify.

The settings you configured for the UCS are displayed.
3 To change the name, highlight the name enter the new one.
4 To change the position of the UCS, click the Position tab, then from the 

Define From list, select the point where you want the UCS axes to appear.
See  Position Options

5 To change the orientation, click the Orientation tab, then from the Define 
From list, select the point where you want to orient the UCS.
See  Orientation Options

6 To show the UCS axes, select Show Trihedron. To hide the UCS axes, 
deselect the check box.

7 To change the UCS that it is relative to, select the UCS from the Relative To 
list.

8 Click OK to close the User Coordinate Systems dialog box.
If you modified the position or orientation, the UCS axes dynamically move 
to the new position. A change in Show Trihedron option will make the UCS 
axes appear or disappear accordingly. Additionally, a name change will 
display the new name in the Coordinate Systems list.
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Activating a Coordinate System
When you set a User-Defined Coordinate System (UCS) as the active axes, 
operations such as measuring, transforming a model, or defining a viewpoint are 
applied with respect to these axes.
1 From the Analysis menu, select Set User Coordinate System.

The User Coordinate Systems dialog box appears.
2 From the Coordinate System list, select the trihedral coordinate system that 

you want to use.
3 Click Set Active.
4 Click OK to close the User Coordinate Systems dialog box.

The newly active trihedral coordinate system appears bolder and larger on 
the model.

Deleting a User Coordinate System
1 From the Analysis menu, select Set User Coordinate System.

The User Coordinate Systems dialog box appears.
2 From the Coordinate System list, select the trihedral coordinate system that 

you want to delete.
3 Click Delete.

Note: The UCS disappears from the list.
4 Click OK to close the User Coordinate Systems dialog box.

Interference Checks
You can check for spatial interference of any two model parts.

Interference Check Options
With the Interference Checking option, you can perform different interference 
checks. These checks are: 

Check Description

All Against All Check for interference of any of the parts in the model.

Set Against the Rest Check where a model part or set of model parts interfere 
with other model parts.
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Performing an Interference Check
1 From the Analysis menu, select Check for Interference.

The Interference Checking dialog box appears.
2 From the Scope options, select the type of interference check that you want 

to perform.
See  Interference Check Options

3 If you selected Set Against the Rest or Set Against Itself, select one or 
more model parts on the model or from the Model Tree.
Note: To select more than one model part, press the Shift or Control key 
while selecting. 
The model parts appear in the Selected Set list and are highlighted on the 
model and in the Model Tree.
Note: To clear the last set of selected model parts, click Clear.

4 If you selected Set 1 Against Set 2, click the Set 1 arrow , then select 
one or more model parts on the model or from the Model Tree.
The model parts appear in the Set 1 list and are highlighted on the model and 
in the Model Tree.
Note: To clear a selected part, press the Control key and click on the part on 
the model. To clear the last set of selected model parts, click Clear.

Click the Set 2 arrow  then select one or more model parts on the model 
or from the Model Tree.
The model parts appear in the Set 2 list and are highlighted in a different 
color on the model and in the Model Tree.

5 In the Minimum Clearance Distance field, enter a distance. The default 
value is 0.
Note: Adding a minimum clearance distance not only checks if the two 
model parts interfere, but also checks if they are located within a set 
minimum distance.

6 From the Units list, select the unit for the clearance distance.

Set Against Itself Check where a model part or set of model parts interfere 
with itself.

Set 1 Against Set 2 Check where a model part or set of model parts interfere 
with another model part or set of model parts.

Check Description
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7 To configure the interference check results, click Options.
The Options dialog box appears.
See  Interference Check Options

8 Click Compute in the Interference Checking dialog box.
Note: The Compute button changes to Stop. To stop the Interference 
Checking process at any point, click Stop
Note: Section plane is not taken into consideration when computing an 
interface check.
When the process is complete, all the instances of interfering pairs appear in 
the Results list. The number of interfering pairs found appears in the 
Description box.
Note: To view a pair’s interference information, click the corresponding 
Results line. The information appears in the Description box and AutoVue 
zooms into the interfering area.

9 To save the results, click Export.
The Export Results dialog box appears.

10 Specify the file name and the directory where you want to save the file.
11 Click Save.

AutoVue saves the results in a .csv (Comma Separated Values) file.
Note: To perform another interference check click Reset, then click the type 
of interference check.

12 Click Close to close the Interference Checking dialog box.

Interference Check Results Options
With AutoVue, you can configure the results of an Interference Check. The 
configuration options are:
• Actions - provides a close-up look at how model parts interfere
• Selected Pair - configure if the selected pair from the Results list should 

display opaque, transparent or hidden
• The Rest - configure if the other parts of the model should display 

transparent or hidden while the selected pair is displayed

Option Select Description

Actions Zoom To Once the interference check is computed 
and a result set is selected from the list of 
results, AutoVue zooms to the result.
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Comparing 3D Files
Note: When comparing 3D files in a non-integrated environment we 
recommend that you use UNC file names or the server protocol so as to ensure 
that all required sub-assemblies and parts are retrieved from correct paths.
For information regarding UNC file names and the server protocol, refer to the 
Installation and Administration Manual.
AutoVue provides the ability to compare two 3D files or two sets of entities from 
the same file or different files and display color-coded comparative data. When 
you compare two files, AutoVue displays a Compare Tree and three windows, 
the first containing the base file, the second containing the file you compared the 
base against, and the third containing the comparison results.
The Compare Tree displays the model’s hierarchy with a State column displaying 
different icons representing the results of the file comparison. The icons indicate 

if an model part has been added , modified , moved  deleted .

Show Intersection Once the interference check is computed 
and a result set is selected from the list of 
results, AutoVue shows where the 
intersection of model parts occur.

Selected Pair Opaque The selected pair from the list of results 
appear opaque.

Transparent The selected pair from the list of results 
appear transparent.

Hide The selected pair from the list of results 
appear hidden.

The Rest Transparent The rest of the model appears transparent 
while the selected pair is displayed.

Hide The rest of the model is hidden while the 
selected pair is displayed.

Option Select Description
Oracle Corp.



AutoVue 149
In the Comparison Result window, results are displayed in different colors to 
differentiate the results of the file comparison. The comparison options and 
corresponding colors are:

To compare files:
1 View the base file in AutoVue.
2 From the Analysis menu, select Compare.

The File Open dialog box appears.
3 Enter the file name or click Browse to locate the file that you want to 

compare with the current active file.
4 Click OK.

AutoVue displays the Compare Tree and three windows. The first window 
displays the base file, the second displays the compare file, and the third 
displays the comparison results.

5 To view the properties of a modified or moved entity in the base file and in 

the compare file, select the modified  or moved  entity from the 
Compare Tree, then right-click and select Entity 1 Properties.
The Entity Properties dialog box appears displaying the properties of the 
entity in the base file.
See   Entity Properties
Select the entity again, then right-click and select Entity 2 Properties.
The Entity Properties dialog box display the properties of the entity in the 
compare file.

6 To compare the results of the entity in the base file to the compare file, select 
the entity from Compare Tree, then right-click and select Compare Results.
The Compare Results dialog box appears.
To view the attribute differences, click Attributes.
To view the transformation difference, click Transformation.
Note: If there are not attribute or transformation differences, the buttons are 
disabled.

7 Click OK to close the Compare Results dialog box.

Option Color Description

View Additions Green Indicates that something has been added.

View Deletions Red Indicates that something has been deleted.

View Unchanged Blue Indicates that there is no change.
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Note: To maximize any of the windows, click the  button on the title bar 
of the window that you want to maximize. To minimize, click the  
button. To restore the window, click the  button.

8 To exit Compare mode, from the File menu, select Exit Compare.
The base file appears in the workspace.

Note: From the AutoVue toolbar, you can also click Exit Compare .

Comparing Entity Sets
From the file comparison, you can compare a set of entities from one file against 
a set of entities from the another file. You can also compare sets of entities from 
the same file.
1 Select the files you want to compare.

See   Comparing 3D Files
2 From the Analysis menu, select Compare Sets.

The Compare Sets dialog box appears.

3 Click  Set 1. Set by default.
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4 Select the entities from either the tree on the left or the tree on the right.
Note: The tree on the left is the base file and the tree on the right is the 
compare file.
The selected entities appear in the Set 1 list.

5 Click  Set 2 point.
6 Select the entities from the other tree that you did not select for Set 1.

The selected entities appear in the Set 2 list.
Note: To compare entities from the same file, select the entities for Set 1 
and Set 2 from either the base file or the compare file.

7 Click OK.
The Compare Tree and the three windows are updated with the set 
comparison results.

8 To restore the comparison files, from the Analysis menu, select Compare 
Files.
The files appear in the three windows.

Generating a Bill of Material
For 3D files, you can obtain a list with a count of the parts required for 
manufacturing the item featured in the file.
To generate a Bill of Material (BOM):
1 From the Analysis menu, select Generate Bill of Material.
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The Bill of Material dialog box appears.

2 To sort the list numerically, click the Count column header. 
To sort the list alphabetically, click the Part Name column header.

3 To view a part or parts on the model, select the parts from the Part Name 
column. 
Note: To select more than one part, press the Shift or Control key while 
selecting.
The parts are highlighted on the model and in the Model Tree.

4 To save the Bill of Material, click Export. 
The Export BOM dialog box appears.
Enter a file name or browse to locate the directory where you want to store 
the file, then click Save.
AutoVue saves the results in a .csv (Comma Separated Values) or .xml file.

5 Click Close to close the Bill of Material dialog box.

Entity Search
AutoVue allows you to search for entities in a 3D model using the Entity Search 
dialog box. You can search the whole model or selected entities on the model, 
apply attributes, entity type or PMI filters as search criteria to filter entities. You 
can also search for entities by the size of an entity and location, or select entities 
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from the results list and have them appear highlighted in the workspace and in 
the Model Tree. 
The Search options are:

Where Option Description

3D Search 
tab

Selection Specify if you want to search the entire model or 
selected parts or parts that are not selected.

Type Specify the type of entity you want to search. For exam-
ple, part, body, assembly or PMI.

Show PMI 
parent entity 
in results

When selected, displays only the parent entity of a PMI 
entity that matches search criteria.
If cleared, displays PMI entities that match search crite-
ria in the Results dialog box.
Note: Option is enabled if Type is set to PMI or All 
and file has PMI entities.

PMI Filter Filters the entities that have PMI information. 
Note: Option is enabled if Type is set to PMI or All.

PMI Type Specify the specific PMI attribute you want to search.
Note: Option is disabled if PMI Filter is set to All.

Attribute 
Filter 
dialog box

Name Specify the specific attribute you want to search. The 
available attributes are:
• Color
• Density
• Display_Mode
• Filepath
• Layer_ID
• Mesh_Resolution
• Name
• Shading_Style
• Translucency
• Visibility
Note: Additional attributes may be available 
depending on the file selected.
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Performing a Search
1 From the Edit menu, select Entity Search.

The Entity Search dialog box appears.

Note: From the AutoVue toolbar, you can also click Entity Search .

Any Value When selected, AutoVue searches for any value of the 
selected attribute.
Note: The attribute value options are disabled.
If cleared, specify the values for the selected attribute 
you want to search.
Note: The attribute value options correspond to the 
selected attribute.

Advanced 
3D Search 
tab

Volume Specify the size of an entity, the minimum and 
maximum dimensions. The dimensions of an entity 
boundary box must be between the specified 
dimensions to meet the search criteria.

Location Specify an axes aligned boundary box. The boundary 
box of an entity must be inside it to meet the search cri-
teria.

Where Option Description
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2 Click the 3D Search tab.

3 From the Selection list, specify what parts of the model that you want to 
search.
To search the entire model, select All.
To search specific parts of a model, select Selected and then select the parts 
on the model.
To search the model parts that are not selected, select Not selected.

4 From the Type list, select the type of entity that you want to search.
Note: For 3D Models that have PMI information, the PMI search features 
are enabled.

5 Select the Show PMI parent entity in results check box if you only want 
the parent entity of the selected PMI entity or entities to appear in the Results 
list.
Deselect the check box if you want all PMI entities to appear in the Results 
list. 
Note: The option is enabled if PMI or All are selected from the Type list 
and the file has PMI entities.

6 From the PMI Filter list, select the type of entities that you want to search.
To search all entities, select All.
To search entities with PMI, select With PMI.
To search entities without PMI, select Without PMI.
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7 From the PMI Type list, select the type of entity that you want to search.
Note: The PMI Type list is disabled if All is selected from the PMI Filter 
list.
See  Saving Search Results

8 Click Close to close the Entity Search dialog box.

Performing an Attribute-based Search
From the Entity Search dialog box, you can search for entities by their attributes, 
such as color, density, shading, and so on.
1 From the Edit menu, select Entity Search.

The Entity Search dialog box appears.

Note: From the AutoVue toolbar, you can also click Entity Search .
2 Click the 3D Search tab.
3 Select the search criteria that you want to use for your search.

See  Performing a Search
4 Click Add. The Attribute Filter dialog box appears.

5 From the Name list, select the attribute that you want to search.
The Value list appears corresponding to the selected attribute.

6 Select the Any Value check box if you want to search by any value. The 
Integer Value options are disabled.

7 Deselect the check box if you want to search by a specific value, then from 
the Value list, select the values that you want to search.
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8 Click OK.
Note: To add more than one Attribute Filter, repeat steps 4 to 8.

9 To edit an Attribute Filter, select the filter and click Edit.
The Attribute Filter dialog box appears allowing you to edit the filter.

10 To disable an Attribute Filter, deselect the check box beside the filter or 
filters that you want to disable.
To enable an Attribute Filter, select the check box beside the filter or filters.

11 To remove an Attribute Filter, in the Entity Search dialog box, select the 
filter and click Remove.
The Attribute Filter disappears from the list.

12 In the Entity Search dialog box, click Search.
A list of entities matching the search criteria appear in the Results list 
displaying the name and type of the entities.
See  Saving Search Results

13 Click Close to close the Entity Search dialog box.

Performing an Advanced 3D Search
From the Entity Search dialog box, you can search for entities using volume or 
location filters. Volume specifies the size of the entity: you can specify the 
minimum and maximum dimensions an entity must be between. Location 
specifies an axes aligned boundary box: you can specify the dimensions for an 
axes aligned boundary box that an entity must be inside.
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1 From the Entity Search dialog box, click the Advanced 3D Search tab.

2 To search for entities by Volume, select the Enabled check box.
Note: If you want to search for entities that match all three dimensions, 
select the Completely contained check box. If the check box is deselected, 
then an entity only has to match one dimension in order to appear in the 
Results list.

3 Enter the minimum and maximum dimensions in their respective fields.
4 From the Units list, select the unit you want to set for the Volume 

dimensions.
5 To search for entities by Location, select the Enabled check box.

Note: If you want to search for entities that match all three dimensions, 
select the Fits completely check box. If the check box is deselected, then an 
entity only has to match one dimension to appear in the Results list. 

6 From the Units list, select the unit you want to set for the Location 
dimensions.

7 Enter the dimensions for Point 1 and Point 2.
8 Click the 3D Search tab.
9 Click Search.

A list of entities matching the search criteria appears in the Results list.
See  Saving Search Results

10 Click Close to close the Entity Search dialog box.
Oracle Corp.



AutoVue 159
Saving Search Results
1 Perform a 3D entity search.

See  Performing a Search
Performing an Attribute-based Search
Performing an Advanced 3D Search

2 Click Search.
A list of entities matching the search criteria appear in the Results list 
displaying the type and name.

3 To save the results, click Export.
The Save As dialog box appears.

4 Specify the path where you want to store the file and enter the file name, 
then click Save. 
AutoVue saves the results in a .csv (Comma Separated Values) file.

Measuring in 3D Files
AutoVue provides the ability to perform measurements in 3D files. When 
measuring, AutoVue provides the option to “snap” to different entity types on the 
model.
From the Analysis menu, select Measure to access the Measurement options. 

Note: From the AutoVue toolbar, you can also click Measure .
The following table outlines the available measuring options:

Name Description

Angle Measure the precise angle between any three vertices or   any 
two edges, planes, faces or any combination of these entity 
types.

Arc Measure the precise radius, length and angle of any arc and 
calculate the center point.

Distance Measure the precise distance between any two vertices, 
edges, mid-edges, arc centers, faces or any combination of 
these entity types.
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3D Snapping Modes
The snapping modes available allow you to select or snap to different entity 
types on a model. For example, if you select Vertex, all vertices are highlighted 
and when you move the cursor over a vertex, a snap box appears.
The snapping modes allow you to snap to vertices, edges, faces, planes and arcs.

Measuring Distance
Use the Distance option to measure the precise distance between two vertices, 
edges, mid-edges, arc centers, faces or any combination of these entity types.
Note: When measuring the distance between faces, if the faces are parallel, 
AutoVue compares the shortest distance between the faces.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Minimum Distance Measure minimum distance between any two vertices, edges, 
mid-edges, arc centers, faces or any combination of these 
entity types.

Edge Length Measure the precise length of a edge.

Face Surface Measure the precise surface area.

Vertex Coordinates Provide the coordinates of each vertex.

Button Snap to Description

Edge Edges are highlighted on the model.
When moving the cursor over an edge, a snap 
circle appears. 

Face Faces are highlighted when you move the cur-
sor over a face and a snap triangle appears.

Vertex Vertices are highlighted on the model.
When moving the cursor over a vertex, a snap 
box appears.

Name Description
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Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Distance tab.
3 From the Measured Distance Units list, select the unit in which you want to 

measure.

4 Click the From  field to select the entity type that you want to measure 
from.

5 Select the snapping modes that you want to use for measuring.
See  3D Snapping Modes
All entities of the selected entity type are highlighted on the model.

6 On the model, select the entity you want to measure from.
Note: If you want to take more than one measurement from the same 
starting point, click Fix Position.

7 Click the To  field to select the entity type that you want to measure to.
8 Select the snapping modes that you want to select as the end point for the 

measurement.
All entities of the selected entity type are highlighted on the model.

9 On the model, select the entity you want to measure to.
The points are joined by a line. The measured distance, Delta X, Delta Y and 
Delta Z appear in the Measurement dialog box.
Note: Click Reset to take another measurement.

10 Click Close to close the Measurement dialog box.

Calibrating Distance
1 Measure a distance.

See  Measuring Distance
2 In the Measurement dialog box, click Calibrate.

The Distance Calibration dialog box appears displaying the measured 
distance.

3 In the Measured Dist list, select the unit to which you want to calibrate the 
distance.

4 Select Calibrate to and enter a value if you want to calibrate the distance to 
a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

5 Click OK. 
The calibration result appears in the Measurement dialog box.
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6 Click Close to close the Measurement dialog box.

Measuring Minimum Distance
With the Minimum Distance option you can measure the minimum distance 
between model parts, as well as any two points from the selection sets: vertices, 
edges, mid-edges, arc centers, faces or any combination of entity types.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Min. Distance tab.

3 Click  Set 1.
4 Select Entity if you want to measure the distance between model parts. 

Snapping modes are disabled.
Select Geometry if you want to measure the distance between entity types. 
Snapping modes are displayed.

5 If you selected Entity, select a part or parts on the model.
The model part or parts appears in the list under Set 1 and are highlighted on 
the model and in the Model Tree.
If you selected Geometry, select the snapping modes that you want to use 
for measuring.
See  3D Snapping Modes
All entities of the selected entity type are highlighted on the model.
Select the entity or entities on the model.
The selected entities appears in the list under Set 1 and are highlighted on 
the model.
Note: To reset a set, click Clear. To clear items from a set, select the items 
and press the Delete key. To deselect a part or entity type on the model, press 
the Control key and left-click the part or entity type.

6 Click  Set 2.
7 Repeat step 5.

The model part appears in the list under Set 2.
8 From the Measured Min. Distance list, select the unit in which you want to 

measure the distance.
9 Click Compute.

The minimum distance from the first set of entities to the second set is 
highlighted by a line. The measured minimum distance, X, Y, and Z 
Oracle Corp.



AutoVue 163
coordinates for Position 1 and X, Y and Z coordinates for Position 2 appear 
in the Measurement dialog box.
Note: Click Reset to take another measurement.

10 Click Close to close the Measurement dialog box.

Measuring an Angle
Use the Angle option to measure the precise angle between any three vertices or 
any two edges, planes, faces or any combination of these entity types.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Angle tab.
3 Select the snapping modes that you want to use for measuring.

Entities of the selected types are highlighted on the model.
See  3D Snapping Modes

4 To measure the angle between an entity type and a plane, select the With 
Plane check box, and then select the plane from the list.

5 From the Measured Angle Units list, select the unit in which you want to 
measure the angle.

6 Click two points on the model to define the angle.
If you selected a Plane, click the vertex, edge or face whose angle you want 
to measure between the plane.
Angle arms appears indicating the angle.The measurement appears in the 
Measurement dialog box.
Note: Click Reset to take another measurement.

7 Click Close to close the Measurement dialog box.

Measuring an Arc
Use the Arc option to measure the precise radius, length and angles of any arc on 
the model. You can also calculates the center point location.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Arc tab.
3 Select Arc Entity if you want to measure a predefined arc.
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All arc and circles are highlighted on the model. Snapping modes are 
disabled.

4 Select From 3 Points if you want to measure the arc between three points. 
Snapping modes are displayed.
Select the snapping modes that you want to use for measuring.
See  3D Snapping Modes

5 From the Arc Info Dist. Units list, select the unit in which you want to 
measure the arc distance.

6 From the Angles Units list, select the unit in which you want to measure the 
angle.

7 If you selected From 3 Points, click three points to define the arc.
The points are joined by an arc. The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle and sweep 
appear in the Measurement dialog box.
If you selected Arc Entity, click the edge of the arc that you want to 
measure.
The arc is highlighted. The measurements for center point coordinates, 
radius, ratio, arc length, angles start, end and sweep appear in the 
Measurement dialog box.
Note: Click Reset to take another measurement.

8 Click Close to close the Measurement dialog box.

Calibrating an Arc
1 Measure an arc.

See  Measuring an Arc
2 In Arc tab, click Calibrate.
3 The Radius Calibration dialog box appears displaying the measured 

distance.
4 From the Measured Rad. list, select the unit to which you want to calibrate 

the distance.
5 Select Calibrate to and enter a value if you want to calibrate to a value.

Select Set Factor and enter a value if you want to calibrate by a factor.
6 Click OK. 

The calibration results appear in the Measurement dialog box.
7 Click Close to close the Measurement dialog box.
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Measuring Vertex Coordinates
The Vertex Coordinates option provides the coordinates of vertices on the 
model.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Vertex tab.

All vertices on the model are highlighted.
3 From the Coordinates Units list, select the unit in which you want to 

measure.
4 Move the cursor over the highlighted vertex that you want to measure.

The X, Y and Z coordinates appear in a tooltip.
5 Select the vertex.

The X, Y an Z coordinates appear in the Measurement dialog box.
Note: Click Reset to take another measurement.

6 Click Close the close the Measurement dialog box.

Measuring the Length of an Edge
Use the Edge Length option to measure the length of any edge on the model.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Edge Length tab.

All edges on the model are highlighted.
3 From the Units list, select the unit in which you want to measure the edge 

length.
Note: If you want to cumulate the measurement of more than one edge, 
select Cumulative.

4 Click the edge that you want to measure.
The edge length measurement appears in the Measurement dialog box.
Note: Click Reset to take another measurement.

5 Click Close to close the Measurement dialog box.
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Measuring Face Surface
Use the Surface option to measure the surface area of a entity face or an entire 
entity on the model.
1 From the Analysis menu, select Measure.

The Measurement dialog box appears.

Note: From the AutoVue toolbar, you can also click Measure .
2 Click the Surface tab.

Select Face Surface if you want to measure the surface area of a face on an 
entity.
Select Entity Surface if you want to measure the surface area of an entire 
entity.

3 From the Measure Surface Units list, select the unit in which you want to 
measure the surface.
Note: If you want to cumulate the measurement of more than one surface, 
click Cumulative.

4 If you selected Face Surface, move the cursor on the model to highlight a 
face surface, then click the face surface that you want to measure.
The face surface is highlighted. The measured surface appears in the 
Measurement dialog box.

5 If you selected Entity Surface, click the entity that you want to measure.
The entity, as well as all the faces belonging to the body are highlighted. The 
measured surface of the body appears in the Measurement dialog box.

6 To measure the face surface of the entity, click on the highlighted body.
A list appears displaying the entity and its parents.
Select the entity or a parent from the list.
The selected entity is highlighted and the measured surface appears in the 
Measurement dialog box.
Note: To measure the face surface of a parent, select the parent from the list.
Note: Click Reset to take another measurement.

7 Click Close to close the Measurement dialog box.
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Configuring AutoVue
Use the configuration options to configure the AutoVue workspace for different 
groups of file formats or for all files in general. For example, you can set 
different background colors for EDA, 2D, 3D, or Office files. You can also set 
paths to locate external resources such as fonts, symbols, or XREFS, or configure 
measurement options. 
To access the configuration options, from the Options menu, select Configure. 
The Configuration dialog box appears. To implement your changes and to close 
the Configuration dialog box, click OK.

See  General Options
Configuring AutoVue for 2D Files
Configuring AutoVue for 3D Files
Configuring AutoVue for EDA Files
Configuring Background Colors for Graphic Files
Configuring Background Colors for Desktop Office

General Options
To access the General configuration options:
8 From the Options menu, select Configure. 

The Configuration dialog box that appears.
9 Click General in the Category tree.

The CAD, Raster, and System Options appear.

Configuring Options for CAD Files
Configure how you want to display w.r.t. text, dimensions, line styles, and so on 
for CAD files:

Option Description

Text • Select to display text entities.
• Clear to hide text entities.

Dimensions • Select to display all dimensional entities.
• Clear to hide simple dimension entities.
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Raster Files
Choose how you want the raster file to display:
• Select Full Resolution to display raster files at full resolution.
• Select Fit to Window to display raster files to fit the current window.

Rendering
When Enable Look Ahead is selected and you zoom into a part of a file, 
AutoVue renders adjacent tiles. The advantage to this is improvement in 
performance when zooming in on parts of a file. The disadvantage is that if the 
client machine is idle for at least one second, Enable Look Ahead is triggered 
which could slow down current operations. However, once all tiles are rendered, 
all zoom operations speed up again.
If Enable Look Ahead is deselected, AutoVue renders the tiles when requested, 
that is, only when you zoom in on parts of the file.

Resources
Select the Resolve Local Resources check box to enable client-side searching of 
XRefs (also know as XRef callback).
Deselect the check box to disable XRef callback.

Line Weights • Select to display varying line thicknesses.
• Clear to make all lines appear equal, with a width of 1 

pixel. No line weights display for any line.

Force to Black • Select to force all colors of a drawing to black.
• Clear to display the file in color.

Line Style • Select to display dotted and dashed lines.
• Clear to display all lines as solid.

Filling • Select to display filled entities as filled rather than just 
an outline.

• Clear to hide filling for filled entities.

Load External
References

• Select to load Xrefs automatically.
• Clear to keep Xrefs from loading automatically.

Option Description
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Configuring Paths
Configure the paths for XRefs and fonts.
When working with files that need external resources, such as fonts or XRefs, 
you may need to specify the path to these external resources if they do not exist 
in the same location as the base file.

Configuring XRef Paths
XRef Paths are the directory paths for any external reference files associated 
with 2D, 3D, or EDA files.
10 From the Category tree, expand General, and then select XRef Paths.
11 Click Add.

The Add Path dialog box appears.
12 Enter the directory path, or scroll to locate the directory where the external 

reference files are located.
To browse all subdirectories below the current path, type two asterisks** at 
the end of the file path.
For example, C:\samples\** results in browsing all subdirectories below 
“samples”.
To browse one subdirectory below the current path, type one asterisk * at the 
end of the file path.
For example, C:\samples\* results in browsing one subdirectory below 
“samples”.

13 Click OK.
The directory path appears.
Note: To add more than one path to the list, repeat steps 3 to 5.

14 To change the order, select the path you want to move, then click Up or 
Down to move the path to where you want it in the list.

15 To remove a path, select the path and click Remove.
16 Click OK to close the Configuration dialog.

Path Description

XRefs The directory paths for any external reference files associated with 2D, 
3D or EDA files.
See  Configuring XRef Paths

Font The directory paths for fonts required by AutoVue’s vector files.
See  Configuring Font Paths
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Configuring Font Paths
Font Paths are the directory paths for fonts required by 2D, 3D, EDA, or Office 
files.
17 From the Category tree, expand General, and then select Font Paths.
18 Click Add.

The Add Path dialog box appears.
19 Enter the directory path or scroll to locate the directory where the external 

font files are located.
To browse all subdirectories below the current path, type two asterisks ** at 
the end of the file path.
For example, C:\samples\** will result in browsing all subdirectories below 
“samples”.
To browse one subdirectory below the current path, type one asterisk * at the 
end of the file path.
For example, C:\samples\* will result in browsing one subdirectory below 
“samples”.

20 Click OK.
The directory path appears.
Note: To add more than one path to the list, repeat steps 3 to 5.

21 To change the order, select the path you want to move, then click Up or 
Down to move the path to where you want it in the list.

22 To remove a path, select the path and click Remove.
The selected path disappears from the list.

23 Click OK to close the Configuration dialog box.

Measurement
The Measurement options let you define the default measurement units and the 
number of decimal places.
From the Category tree, expand General, and then select Measurement.to 
display the options you need.
The available options are as follows:

Option Description

Decimal Digits Lets you specify the number of decimal digits displayed for 
each measurement. Enter a number from 1 to 18.
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Configuring the Base Font for Text Files
The Base Font option lets you define the font properties for text files.
24 From the Category tree, expand General, and then select Base Font.
25 Select a font from the Font list.
26 Select a font size from the Size list.
27 Select the Bold option, Italic option, or both options to change the font style.

Note: You can see a preview of the text in the Sample area.
28 Click OK to apply the font change and close the Configuration dialog box.
Note: The font changes will only apply to text files.

Configuring AutoVue for 2D Files
You can configure background color and snap settings for 2D files. 
29 From the Options menu, select Configure. 
30 The Configuration dialog box appears.
31 From the Category tree, select 2D.

The Snap Settings option appears.

Snap Settings
In measurement mode, when you move the cursor within a predetermined snap 
radius, the snap box appears for the entity to be selected. To change the snap 
radius, change the value in the Snap Radius field. The snap radius is configured 
in pixels.

Configuring Colors
The Colors settings let you modify colors for 2D files. 

Default File Units Lets you specify the units for displaying.

Measurement Units Lets you specify the default unit for measuring.

Option Description
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From the Category tree, expand 2D, and then select Colors to display the 
following options:

Configuring AutoVue for 3D Files
In AutoVue, there are configuration options that you can set to customize the 
work environment when working with 3D files. 
32 From the Options menu, select Configure.

The Configuration dialog box appears.
33 From the Category tree, select 3D.

The Rendering, Dynamic Rendering, and Frame Rate options appear.

Rendering
The Rendering options let you modify the manner in which the model is 
rendered. Changing these options affects the level of detailed displayed. The 
Rendering options are: 

Option Description

Background Change the color of the background for 2D files.

Measurement Modify the color you want displayed when taking 
measurements on 2D files.

Option Description

Smooth Shading Set by default. Turning this option off renders curved sur-
faces of shaded models as a series of flat surfaces. The level 
of detail is thus reduced but render speed is increased.
Note: Only affects shaded models.

Back-Face Removal If selected, instructs AutoVue not to render the back faces 
of the model being displayed. This increases the render 
speed but the model appears less realistic while in motion. 
Note: Only affects shaded models.

Tristrip If selected, enable/disable tristripping of mesh data for dis-
play.
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Dynamic Rendering
The Dynamic Rendering options let you select the rendering mode for a model 
in motion. The options you can select are:

Frame Rate
The Frame Rate slider lets you define the frame rate for rotating and dynamic 
zooming on 3D files. Drag the slider to specify the frame rate. Drag the slider to 
the left for a lower frame rate and to the right for a higher frame rate.
Note: A higher frame rate results in a lower resolution.

Model
The Model configuration options let you control the streaming method, the 
dynamic load mesh resolution, and the visibility of model parts.
From the Category tree, expand 3D, and then select Model to load the Loading, 
Dynamic Load Mesh Resolution, Initial Visibility, and PMI Initial Visibility 
options.

Menu Option Description

Fast Frame Model spins or rotates at a fast rate. The level of detail is 
reduced, which enables faster rendering when the model is 
in motion.

Wire Frame Model is displayed as wire framed during rotation or spin-
ning.

Flat Shading Smooth shading is not performed on curved surfaces while 
the model is in motion.

Wire Polygons Render the model in wire polygon mode while in motion.

Vertex Cloud Model is displayed as a skeleton of vertices when in 
motion.

Bounding Box Model parts are enclosed by bounding boxes when the 
model is in motion.

Current Render Mode Model is rendered in the same mode whether moving or 
static.
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Loading
Control the streaming method with the Dynamic Loader option.
When the option is selected, AutoVue loads enough detail to display an accurate 
visual representation of the model. The data is loaded based on the level of detail 
that is necessary at that point in time.
When the option is deselected, AutoVue requests data in 10% chunks until it 
reaches full resolution for the file. You would see the model initially at coarse 
resolution, but continuously refining.
Note:  For more information, refer to System Administration Guide.

Dynamic Load Mesh Resolution
Control the initial resolution with the Dynamic Load Mesh Resolution slider.
When you select Dynamic Loader, you can control the initial resolution by 
setting the Dynamic Load Mesh Resolution. When you set the Dynamic Load 
Mesh Resolution to High, the file displays at a higher resolution when you zoom, 
resulting in a smoother look.
Note:  For more information, refer to the Installation and Administration 
Manual.

Initial Visibility
With the Initial Visibility options, you can specify the visibility of model parts 
when first opening a 3D file.

PMI Initial Visibility
With the PMI Initial Visibility option, you have the option to set a threshold for 
the number of PMIs to display for large models. To do, select the Don’t display 

Option Description

Default Visibility Load model with default visibility options.

All Visible Force all parts ON in the display.

All Invisible Force all parts OFF in the display.
Note: To display model parts, select the part(s) from the 
Model Tree.
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PMI for large models check box, and then enter the number of PMIs to display 
in the PMI Threshold field.

PMI Filtering
From the Category tree, expand 3D, and then select PMI to display the PMI 
options.
The PMI Filtering options let you configure which types of product and 
manufacturing information to display. The check boxes in the Tree column let 
you select which PMI entity types display in the 3D model tree. The check boxes 
in the View column let you select which PMI entity types display in the 
workspace. 

See  PMI Filtering
The following PMI Text Rendering Style options let you define the style for the 
PMI text: 

Configuring Colors
With the Colors option, you can configure the color to allow easier viewing of 
3D file details. 
From the Category tree, expand 3D, and then select Colors to display the 
Common, Section Highlight, and Geometry Highlight options.

Option Description

Native Setting (from 
file)

PMI text is displayed with the default setting

3D PMI text is displayed in 3 dimension

Flat-to-screen PMI text is displayed in 2 dimension
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Common

Section Highlight

Geometry Highlight

Option Description

Background Set the background color for 3D files.

Selection Set the color when selecting a model or model parts.

Entity Default Set the default color to use when the model color is not read-
able.

Measurement Set the color for measurements.

Min. Distance Set 1 Set the color of the first set-point when measuring minimum 
distance.

Min. Distance Set 2 Set the color of the second set-point when measuring mini-
mum distance.

Option Description

Edges Set the color for the section edges when defining Section Cut 
Options.

Fill Set the fill color when defining Section Cut Options.

Option Description

Vertex Set the color for vertices when highlighted during measure-
ment and markup.

Face Set the color for faces when highlighted during measurement 
and markup.

Edge Set the color for edges when highlighted during measurement 
and markup.
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Configuring Background
With the Background options, you can select a gradient or an image to display in 
the background.
From the Category tree, expand 3D, and then select Background. The 
Background Gradient and Background Images options appear.
For the Background Gradient option, you can select either Plain, Directional 
Gradient, or Radial Gradient. The background is previewed to the right of the 
options.
For the Background Images option, do the following:
1 Click Add.

The Background Image dialog box appears.
2 Click on the ellipses to the right of the Image File field to browse to the 

image file.
Note: You can only select .bmp, .jpeg, or .img files.

3 From the Stretch Type list, select whether to leave the image as is, Stretch to 
fill, Zoom to fit, or Zoom to fill. 

4 From the Position in the Background list, select where to position the image.
5 Click OK when done.

The Background Image dialog box closes.
Note: The selected Background is implemented when you click OK in the 
Configuration dialog box.

Miscellaneous
In the Configuration dialog box, select 3D > Miscellaneous in the tree to 
display the Display, Model Tree, Manipulator, and Selection options.

Display
The Show Global Axes option is active by default. Disable this option to remove 
the axes that display in the bottom-right corner of the workspace.

Model Tree
Enter a different value in the Tree Level field to define the level at which you 
want the Model Tree to collapse when opening a 3D file. The default is 3 levels.
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Manipulator
Select the Align with current UCS option to automatically align the 
manipulators with the current User-Defined Coordinate System.

Selection
The following Selection options let you define how AutoVue indicates that an object is 
selected.

Configuring AutoVue for EDA 
Files
In AutoVue, there are configuration options that allow you to customize your 
work environment when working with EDA files. To access the EDA 
configuration options, from the Options menu, select Configure. In the 
Configuration dialog box that appears, click EDA in the tree.

Customizing Selections
Configure how you want selected components to be highlighted. 
From the Configuration tree, select EDA. There are two selection options: 
Highlight Entity and Dim Unselected.

Highlight Entity
Activate this option to highlight all entities that you select. This option is enabled 
by default. 
Note: The default highlight color is yellow.

See  Modifying Colors

Option Description

Highlight Bounding 
Box

Selection is enclosed in a wireframe box.

Highlight Entity Selection is indicated by changing color.
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Dim Unselected
Activate this option to dim all the entities that are not selected. Selected entities 
retain their original entity color.

Note: From the AutoVue toolbar, you can also click Dim Unselected .
When you select Dim Unselected, you can set the dimness level for entities that 
are not selected. Drag the slider to the right to increase the dimness level and to 
the left to decrease the dimness level. The icon to the right of the dimness settings 
in the Configuration dialog box lets you preview the dimness level.
Additionally, with Dim Unselected, you can select the Thicken Highlighted 
Entity to check box. This option makes the selected entity appear more 
pronounced. Deselect the check box to return the entity to its default thickness.

Displaying Tooltips
When you hover the mouse over an entity, a tooltip appears to show you 
information about the entity. You can disable or enable these tooltips.
When the option is selected, AutoVue automatically retrieves the entity 
information from the server. Clear this option if you do not want this behavior 
every time your mouse hovers over an entity.
6 Select EDA in the tree.
7 Under the Mouse Hover heading, select or deselect the Show Entity 

Information Tooltip check box.
8 Click OK.

Modifying 3D View
You can configure the 3D PCB view of EDA files. 
Note: The Default Board Thickness and Component Height values are read-only 
if the EDA 3D file does not contain board and component information.
1 Select EDA in the tree.
2 Enter a value in the Default Board Thickness field to change the board’s 

thickness. 
Note: The Default Board Thickness option only affects boards that have no 
board thickness defined in the design. If a board has a defined thickness, this 
option does not affect that board.

3 Enter a value in the Default Component Height field to change the 
component height. 
Oracle Corp.



180 AutoVue
Note: The Default Component Height option affects components that do not 
have height defined in the design. If a component has a defined height, this 
option does not affect that component.

4 To work with a different unit of measurement, select another unit from the 
Default Units menu. This is the unit of measurement used for values set in 
the Default Board Thickness and Default Component Height fields.

5 Reload the file to see your changes.

Synchronizing Layers when Comparing 
Files
When you compare files, you can synchronize all layer settings. When the layer 
settings are synchronized, changing one setting changes the same setting for both 
files you are comparing.
1 From the Category tree, select Analysis.
2 Select the Layer Settings check box to synchronize all layer settings when 

comparing files.
Note: This option is only applicable for PCB drawings.

Configuring Zoom Behavior when Cross 
Probing
You can configure the zoom options when you cross probe files.
1 From the Category tree, select Analysis.
2 Select one of the following Cross Probe options:

•   Click Keep Current Zoom Level. When this option is active, the view of 
the target files remains the same while you cross probe. 

•   Click Zoom Selected to automatically zoom in on selected entities while 
you cross probe. This option is enabled by default.

•   Click Zoom Fit to automatically adjust the contents of a file along the 
horizontal or vertical axis to fully display within the current window. 

3 Click OK.

Modifying Colors
You can configure the colors for EDA files. 
Select EDA > Colors in the tree.
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The options that you can configure are grouped under Common and 3D View as 
follows:

Common

3D View

Configuring Background Colors 
for Graphic Files
Specify background colors for mono raster files and color raster files.
1 From the Options menu, select Configure. 

The Configuration dialog box that appears.
2 Select Graphics in the tree. 
3 From their respective Background lists, select colors for mono raster files 

and color raster files.

Option Description

Background Change the background color for EDA files.

Selection Configure the color used to highlight entities.

Min. Distance Set 1 Configure the color of the first selection set point when 
measuring minimum distance.

Min. Distance Set 2 Configure the color of the second selection set point 
when measuring minimum distance.

Option Description

Default Board Color Configure the color of the board in 3D view.

Default Component Color Configure the component color in 3D view.
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Configuring Background Colors 
for Desktop Office
Specify background colors for the following types of Desktop Office files:

•   Document
•   Spreadsheet
•   Database
•   Archive

1 From the Options menu, select Configure.
The Configuration dialog box appears.

2 Select Desktop Office in the tree.
3 Select a background color for each Desktop Office file type.
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Markups
AutoVue has the ability to view hundreds of different file formats and to create 
markups for all its readable file formats without the document's authoring 
application.
Marking up refers to drawing and writing on an electronic document. AutoVue 
provides the ability to markup different formats without modifying the original 
file. When you create a markup for a file, the markup is created on top of the 
original file. Markups are saved in separate files.
Note: When you are creating a markup entity, you can press the Escape key to 
cancel.

If a file has existing Markup files, the Markup Indicator icon  appears on 
the status bar at the bottom of the AutoVue workspace. Clicking this button 
opens the Markup Files dialog box allowing you to select Markup files to open or 
create a new Markup file. When you open a Markup file, AutoVue layers the 
markup over the original file.
In Markup mode you can:
• Create entities such as text, arcs, boxes, circles, clouds, lines, arrows, and 

polygons.
• Add a stamp or information to an entity by adding a text or a note.
• Create, name, and color layers to organize your work.
• Create a new Markup file that combines copies of selected layers of different 

Markup files.
• Create measurement markup entities that can be moved or resized.
• Navigate markups through a hierarchy tree, view markup properties, and sort 

the tree according to each property.
• View markup layers individually or in combination.
Note: Markup capability is only available in certain versions of the AutoVue 
product. For more information, refer to the Product Variations Checklist.
Note: By default, markups are disabled for Office documents. For information 
on how to enable markups for Office documents, refer to the “INI Options” 
chapter in the Installation and Administration Manual.
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Markup Navigation Tree
When you are in Markup mode, a Markup Navigation Tree appears below the 
workspace. If the tree does not appear, from the Options menu, select Show 
Panel, and then select Markup Panel.

The tree displays a hierarchy tree of markups or comments created by users. You 
can navigate through the markups. A set of properties are generated for each 
markup. You can sort the markups in the tree according to each property by 
clicking the column headers. These properties are:

When a markup entity is created, it appears in the tree and the information is 
recorded and saved in the Markup file.
Note: Hover your mouse over an entity to displays its author and date 
properties.

Property Description

Markup Entity Type of markup entity created.

Author The name of the user who created the markup.

Last Modified The date and time the markup was modified.

Page Page number of the original document on which the markup entity 
is created.

Layer Markup layer on which the markup entity is created.
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Filtering Markups
When viewing markups, you have the option to filter the Markup files or entities 
that are displayed based on their metadata information. 
To do so, from the Markup menu, select Filter. The Filter Markup Visibility 
dialog box appears and displays the following options: Author, Entity Types, 
Last Modified, Page, and Layer. 
Note: From the Markup Properties toolbar, you can also click Markup Filter 

.
• To display markups created by a specific author, click the Author tab and 

select the check box next to the author’s name. To remove an author’s 
markup from the filter, deselect the associated check box. In the Markup 
Navigation Tree, a filter icon appears in the Author column header.

• To display markups by entity type, click the Entity Types tab and select the 
check box next to the markup entity or entities. To remove a markup entity 
from the filter, deselect the associated check box. In the Markup Navigation 
Tree, a filter icon appears in the Markup Entity column header.

• To display markups based on when they were last modified, click the Last 
Modified tab. From the list, select one of the following options:
•   Anytime: Displays all markup entities.
•   Before: Displays all markup entities modified before the selected date.
•   After: Displays all markup entities modified after the selected date.
•   On: Displays all markup entities modified on the selected date.
•   Between: Displays all markup entities modified between the selected 

dates.
In the Markup Navigation Tree, a filter icon appears in the Last Modified 
column header.

• To display markups by page location, click the Page tab and select one of the 
following:
•   All pages: Displays markup entities on all the pages.
•   Current page: Displays markup entities on the currently selected page.
•   Page ranges: Displays the markup entities on the selected page range.
In the Markup Navigation Tree, a filter icon appears in the Page column 
header.

• To display markups by layers, click the Layer tab and select the check box 
next to the layer or layers. To remove a layer from the filter, deselect the 
associated check box. In the Markup Navigation Tree, a filter icon appears in 
the Layer column header.
Oracle Corp.



186 AutoVue
Note: To remove the filters, from the Markup menu, select Filter, and then 
select Show All.

Working with Markup Files
AutoVue provides the ability to markup different formats without modifying the 
original file. When you create a markup for a file, the markup is created on top of 
the original file. Markups can be saved as separate Markup files while working 
with the same document. You have the option to add user information to the 
Markup file, save and create separate Markup files with different markup IDs, 
import and export Markup files, or change the active Markup file.

Saved States
When you create and save a Markup file, you also save the view state, such as the 
zoom level at which you are working. If you save the Markup file while you are 
working at your preferred zoom level, the next time you open the Markup file, it 
displays at the same zoom level. Some examples of view states include zoom 
level (extents), rotation and flip settings, transformation, section plane, and 
visibility. When creating markups for 3D files containing imported models, the 
imported design becomes part of the view state. For EDA files, you can save 
user-defined layers with markups. 

See  Creating a User-Defined View
State information is also saved with each markup entity. For instance, if you were 
at a certain zoom level when you created a markup entity, AutoVue saves the 
information with the markup entity. To “Go To” the state you were at when you 
created or modified the markup entity, from the tree, right-click the markup entity 
and select Go To.

Creating a Markup File
To create a Markup file:
1 View a file that you want to markup.
2 From the Markup menu, select New.

AutoVue enters Markup mode and a new Markup file appears in the Markup 
Navigation Tree.
Note: From the Markup Properties toolbar, you can also click New 

Markup .
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See Also  Creating a Markup Layer

Entering Markup Information
When creating a markup you can provide user information that you can save with 
the markup.
From the Markup menu, select Properties. The Markup Information dialog box 
appears.
Enter a user name, department, company name, company location, and telephone 
number. Click OK to save your markup information and to close the dialog box.

Saving a New Markup File
To save a new Markup file:
1 From the Markup menu, select Save. 

The Save Markup File As dialog box appears displaying the Markup 
Information that you entered when creating the markup.
Note: From the Markup Properties toolbar, you can also click Save 

Markup .
2 In the Markup ID field, enter an ID consisting of any combination of 

characters or numbers.
3 Click OK.

The Markup file is saved. The markups and the Markup file remain 
displayed in the workspace and in the Markup Navigation tree.

Opening Markup Files
To open a Markup file:
1 View a file that has existing markups.
2 From the Markup menu, select Open.

The Markup Files dialog box appears.
Note: From the AutoVue toolbar, you can also click Open Markup(s) 

, or from the bottom-left corner of the status bar, you can click Markup 

Indicator . 
Note: If the Markup Indicator icon does not display, then the file you 
opened has no existing markups associated to it.
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3 From the Markup list, select the check box next to Markup file you want to 
open. 
Note: If you select more than one Markup file, the Active Markup menu lets 
you select which one of them is initially active.

4 Click OK. 
The selected markup or markups appear in the workspace on top of the 
original file.
Note: When you select more than one Markup file, the markups display 
simultaneously.
See Also  Setting the Active Markup File

Saving an Existing Markup File
To save a modified existing Markup file, from the Markup menu, select Save.
Note: From the Markup Properties toolbar, you can also click Save Markup 

.

If you have multiple markups open that you have modified and want to save them 
all, from the Markup menu, select Save All.
To save an existing markup as a new markup, from the Markup menu, select 
Save As.

Importing a Markup File
To import a Markup file on top of the original file:
1 From the Markup menu, select Open.

The Markup Files dialog box appears.
Note: From the AutoVue toolbar, you can also click Open Markup(s) 

. 
2 Click Import.

The Select Markup File to Import dialog box appears.
3 Navigate to the markup file that you want to import and select it.
4 Click Open.

The imported Markup file appears in the workspace on top of the original 
file.
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Exporting a Markup File
To export a Markup file:
1 From the Markup menu, select Save As.

The Save Markup File As dialog box appears.

Note: For a new Markup file, you can also click Save Markup .
2 Click Export.

The Save As dialog box appears.
3 Navigate to the location where you want to export the Markup file.
4 Enter file name.
5 Click Save.

The Markup file is exported to the selected directory.
The default format saved is Markup Files (*.*), but you can select another one. In 
the Save as Type list, there are six formats to choose from: 
• Markup Files (*.*)
• DXF Output (*.dfx)
• AutoCAD DWG R12 (*.dwg) 
• AutoCAD DWG R13 (*.dwg) 
• AutoCAD DWG 14 (*.dwg) 
• Microstation DGN Output (*.dgn)

Setting the Active Markup File
A file can have several Markup files. When you open several Markup files 
simultaneously, you can set one as the active Markup file. Any changes you make 
is applied to the current active markup.
6 From the Markup menu, select Open.

The Markup Files dialog box appears.
Note: From the AutoVue toolbar, you can also click Open Markup(s) 

, or from the bottom-left corner of the status bar, you can click Markup 

Indicator . 
Note: If the Markup Indicator icon does not display, the file you opened has 
no existing markups associated to it.

7 From the Markup list, select the markup or markups you want to open. 
8 From the Active Markup list, select the markup you want to make active.

Note: An active markup displays in bold in the Markup Navigation Tree.
9 Click OK.
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The selected markups appear in the AutoVue workspace.

Changing the Active Markup File
When you have multiple Markup files open, you can change the active markup.
Note: An active markup displays in bold in the Markup Navigation Tree.
Take one of the following steps:
• In the tree, right-click the name of the Markup file you want to make active, 

then select Set Active.
• From the Markup toolbar, you can set the active markup by selecting a 

markup from the list on the Markup Properties toolbar.

• Take the following steps:
a.  From the Markup menu, select Set Active.

The Set Active Markup dialog box appears.
b.  From the Select Active Markup list, select the markup you want to make 

active.
c.  Click OK to make the selected Markup file active.

Working with Markup Layers
Markup files can be divided into layers with each layer having its own unique 
name. You can create, name, and color layers to organize your work. For 
example, different colors can indicate time priorities and each layer can contain 
markups relating to a common purpose. 
When working with markup layers, you can view layers individually or in 
combination, add, rename, or delete layers. You can also specify a different color 
for each layer. 
Note: The default layer color is red.

See  Moving a Markup Entity to Another Layer
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Creating a Markup Layer
From the Markup Layers dialog box, you can create a markup layer.
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
2 Click New.

The New Markup Layer dialog box appears.
3 Enter a name for the markup layer.
4 Click OK.

The new markup layer is added to the list in the Markup Layers dialog box.
5 To change the color of the new layer, click Color. 

The Layer Color dialog box appears. 
Note: The default layer color is red.

6 Select a color and click OK.
7 Click OK to close the Markup Layers dialog box.

Setting the Active Markup Layer
A markup can have several layers and you can set a layer as the active markup 
layer. When a markup layer is active, all modifications you make are applied to 
that markup layer. There are two ways in which to set a layer as active:
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
2 From the Markup Layers list, select the layer you want to make active.
3 Click Set Active.
4 Click OK.
or
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
2 From the Currently Active Layer list, select the layer you want to make 

active.
3 Click OK.

Changing the Color of a Markup Layer
After you create a markup layer, you have the option to the change color of its 
markup entities.
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
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2 From the Markup Layers list, select the markup layer that you want to 
change the color.

3 Click Color.
The Layer Color dialog box appears.

4 Select a Color.
5 Click OK.

Note: Only the entities that were created with the Bylayer  color 
defined in the Markup Layers dialog box will change color. Any entities that 
were created using the color options from the Markup Properties toolbar, 

will override the Bylayer  color and will not change color.
See  Assigning a Markup Entity the Same Color as the Layer

6 Click OK to close the Markup Layers dialog box.
See Also  Working with Markup Entities

Renaming a Markup Layer
After you create a markup layer, you have the option to rename the layer.
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
2 From the Markup Layers list, select the markup layer you want to rename.
3 Click Rename.

The New Markup Layer dialog box appears.
4 Enter the new layer name.
5 Click OK. 

The markup layer is assigned the new name.
6 Click OK to close the Markup Layers dialog box.

Toggling between Markup Layers
From the Markup Layers dialog box, you can choose to show or hide a layer and 
its associated markup entities. 
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
2 To show/hide a layer or layers:

•   Select a layer and click Toggle. The layer’s check box will switch 
between selected and deselected. To view all the markup layers, click All 
On. To hide all markup layers click All Off.

or
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•   From the Markup Layers list, select the check box next to the layer or 
layers you want visible, and deselect the check box next to the layer or 
layers you want to hide.

3 Click OK.
The markup entities belonging to the selected layer or layers appear in the 
workspace on top of the original file.

Deleting a Markup Layer
From the Markup Layers dialog box, you can choose to delete a selected layer 
and its associated markup entities.
1 From the Markup menu, select Markup Layers.

The Markup Layers dialog box appears.
2 From the Markup Layers list, select the markup layer you want to delete.
3 Click Delete.
4 Click OK.

The layer or layers are deleted along their associated entities.

Moving a Markup Entity to Another Layer
Once you create a markup entity, it is possible to assign it to a pre-existing 
markup layer.
1 Select the markup entity or entities that you want to move.
2 From the Markup menu, select Format, and then select Move to Layer.

The Move to Layer dialog box appears.
Note: You can also right-click the markup entity, select Format, and then 
select Move to Layer.

3 From the Layers list, select the destination layer.
4 Click OK. 

The selected markup entity or entities are moved to the selected layer.
Note: Only the markup entities that were created with the layer color 
defined in the Markup Layers dialog box will change color. Any entities that 
were created using the color options from the Markup Properties toolbar, 
will override the layer color and will not change color.
See Also  Working with Markup Entities
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Consolidating Markup Files
The Consolidate option allows you to create a new Markup file that combines 
copies of selected layers of different Markup files. During the review cycle, 
consolidation simplifies document revisions by providing the author with one 
combined Markup file instead of several Markup files.

Note: The Consolidate option is only active when more than one Markup 
file is opened.

1 Open the Markup files that you want to consolidate.
2 From the Markup menu, select Consolidate.

The Consolidate Markups dialog box appears.
3 Select the markup layers that you want to consolidate into one file. To select 

multiple layers, press the Shift or Control key while selecting.
Note: To select all the layers click Select All, and to deselect all the layers 
click UnSelect All.

4 In the Output ID field, enter an ID for the new Markup file.
5 If you want to open the newly consolidated markup as the active markup, 

select the Open as Active Markup check box. 
6 Click OK.

The consolidated Markup file is saved. If you selected Open as Active 
Markup, the consolidated markup opens and is set as the active markup.

Marking up 2D and 3D Files
AutoVue provides a number of markup options that display the same behavior 
when marking up 2D or 3D files. You can add markup entities such as 
attachments, hyperlinks, signoffs, and stamps.    
Note: When you are creating a markup entity, you can press the Escape key to 
cancel.
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The following tables lists common markup entities for 2D and 3D files. For 
markup entities that are specific to 2D and 3D files, refer to the 2D-Specific 
Markups and 3D-Specific Markups sections, respectively.

See Also  2D-Specific Markups
3D-Specific Markups

Option Description

Attachment Add an attachment entity to the markup.
From the Markup Entity toolbar, you can also click Attachment 

.
See  Adding an Attachment

Hyperlink Click the workspace to attach a hyperlink.
From the Markup Entity toolbar, you can also click Hyperlink 

.
See  Adding a Hyperlink

Intellistamp Add a stamp on a document in a connected and discon-
nected environment. Includes specific document and user 
information (metadata) pulled directly from the DMS/ERP/
PLM/UCM system.
From the Markup Entity toolbar, you can also click Intellistamp 

.
Refer to the AutoVue Mobile User Manual.

Signoff Create an approval stamp containing information about the 
markup author, date and time of creation.

From the Markup Entity toolbar, you can also click Signoff .
See  Adding Signoff Entities

Stamp Click and drag a stamp from the dialog box to the workspace.

From the Markup Entity toolbar, you can also click Stamp .
See  Adding a Stamp
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Adding an Attachment
In AutoVue, you can attach a file of any type (for example, text, audio, or video) 
as a markup entity. The attachment is embedded into the markup entity and 
displays as an icon the display. 
1 From the Markup menu, select Add Entity, and then select Attachment.

Note: From the Markup Entity toolbar, you can also click Attachment .
2 Click on the drawing where you want to add an attachment.

The Attach File dialog box appears.
3 In the Link Name field, enter a name for the attachment.

Optionally, you can also provide a brief description of the attachment in the 
Description box.

4 In the URL field, enter the path to the file or click Browse.
The File Open dialog box appears.

5 Select the file or click Browse and click OK.
Note: You can attach any local file or any DMS file.

6 From the Open In list, select one the following: 
•   A new applet window: Opens the attachment in a new AutoVue window.
•   Current applet window: Opens the attachment in the current AutoVue 

window.
•   Associated application: Opens the attachment in its associated 

application.
7 Click OK to close the Attach File dialog box.

The attachment appears on the markup workspace and in the Markup 
Navigation Tree.

8 Right-click in the workspace to complete the attachment.
Note: To open the attachment, double-click on it. It will open in the 
application selected in step 6.

Opening an Attachment
To open an attachment, do one of the following:
• Double-click or the attachment icon in the workspace or Markup Navigation 

Tree.
•   If A new applet window was selected while attaching the file, it will 

open Opens the attachment in a new AutoVue window.
•   If Current applet window was selected while attaching the file, it will 

open in the current AutoVue window.
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•   If Associated application was selected while attaching the file, it will 
open in its associated application.

• In the tree, right-click the attachment entity in the tree, select Attachment, 
and then select one of the following:
•   Open: If A new applet window was selected while attaching the file, it 

will open in a new AutoVue window. If Current applet window was 
selected while attaching the file, it will open in the current AutoVue 
window. Otherwise, it will in its native application.

•   Open With: You have the option to open the attachment with AutoVue or 
Associated Application.

Editing an Attachment
9 In the Markup Navigation Tree, right-click the attachment and select Edit.

The Attach File dialog box appears.
10 Make your changes and click to OK.

The dialog box closes and modifications are implemented.

Adding a Hyperlink
A hyperlink is a link between the current file and a new file or application. You 
can create hyperlinks in your current file so that your files and applications 
outside AutoVue are only a click away. The main benefit of adding hyperlinks to 
a file is that you can gather all files of related information into one file with the 
files kept separate. In other words, the files may be accessible from one location 
but the information is referenced, not duplicated. This ensures a manageable file 
size when loading. If changes need to be made to a linked file, they need to be 
done in one location—to the linked file itself.

Creating a Hyperlink
1 From the Markup menu, select Add Entity, and then select Hyperlink.

Note: From the Markup Entity toolbar, you can also click Hyperlink .
2 Click a point on the document where you want to place the hyperlink.

The Establish Hyperlink dialog box appears.
3 Enter a Link Name.
4 Enter a Description (optional).
5 Type the URL or click Browse to locate the file that you want to link to.
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6 From the Open In list, select where you want the hyperlink to open.

7 Click OK.
The hyperlink appears on the Markup.

Opening a Hyperlink
To open a hyperlink, double-click on it from the workspace.
The hyperlink file opens in the window you selected in the Establish Hyperlink 
dialog box.

Editing a Hyperlink
1 In the Markup Navigation Tree or from the workspace, select the hyperlink 

that you want to edit.
2 From the Markup menu, select Format, and then select Edit Hyperlink.

The Edit Hyperlink dialog box appears.
Note: You can right-click a hyperlink in the Markup Navigation Tree and 
select Edit.

3 Edit the information that you want.
4 Click OK.

The changes are saved.

Deleting a Hyperlink
1 In the Markup Navigation Tree or from the workspace, select the hyperlink 

that you want to delete.
2 From the Markup menu, select Format, and then select Remove 

Hyperlink.
The Establish Hyperlink dialog box appears.

Open in Description

A new applet window Opens the file in another AutoVue window.

Current applet window Opens the file in the current AutoVue window.

A new browser window Opens the file in the default browser window.

A current browser window Opens the file in the current browser window.
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Note: You can also right-click the hyperlink and select Format, and then 
select Remove Hyperlink.
The hyperlink is deleted from the file.

Adding Signoff Entities
The Signoff entity is an approval stamp containing information about the markup 
author, date, and time of creation. You create a signoff entity when the Markup 
file is finalized.
Note: If a markup is modified after a signoff is created, the signoff disappears 
from the workspace but remains in the Markup Navigation tree. Double-click on 
the signoff entity in the tree to view the signoff history—the person who 
rescinded the signoff, the creation date, and the drop date.
1 From the Markup menu, select Add Entity, and then select Signoff.

Note: From the Markup Entity toolbar, you can also click Signoff .
2 Click and drag to create a box on the drawing where you want the signoff.

The Signoff dialog box appears displaying details of the signoff.
3 Click OK.

The signoff entity appears on the drawing and the tree, and displays the 
author, creation date, and approval date.

Rescinding the Signoff
You can rescind a signoff on a drawing.
1 In the Markup Navigation tree or in the workspace, double-click the signoff 

markup entity.

Note: From the Markup Entity toolbar, you can also click Signoff .
The Signoff dialog box appears.

2 Click Rescind.
The signoff disappears from the drawing but remains in the Markup 
Navigation Tree.

To re-approve the signoff:
1 In the tree, double-click the signoff markup entity.

The Signoff dialog box appears
2 Click Approve.
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Note: When a the Markup file is modified after adding a signoff, the signoff is 
automatically rescinded.

Viewing the History of a Signoff
1 From the Markup menu, select Add Entity, and then select Signoff.

From the Markup Entity toolbar, you can also click Signoff .
2 Click History.

The Signoff History dialog box appears displaying the author, date and time 
the signoff was created.

3 Click OK.
4 Click Cancel to close the Signoff dialog box.

Creating an Intellistamp
The Intellistamp markup entity lets you create a stamp that includes document 
and user information (metadata) pulled directly from the backend DMS/ERP/
PLM/UCM system. 

Designing an Intellistamp
To design an Intellistamp, you must use the Design Stamp tool that is included 
with the AutoVue Web Version installation. To launch the tool, go to the 
<AutoVue Web Version installation>\bin folder and double-click stampdlg.exe.
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The Design Stamp dialog box appears.

The following sections describe how to design an Intellistamp with the Design 
Stamp tool.
1 From the Stamp Name section, click Add. 

The Add New Stamp dialog box appears.
2 Enter a name for the Intellistamp and then click OK. 

The Open dialog box appears.
3 Select a background image for the Intellistamp and then click Open.

The selected image appears in the Preview window of the Design Stamp 
dialog box. The Image File field displays the image file path.
Note: To change the background image once the Intellistamp is created, 
click Browse, and then select a new background.
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4 To set the selected Intellistamp as read-only, select the Traditional Stamp 
check box.
Note: To remove an Intellistamp, from the Stamp Name box, select an 
Intellistamp and then click Remove.

5 To add an attribute, click Add. 
The Add New Attribute dialog box appears. 

6 In the Name field, enter an attribute name that is defined in the backend 
system.

7 From the Default Value box, select one of the following values:
•   <Not Defined>: The attribute retains the same value as defined in the 

backend system.
•   $user: For AutoVue Desktop Version, the operating system user name is 

assigned to the attribute. For AutoVue Web Version, the user session name 
is assigned to the attribute.

•   $date: The current date and time is assigned to the attribute.
8 To prevent users from modifying the attribute, select the Read Only check 

box. 
9 To hide the attribute from appearing on the Intellistamp, select the Hidden 

check box. However, the attributes are viewable from the DMS Attributes 
dialog box. 
See Also  Viewing/Modifying Intellistamp Attributes

10 When you are done adding an attribute, click Add.
The Add New Attribute dialog box closes and the new attribute is added to 
Attributes box. The attribute displays as a resizable box in the Preview 
window. 

11 To change the value of an existing attribute, from the Attributes list, select 
the attribute and then select a new value from the Default Value box.

12 To remove an attribute, from the Attributes list, select the attribute and then 
click Remove.
Note: To add another attribute, repeat steps 5 through 10.

13 To change the position of the attribute box in the preview window, you can 
enter either click and drag the box or enter the (X,Y) coordinates in the 
Position fields.
Note: The Position fields take values between 0 and 1, where (0,0) is the 
default setting.

14 To enlarge the preview, click Zoom In.
The Zoom In dialog box appears. This dialog box provides an enlarged 
version of the options available in the Design Stamp dialog box. 
a.  To close the Zoom In dialog box, click Zoom Out.
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15 To hide an attribute, select an attribute from the Attributes box, and then 
select the Hidden check box. The hidden attributes will not appear on the 
Intellistamp, however they are viewable from the DMS Attributes dialog 
box. 
See Also  Viewing/Modifying Intellistamp Attributes

16 To changed the font of the attributes, click Font.
The Font dialog box appears.
a.  Select the font, font style, and font size. 
b.  From the Script box, you can select Western script or Hebrew script.

The font previews in the Sample window.
c.  Click OK to implement the font changes.

Repeat to add multiple Intellistamps. 
To view the available Intellistamps, select an Intellistamp from the Stamp Name 
box; the Intellistamp previews in the Preview window.

Adding an Intellistamp
To add an Intellistamp markup entity in AutoVue, you must either connect to a 
backend system or work with a Mobile Pack created with a file from a a backend 
system which contains an Intellistamp definition.

See Also  AutoVue Mobile
To add an Intellistamp markup entity to a document, do the following:
1 Enter Markup mode.
2 From the Markup menu, select Add Entity, and then select Intellistamp.

Note: From the Markup Entity toolbar, you can also click Intellistamp 

.
3 In the workspace, click and drag a box to the desired Intellistamp size.

The Intellistamp dialog box appears.
4 From the Choose Stamp box, select the desired Intellistamp.

Note: To resize the Intellistamp, select Enable Resizing.
5 Click OK.

The Intellistamp dialog box closes and the Intellistamp appears in workspace 
and in the Markup Entity Tree.

6 Right-click the workspace to complete the Intellistamp placement.
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Viewing/Modifying Intellistamp Attributes
You can view the attributes of an Intellistamp by double-clicking the Intellistamp 
markup entity. The DMS Attributes dialog box appears listing all attributes of the 
Intellistamp.
Note: All attributes tagged hidden will also display in the Attributes dialog box.
The dialog box contains three columns that include attribute values defined in the 
design stage:
• The Name column displays the attribute name as defined in the design stage. 

It will either display the backend DMS/ERP/PLM/UCM system-defined 
attribute name or the user-defined name.

• The Value column displays the assigned value. If the attribute is not marked 
as read-only in the design stage, you can modify the value.

• The Value from DMS column displays the value assigned from the backend 
system.

Intellistamp in a DMS/ERP/PLM/UCM System Integration
If you view the Intellistamp markup entity in AutoVue with a backend system 
integration, the Commit Changes and Reset buttons appear in the DMS 
Attributes dialog box: 
• Click the Commit Changes button to upload the changes made to the DMS 

Attributes dialog box to the backend system. 
• Click the Reset button to retrieve the attribute values defined in the backend 

system.
When you are done modifying the attribute, click OK to finalize your changes 
and to close the DMS Attributes dialog box.
Intellistamp in a Mobile Pack
If you view the Intellistamp markup entity from a Mobile Pack, the Commit 
Changes and Reset buttons appear in the DMS Attributes dialog box:
• Click the Commit Changes button to upload the changes made to the DMS 

Attributes dialog box to the Mobile Pack. 
• Click the Reset button to reset the Intellistamp attribute values to those 

defined in the Mobile Pack.
When you are done modifying the attribute, click OK to finalize your changes 
and to close the DMS Attributes dialog box.
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Adding a Stamp
A Stamp is a graphical entity, such as a company logo. Before a graphic entity 
can be used as a stamp, it must be added to a Stamp Library. 
You can create a Stamp Library and add stamps to it. You can also add or remove 
stamps from existing libraries.
7 From the Markup menu, select Add Entity, and then select Stamp.

The Stamps dialog box appears.

Note: From the Markup Entity toolbar, you can also click Stamp .
8 Click the Stamps tab.
9 From the Stamp Library list, select the library from which you want to select 

a stamp.
The stamps appear for the selected library.
See  Adding a Stamp to a Library

10 Click Isotropic if you want to scale the stamp proportionately. 
Click Anisotropic if you want to scale the stamp disproportionately.

11 Drag the stamp onto the workspace.
The stamp appears on the drawing and in the Markup Navigation Tree.
Note: To add more stamps, repeat steps 3 to 5.

12 Close the Stamps dialog box.

Creating a New Stamp Library
1 From the Markup menu, select Add Entity, and then select Stamp.

The Stamps dialog box appears.

Note: From the Markup Entity toolbar, you can also click Stamp .
2 Click the Libraries tab.
3 Click Create.

The Stamp Library dialog box appears.
4 Enter the library name, description, author, and keywords in their respective 

fields.
5 To add a stamp to the library, click Add.

The Open dialog box appears.
6 Browse to locate the stamp you want to add, and then click Open.

The file appears in the Stamp Files list.
Note: To add more stamps, repeat steps 4 to 6. To remove a stamp, select 
the stamp and click Remove.
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Deleting a Stamp from a Library
1 From the Markup menu, select Add Entity, and then select Stamp.

The Stamps dialog box appears.

Note: From the Markup Entity toolbar, you can also click Stamp 
2 Click the Stamps tab.
3 From the Stamp Library list, select the library which contains the stamp you 

want to delete.
4 The stamps appear in the Drag and Drop a Stamp onto AutoVue section.
5 Select the stamp you want to delete, then click Delete.

The stamp disappears from the library.
6 Close the Stamps dialog box.

Editing Stamp Library Information
1 From the Markup menu, select Add Entity, and then select Stamp.

The Stamps dialog box appears.

Note: From the Markup Entity toolbar, you can also click Stamp .
2 Click the Libraries tab.
3 From the Stamp Libraries list, select the library that you want edit.
4 Click Edit.

The Stamp Library dialog box appears.
5 Edit the information.
6 Click OK.
7 Close the Stamps dialog box.

Deleting a Stamp Library
1 From the Markup menu, select Add Entity, and then select Stamp.

The Stamps dialog box appears.

Note: From the Markup Entity toolbar, you can also click Stamp .
2 Click the Libraries tab.
3 From the Stamp Libraries list, select the library that you want to delete.
4 Click Delete.

The library disappears from the list and from the Stamp Library list under 
the Stamps tab.

5 Close the Stamps dialog box.
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Adding a Stamp to a Library
1 From the Markup menu, select Add Entity, and then select Stamp.

The Stamps dialog box appears.

Note: From the Markup Entity toolbar, you can also click Stamp .
2 Click the Stamps tab.
3 From the Stamp Library list, select the library that you want to add a stamp.
4 Click Add Stamp.

The Stamp Definition dialog box appears.
Enter the source file, stamp Name, and description in their respective fields, 
or click Browse to locate the source file. 

5 Click OK.
The stamp appears under the Drag and Drop a Stamp onto AutoVue section 
in the Stamps dialog box.
Note: To add more than one stamp, repeat steps 4 and 5.

6 Close the Stamps dialog box.

2D-Specific Markups
AutoVue provides a variety of user-friendly markup options that you can use 
when marking up 2D files. You can create entities such as arcs, boxes, circles, 
clouds, lines, and polygons. You can draw a leader with multi-line segments and 
add text to it.   
Note: When you are creating a markup entity, you can press the Escape key to 
cancel.

See Also  Marking up 2D and 3D Files

2D Markup Entities
You can create many different types of markup entities. To access the markup 
entities, from the Markup menu, select Add Entity. 
The markup entities are:

Option Description

Note: To complete a markup entity (for example, to finish creating a box), simply 
right-click in the AutoVue workspace.
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Arc Click and drag the mouse to draw an Arc.

From the Markup Entity toolbar, you can also click Arc .

Attachment Add an attachment entity to the markup.

From the Markup Entity toolbar, you can also click Arc .
See  Adding an Attachment

Box Click and drag to draw a rectangle.

From the Markup Entity toolbar, you can also click Box .
Note: To draw a square instead of a rectangle, press and hold the 
Shift key while you click and drag.

Cloud Click and drag to draw a Cloud.

From the Markup Entity toolbar, you can also click Cloud .

Circle Click and drag to draw a ellipse.

From the Markup Entity toolbar, you can also click Circle .
Note: To draw a circle instead of an ellipse, press and hold the 
Shift key while you click and drag.

Freestyle Click, release mouse button, then drag to draw an entity.
From the Markup Entity toolbar, you can also click Freestyle 

.
Note: You can create a contiguous or non-contiguous freestyle 
entity.
See  Adding a Freestyle Entity

Highlight Click and drag to highlight a boxed area.
From the Markup Entity toolbar, you can also click Highlight 

.
Note: The highlighted box will be filled with a transparent color.

Hyperlink Click the workspace to attach a hyperlink.
From the Markup Entity toolbar, you can also click Hyperlink 

.
See  Adding a Hyperlink

Option Description
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Intellistamp Add a stamp on a document in a connected and discon-
nected environment. Includes specific document and user 
information (metadata) pulled directly from the DMS/ERP/
PLM/UCM system.
From the Markup Entity toolbar, you can also click Intellistamp 

.
Refer to the AutoVue Mobile User Manual.

Leader Click and drag to draw a leader. 

From the Markup Entity toolbar, you can also click Leader .
Note: To force a line segment in a Leader entity to be aligned to 
the closer axis, horizontal or vertical axis, hold the Shift key 
while you click and drag for that line segment.
See  Adding a Leader

Line Click and drag to draw a line.

From the Markup Entity toolbar, you can also click Line .
Note: To draw a line and force it to be aligned to the closer axis, 
horizontal or vertical, press and hold the Shift key while you click 
and drag.
See  Aligning a Line Segment to the Vertical or Horizon-
tal Axes

Measurement Create markup measure entities.

From the Markup Entity toolbar, you can also click Distance , 

Area , Angle , Arc , or Minimum Distance .
See  Creating 2D non-Vector Markup Measure Entities
        Creating 2D Vector Markup Measure Entities
        Creating EDA Markup Measure Entities

Note Add a note to the markup.

From the Markup Entity toolbar, you can also click Note .
See  Adding a Note

Polygon Click and drag to draw a polygon.

From the Markup Entity toolbar, you can also click Polygon .

Option Description
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Adding a Freestyle Entity
You can create a freestyle markup entity. You have the option of making the 
entity non-contiguous or contiguous.

Creating a Non-Contiguous Freestyle Entity
1 From the Markup menu, select Add Entity, and then select Freestyle.

Note: From the Markup Entity toolbar, you can also click Freestyle .
2 Click a point on the drawing where you want to start the Freestyle entity.
3 Move the cursor to create the Freestyle entity.
4 Click a point on the drawing where you want to interrupt the Freestyle entity.
5 Click another point on the drawing where you want to restart the Freestyle 

entity.

Polyline Click and drag to draw a polyline.

From the Markup Entity toolbar, you can also click Polyline .
Note: To force a line segment in a Polyline entity to be aligned to 
the closer axis, horizontal or vertical, press and hold the Shift key 
while you click and drag for that line segment.
See  Aligning a Line Segment to the Vertical or Horizon-
tal Axes

Signoff Create an approval stamp containing information about the 
markup author, date and time of creation.

From the Markup Entity toolbar, you can also click Signoff .
See  Adding Signoff Entities

Stamp Click and drag a stamp to the markup.

From the Markup Entity toolbar, you can also click Stamp .
See  Adding a Stamp

Text Add text to the markup.

From the Markup Entity toolbar, you can also click Text .

See  Adding Text

Option Description
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Note: You can interrupt the Freestyle entity as many times as you like by 
repeating steps 4 and 5.

6 Right-click to end the Freestyle entity.

Creating a Contiguous Freestyle Entity
1 From the Markup menu, select Add Entity, and then select Freestyle.

Note: From the Markup Entity toolbar, you can also click Freestyle .
2 Click a point on the drawing where you want to start the Freestyle entity.
3 Move the cursor to create the Freestyle entity.
4 Right-click to end the Freestyle entity.

Adding a Leader
1 From the Markup menu, select Add Entity, and then select Leader.

Note: From the Markup Entity toolbar, you can also click Leader .
2 Click a point on the document where define the Leader anchor point.
3 Move the cursor to draw the Leader.

Note: To draw a Leader segment and force it to be aligned to the closest 
axis, vertical or horizontal, hold the Shift key while moving the cursor.
See  Aligning a Line Segment to the Vertical or Horizontal Axes

4 To draw a Leader with multiple line segments, repeat steps 2 and 3 as often 
as you like. You can click, then drag as often as you like. 

5 Right-click to end the Leader.
A text box appears at the end of the Leader.

6 In the text box, enter the text you want to attach to the Leader.
Note: The height of the text box will resize to fit the entered text.

7 To change text box font properties, from the Markup menu, select Format, 
and then select Font.
The Font dialog box appears allowing you to change the font type, style, and 
size.
Note: From the respective font property lists on the Markup Properties 
toolbar, you can also modify the font type, style, and size

8 Click OK to implement the font changes and to close the Font dialog box.
9 To change the line properties or fill color of the Leader, select the Leader, 

then from the Markup menu, select Format, and then select the property or 
properties you want to change.
Oracle Corp.



212 AutoVue
Note: From the respective line property lists on the Markup Properties 
toolbar, you can also modify the line style, line thickness, fill types, and fill 
colors.

10 Right-click outside the text area to complete the modification.
The text appears on the drawing and in the Markup Navigation Tree.
Note: To edit the Leader text, double-click the Leader in the tree or in the 
workspace.

Aligning a Line Segment to the Vertical or 
Horizontal Axes
You can draw a line segment and force it to be aligned with the closer axis—
horizontal or vertical. You can also take an existing line segment and have it align 
with the closer axis. The types of line segments that you can align are lines, line 
segments of leaders and polylines, and measure entities.
Note: This procedure only works for measure entities that are drawn using Free 
Snap. 

See  2D Vector Snapping Modes
1 To draw and force a line segment, press and hold the Shift key while you 

click and drag for that line segment.
To force an existing line segment, click and hold the left mouse button on the 
line segment, then press and hold the Shift key.

2 When you see that the line segment is horizontal or vertical, release the left 
mouse button, then release the Shift key.

Creating 2D non-Vector Markup Measure 
Entities
When marking up 2D non-vector files, in addition to all the markup options 
available for 2D files, you can create markup measure entities. The measure 
options in Markup mode work a bit differently than in View mode. 

See  2D-Specific Markups
When measuring in Markup mode, the specified measurement lines and values 
are displayed on the current active markup layer as entities. These entities can be 
moved, resized, or deleted. You can also modify the font of a measure entity, 
align a “free snap” measure entity to the horizontal or vertical axis, as well as add 
units of measure and symbols to a measurement and have them appear on the 
drawing.
Oracle Corp.



AutoVue 213
Note: When you are creating a markup entity, you can press the Escape key to 
cancel.
Measure options vary between vector and non-vector files. For vector files, 
AutoVue provides the option to “snap” to fixed points on the drawing. For non-
vector files, you can only “free snap”.
In Markup mode, you can choose from several measure options to create markup 
measure entities. From the Markup menu, select Add Entity, and then select 
Measurement to access the following measure options:

Measuring Distance
Use the Distance option to measure the distance between two specific points.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Distance.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 From the Measured Distance Units list, select the unit in which you want to 

measure the distance.
3 Click a point on the drawing to define the starting point.
4 Click another point on the drawing to define the end point.

The measured line path appears as an entity on the current active markup.

Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle .

Arc Measure an arc entity.

From the Markup Entity toolbar, you can also click Arc .

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area .

Distance Measure the distance between two points.
From the Markup Entity toolbar, you can also click Distance 

.
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5 Move the cursor and click a location on the drawing to display the measure 
distance.
The measurement and unit appear in a value box entity on the current active 
markup layer. The measured distance, Delta-X, and Delta-Y appear in the 
Measurement Entities dialog box.

6 To resize the value box, select it and then click and drag the frame handles. 
7 You can click and drag the text box anywhere on the drawing.

Note: To make another measurement, click Reset.
8 Click Close to close the Measurement Entities dialog box.

Measuring Cumulative Distance
Use the Cumulative Distance option to measure the distance along a path of 
multi-faceted (adjoining) points.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Distance.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 From the Measured Distance Units list, select the unit in which you want to 

measure the distance.
3 Select Cumulative.
4 Click a point on the drawing to define the starting point.
5 Continue clicking points along the path that you want to measure.

Each point is joined by a line. 
6 Right-click to complete the measurement.

The measured line path, cumulated measurement and unit appear in a value 
box entity on the current active markup layer. The cumulated measured 
distance, Delta-X, and Delta-Y appear in the Measurement Entities dialog 
box.
Note: To make another measurement, click Reset.

7 Click Close to close the Measurement Entities dialog box.

Calibrating Distance
1 Measure the distance between two points or measure cumulative distance.

See  Measuring Distance
2 In the Measurement Entities dialog box, click Calibrate.

The Distance Calibration dialog box appears displaying the measured 
distance.
Oracle Corp.



AutoVue 215
3 From the Distance list, select the unit to which you want to calibrate the 
distance.

4 Select Calibrate to and enter a value if you want to calibrate the distance to 
a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

5 Click OK. 
The calibration result appears in the Measurement Entities dialog box.

6 Click Close to close the Measurement Entities dialog box.

Measuring Area
Use the Area option to measure the area and perimeter of a region.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Area.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Area .
2 From the Measured Area Units list, select the unit in which you want to 

measure the area.
From the Perimeter Units list, select the unit in which you want to measure 
the perimeter.

3 To cumulate a Net Area Result of different areas, select Add. 
To subtract an area from the Net Area Result, select Subtract. 
Select Clear to clear the Net Area Result field.

4 Click a point on the drawing to define the starting point.
5 Continue clicking points on the drawing to define the area you want to 

measure.
Each point is joined by a line. 

6 Right click to complete the measurement.
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The area and perimeter measurements 
appear in the Measurement Entities dialog box.
Note: To make another measurement, click Reset.

7 Click Close to close the Measurement Entities dialog box.

Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.
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1 From the Markup menu, select Add entity, select Measurement, and then 
select Angle.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Angle .
2 From the Measured Angle Units list, select the unit in which you want to 

measure the angle.
3 Click points on the drawing to define the angle you want to measure:

•   The first click defines the starting point of the angle measurement.
•   The second click defines the vertex of the angle measurement.
•   The third click defines the endpoint of the angle measurement.
The points are joined by angle arms with an arc connecting them. 

4 Move the cursor to increase or decrease the radial and arc length.
5 Click again to complete the measurement. 

The measured line path, angle measurement and unit appear in a value box 
entity on the current active markup layer. The measured angle also appears 
in the Measurement Entities dialog box. 

6 To resize the value box, select it and then click and drag the frame handles.
7 You can click and drag the value box anywhere on the drawing.

Note: To make another measurement, click Reset.
8 Click Close to close the Measurement Entities dialog box.

Measuring an Arc
Use the Arc option to define an arc in the drawing and measure its radius, center 
and diameter.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Arc.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Arc .
2 From the Arc Info Length list, select the unit in which you want to measure 

the arc. 
3 From the Measured Angle Units list, select the unit in which you want to 

measure the angle. The options are degrees or radians.
4 Select Add Radius if you want to measure the radius of the arc.

Select Add Diameter if you want to measure the diameter of the arc.
5 Click three points on the drawing to define the arc you want to measure.

The points are joined by an arc. 
6 Click again to complete the measurement.
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The measured line path, arc measurement and unit appear in a value box 
entity on the current active markup layer and in the Measurement Entities 
dialog box. 

7 To resize the value box, select it and then click and drag the frame handles.
8 You can click and drag the text box anywhere on the drawing.

Note: To make another measurement, click Reset.
9 Click Close to close the Measurement Entities dialog box.

Calibrating an Arc
1 Measure an arc in the drawing.

See  Measuring an Arc
2 In the Measurement Entities dialog box, click Calibrate.

The Radius Calibration dialog box appears displaying the measured 
distance.

3 From the Measured Rad list, select the unit to which you want to calibrate 
the distance.

4 Select Calibrate to and enter a value if you want to calibrate to a value.
Select Set Factor and enter a value if you want to calibrate by a factor.

5 Click OK. 
The calibration result appears in the Measurement Entities dialog box.

6 Click Close to close the Measurement Entities dialog box.

Creating 2D Vector Markup Measure 
Entities
When marking up 2D vector files, in addition to all the markup options available 
for 2D files, you can create markup measure entities. The measure options in 
Markup mode work slightly different than in View mode. 

See  2D-Specific Markups
Measure options vary between vector and non-vector files. For vector files, 
AutoVue provides the option to “snap” to fixed points on the drawing. For non-
vector files, you can only “free snap”.
When measuring in Markup mode, the specified measurement lines and values 
are displayed on the current active markup layer as entities. These entities can be 
moved, resized, hidden or deleted. You can also modify the font of a measure 
entity, align a “free snap” measure entity to the horizontal or vertical axis, as well 
as add units of measure and symbols to a measurement and have them appear on 
the drawing.
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Note: When you are creating a markup entity, you can press the Escape key to 
cancel.
In Markup mode, you can choose from several measure options to create markup 
measure entities. From the Markup menu, select Add Entity, and then select 
Measurement to access the following measure options:

2D Vector Snapping Modes
The snapping modes available allow you to click to precise geometrical points 
on a drawing. For example, if you select Snap to End-Point and you move the 
cursor over an end-point of a line, the end-point will be highlighted by a snap 
box. 
The snapping modes allow you to snap to the mid, center, and end-points of an 
entity:

Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle .

Arc Measure an arc entity.

From the Markup Entity toolbar, you can also click Arc .

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area .

Distance Measure the distance between two points.
From the Markup Entity toolbar, you can also click Distance 

.

Button Snap to Description

End-point Geometric snap mode where a snap box appears 
when moving the cursor near a linear component’s 
end point.
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The below table lists snapping locations for certain measurements:

Measuring Distance
Use the Distance option to measure the distance between two specific points.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Distance.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  2D Vector Snapping Modes

3 From the Measure Distance Units list, select the unit in which you want to 
measure the distance.

4 Click a point on the drawing to define the starting point.
5 Click another point on the drawing to define the end point.

The measured line path appears as an entity on the current active markup.
6 Drag to move the measured line path.

Mid-point Geometric snap mode where a snap box appears 
when moving the cursor near the halfway point of a 
linear component.

Center-point Geometric snap mode where a snap box appears 
when moving the cursor near the center of an 
elliptical component.

Free snap Allow snapping at any point on the drawing.

Measurement Snapping Location

Area Snaps to a shape on the drawing.

Arc Snaps to an arc on the drawing.

Angle Snap to an angle on the drawing.

Button Snap to Description
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7 Click on the measured line path.
The measurement and unit appear as in a value box entity on the current 
active markup layer. The measured distance, Delta-X and Delta-Y appear in 
the Measurement Entities dialog box.

8 To resize the value box, select it and then click and drag the frame handles. 
Note: To make another measurement, click Reset.

9 Click Close to close the Measurement Entities dialog box.

Measuring Cumulative Distance
Use the Cumulative Distance option to measure the distance along a path of 
multi-faceted (adjoining) points.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Distance.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  2D Vector Snapping Modes

3 From the Measured Distance Units list, select the unit in which you want to 
measure the distance.

4 Select Cumulative. 
5 Click a point on the drawing to define the starting point.
6 Continue clicking points along the path that you want to measure.

Each point is joined by a line. 
7 Right-click to complete the measurement.

The measured line path, measurement and unit appear as in a value box 
entity on the current active markup layer. The cumulated measured distance, 
Delta-X and Delta-Y appear in the Measurement Entities dialog box.

8 To resize the value box, select it and then click and drag the frame handles. 
Note: To make another measurement, click Reset.

9 Click Close to close the Measurement Entities dialog box.

Calibrating Distance
1 Measure the distance between two points or measure cumulative distance.

See  Measuring Distance
2 In the Measurement Entities dialog box, click Calibrate.
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The Distance Calibration dialog box appears displaying the measured 
distance.

3 In the Measured Distance list, select the unit to which you want to calibrate 
the distance.

4 Select Calibrate to and enter a value if you want to calibrate the distance to 
a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

5 Click OK. 
The calibration result appears in the Measurement Entities dialog box.

6 Click Close to close the Measurement Entities dialog box.

Measuring Area
Use the Area option to measure the area and perimeter of a region.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Area.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Area .
2 Select Between Points if you want to measure the area between points on a 

drawing. The snapping modes are displayed.
Select the snapping modes that you want to use for measuring.
To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  2D Vector Snapping Modes

3 Select Shape if you want to measure the area of a predefined shape on the 
drawing.

4 From the Measured Area Units list, select the unit in which you want to 
measure the area.

5 From the Perimeter Units list, select the unit in which you want to measure 
the perimeter.

6 To cumulate a Net Area Result of different areas, select Add in the 
Measurement Entities dialog box. 
To subtract an area from the Net Area Result, select Subtract. 
Select Clear to clear the Net Area Result field.

7 If you selected Between Points, click points on the drawing to define the 
area, then right click to complete the measurement.
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Each point is joined by a line. The measured line path, measurement and unit 
appear in a value box entity on the current active markup layer. The area and 
perimeter measurements appear in the Measurement Entities dialog box.

8 If you selected Shape, click the edge of a predefined shape on the drawing.
The shape is highlighted. The measured line path, measurement and unit 
appear in a value box entity on the current active markup layer. The area and 
perimeter measurements appear in the Measurement Entities dialog box. 

9 Click Close to close the Measurement Entities dialog box.

Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Angle.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Angle .
2 Select From 3 Points if you want to measure the angle between three points. 

The snapping modes are displayed. 
3 Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes 
click All Off.
See  2D Vector Snapping Modes

4 Select Between 2 lines if you want to measure the angle between two lines. 
5 From the Measured Angle Units list, select the unit in which you want to 

measure the angle.
6 If you selected From 3 Points, click three points on the drawing to define 

the angle.
If you selected Between 2 Lines, click two lines on the drawing to define the 
angle.
Angle arms appear with an arc connecting them. 

7 Click to complete the measurement. 
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The measured angle also appears in the 
Measurement Entities dialog box.

8 To change the size of the arc, click and drag the value box.
9 To resize the value box, select it and then click and drag the frame handles. 

Note: To make another measurement, click Reset.
10 Click Close to close the Measurement Entities dialog box.
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Measuring an Arc
Use the Arc option to define an arc in the drawing and measure its radius, center 
and diameter.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Arc.
The Measurement Entities dialog box appears.

2 From the Markup Entity toolbar, you can also click Arc .
3 Select From 3 Points if you want to measure the arc between three points. 

The snapping modes are displayed. 
Select the snapping modes that you want to use for measuring.
To select all snapping modes, click All On. To deselect all snapping modes 
click All Off.
See  2D Vector Snapping Modes

4 Select Arc Entity if you want to measure a predefined arc. 
5 From the Arc Info list, select the unit in which you want to measure the 

distance.
6 From the Measure Angle Units list, select the unit in which you want to 

measure the angle.
7 Select Add Radius if you want to measure the radius.

Select Add Diameter if you want to measure the diameter
8 If you selected From 3 Points, click three points to define the arc, then click 

to complete the measurement
The points are joined by an arc. 
If you selected Arc Entity, click the edge of the arc that you want to 
measure. The arc is highlighted.

9 Click to complete the measurement.
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer.The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle and sweep 
appear in the Measurement Entities dialog box.

10 To move the value box, click and drag it to anywhere on the drawing.
11 To resize the value box, select it and then click and drag the frame handles. 

Note: Click Reset to take another measurement.
12 Click Close to close the Measurement Entities dialog box.

Calibrating an Arc
1 Measure an arc in the drawing.
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See  Measuring an Arc
2 In the Measurement Entities dialog box, click Calibrate.

The Radius Calibration dialog box appears displaying the measured 
distance.

3 From the Measured Rad. list, select the unit to which you want to calibrate 
the distance.

4 Select Calibrate to and enter a value if you want to calibrate to a value.
Select Set Factor and enter a value if you want to calibrate by a factor.

5 Click OK. 
The calibration result appears in the Measurement Entities dialog box.

6 Click Close to close the Measurement Entities dialog box.

Creating EDA Markup Measure Entities
When marking up EDA files, in addition to all the markup options available for 
2D files, you can create markup measure entities. The measure options in 
Markup mode work slightly different than in View mode. 

See  2D-Specific Markups
Note: When you are creating a markup entity, you can press the Escape key to 
cancel.
When measuring in Markup mode, the specified measurement lines and values 
are displayed on the current active markup layer as entities. These entities can be 
moved, resized, or deleted. You can also modify the font of a measure entity, 
align a “free snap” measure entity to the horizontal or vertical axis, as well as add 
units of measure and symbols to a measurement and have them appear on the 
drawing.
AutoVue provides the option to “snap” to geometrical or electrical points on the 
drawing.
In Markup mode, you can choose from several measure options to create markup 
measure entities. From the Markup menu, select Add Entity, and then select 
Measurement to access the following measure options:

Option Description

Angle Measure the angle between selected points.
From the Markup Entity toolbar, you can also click Angle 

.
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EDA Snapping Modes
The snapping modes allow you to click to precise geometrical or electrical 
points. For example, when you select Snap to Pin, move the cursor over the pin 
you want to select until the pin is highlighted, then click. Highlight and click a 
second pin to measure the distance between them. 
The snapping modes allow you to snap to the mid, center, and end-points of an 
entity, as well as a pin, via, and symbol. The following table outlines the 
available snapping modes:

Arc Measure an arc entity.
From the Markup Entity toolbar, you can also click Arc 

.

Area Measure a selected area.
From the Markup Entity toolbar, you can also click Area 

.

Distance Measure the distance between two points.
From the Markup Entity toolbar, you can also click Distance 

.

Minimum Distance Measure the minimum distance between entities.
From the Markup Entity toolbar, click Minimum Distance 

.

Button Snap to Description

End-point Geometric snap mode where a snap box appears 
when moving the cursor near the component’s end 
point.

Mid-point Geometric snap mode where a snap box appears 
when moving the cursor near the halfway point of a 
linear component.

Option Description
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Measuring Distance
Use the Distance option to measure the distance between two specific points.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Distance.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  EDA Snapping Modes

3 From the Measured Distance Units list, select the unit in which you want to 
measure the distance.

4 Click a point on the drawing to define the starting point.
5 Click another point on the drawing to define the end point.

The points are joined by a line. The measured line path appears as an entity 
on the current active markup.

6 Drag to move the measured line path.
7 Click on the measured line path.

The measurement and unit appear in a value box entity on the current active 
markup layer. The measured distance, Delta-X, Delta-Y and the “Manhattan 
Distance” appear in the Measurement Entities dialog box. 

8 To resize the value box, select it and then click and drag the frame handles. 

Center-point Geometric snap mode where a snap box appears 
when moving the cursor near the center of an ellipti-
cal component.

Pin Electrical snap mode where a snap box appears 
when the cursor touches a pin.

Via origin Electrical snap mode where a snap box appears 
when the cursor touches a via.

Symbol origin Electrical snap mode where a snap box appears 
when the cursor touches the entire component.

Free snap Allows snapping at any point on the drawing.

Button Snap to Description
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Note: Click Reset to take another measurement.
9 Click Close to close the Measurement Entities dialog box

Measuring Cumulative Distance
Use the Cumulative Distance option to measure the distance along a path of 
multi-faceted (adjoining) points.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Distance.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  EDA Snapping Modes

3 From the Measured Distance Units list, select the unit that you want to 
measure the distance.

4 Select Cumulative.
5 Click the first entity to define the starting point.
6 Continue clicking points along the path that you want to measure.

Each point is joined by a line. 
7 Right-click to complete the measurement.

The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The measured distance, Delta-X, Delta-Y 
and the “Manhattan Distance” appear in the Measurement Entities dialog 
box. 
Note: Click Reset to take another measurement.

8 Click Close to close the Measurement Entities dialog box.

Calibrating Distance
1 Measure the distance between two points or measure cumulative distance.

See  Measuring Distance
2 In the Measurement Entities dialog box, click Calibrate.
3 The Distance Calibration dialog box appears displaying the measured 

distance.
4 In the Measured Distance list, select the unit to which you want to calibrate 

the distance.
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5 Select Calibrate to and enter a value if you want to calibrate the distance to 
a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

6 Click OK. 
The calibration result appears in the Measurement Entities dialog box.

7 Click Close to close the Measurement Entities dialog box.

Measuring Area
Use the Area option to measure the area and perimeter of a region.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Area.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Area .
2 Select Between Points if you want to measure the area between points on a 

drawing. Snapping modes are displayed.
Select the snapping modes that you want to use for measuring.
To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  EDA Snapping Modes

3 Select Shape if you want to measure the area of a predefined shape on the 
drawing. 

4 From the Measured Area Units list, select the unit in which you want to 
measure the area.

5 From the Perimeter Units list, select the unit in which you want to measure 
the perimeter.

6 To cumulate a Net Area Result of different areas, select Add in the 
Measurement Entities dialog box. 
To subtract an area from the Net Area Result, select Subtract. 
Select Clear to clear the Net Area Result field.

7 If you selected Between Points, click points on the drawing to define the 
area. 
Each point is joined by a line and the measurement appears in the 
Measurement Entities dialog box.

8 If you selected Shape, click the edge of a predefined shape on the drawing.
The shape is highlighted.

9 Right-click to complete the measurement.
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The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The area and perimeter measurements 
appear in the Measurement Entities dialog box.
Note: Click Reset to take another measurement.

10 Click Close to close the Measurement Entities dialog box.

Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Angle.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Angle .
2 Select From 3 Points if you want to measure the angle between three points. 

Snapping modes are displayed. 
Select the snapping modes that you want to use for measuring.
To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  EDA Snapping Modes

3 Select Between 2 lines if you want to measure the angle between two lines. 
4 From the Measured Angle Units list, select the unit in which you want to 

measure the angle.
5 If you selected From 3 Points, click three points to define the angle.

If you selected Between 2 Lines, click two lines to define the angle.
Angle arms appear with an arc connecting them. 

6 Right-click to complete the measurement. 
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The measured angle appears in the 
Measurement Entities dialog box.

7 To change the size of the arc, click and drag the it to the desired size.
8 To move the value box, click and drag it to anywhere on the drawing.
9 To resize the value box, select it and then click and drag the frame handles. 

Note: Click Reset to take another measurement.
10 Click Close to close the Measurement Entities dialog box.

Measuring an Arc
Use the Arc option to define an arc in the drawing and measure its radius, center 
and diameter.
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1 From the Markup menu, select Add entity, select Measurement, and then 
select Arc.
The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Arc .
2 Select From 3 Points if you want to measure the arc between three points. 

Snapping modes are displayed. 
Select the snapping modes that you want to use for measuring.
To select all snapping modes, click All On. To deselect all snapping modes, 
click All Off.
See  EDA Snapping Modes

3 Select Arc Entity if you want to measure a predefined arc. 
4 From the Arc Info list, select the unit in which you want to measure the 

distance of the arc.
5 From the Measured Angle Units list, select the unit in which you want to 

measure the angle.
6 Select Add Radius if you want measure the radius.

Select Add Diameter if you want to measure the diameter.
7 If you selected From 3 Points, click three points to define the arc.

The points are joined by an arc.
If you selected an Arc Entity, click an edge of the arc.
The arc is highlighted.

8 Click to complete the measurement.
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer.The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle and sweep 
appear in the Measurement Entities dialog box.

9 To move the value box, click and drag it to anywhere on the drawing.
10 To resize the value box, select it and then click and drag the frame handles. 

Note:  Click Reset to take another measurement.
11 Click Close to close the Measurement Entities dialog box.

Calibrating an Arc
1 Measure an arc in the drawing.

See  Measuring an Arc
2 In the Measurement Entities dialog box, click Calibrate.

The Distance Calibration dialog box appears displaying the measured 
distance.
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3 From the Measured Rad. list, select the unit to which you want to calibrate 
the distance.

4 Select Calibrate to and enter a value if you want to calibrate to a value.
Select Set Factor and enter a value if you want to calibrate by a factor.

5 Click OK. 
The calibration result appears in the Measurement Entities dialog box.

6 Click Close to close the Measurement Entities dialog box.

Measuring Minimum Distance
Use the Minimum Distance option to measure the minimum distance between 
entities. The available entities for snapping are nets, pins, vias and traces.
1 From the Markup menu, select Add entity, select Measurement, and then 

select Minimum Distance.
The Measurement Entities dialog box appears.
Note: From the Markup Entity toolbar, you can also click Minimum 

Distance .

2 Click  First Set to select the entities that you want to measure from.
3 Select the snapping modes that you want to use for measuring.

See  EDA Snapping Modes
Note: If you select Net, you cannot select any other type of entity.

4 Click the first set of entities on the drawing.
The entities are highlighted.
Note: To clear the last set of entities you selected, click Clear Set.

5 Click  Second Set to select the entities that you want to measure to.
6 Click the second set of entities on the drawing.

The entities are highlighted in a different color.
7 From the Measured Min. Distance list, select the unit in which you want to 

measure the distance.
8 Select Zoom to Result, if you want to zoom in on the measured value on the 

drawing.
9 Click Compute.

The minimum distance from the first set of entities to the second set is 
highlighted by a line. The measured line path, measurement and unit appear 
in a value box entity on the current active markup layer. The measurement, 
Delta-X, Delta-Y, and the Manhattan Distance appear in the Measurement 
Entities dialog box.

10 To move the value box, click and drag it to anywhere on the drawing.
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11 To resize the value box, select it and then click and drag the frame handles. 
Note: Click Reset to take another measurement.

12 Click Close to close the Measurement Entities dialog box.

Adding Text
With AutoVue, you can add a text box entity to a markup.
1 From the Markup menu, select Add Entity, and then select Text.

Note: From the Markup Entity toolbar, you can also click Text .
2 Click and drag on the drawing to define the dimensions of the text box.
3 Click in the text box and enter the text you want to add.

Note: The height of the text box will adjust to accommodate the text.
4 To change text box font properties, from the Markup menu, select Format, 

and then select Font.
The Font dialog box appears allowing you to change the font type, style, and 
size.
Note: From the respective font property lists on the Markup Properties 
toolbar, you can also modify the font type, style, and size.

5 Click OK to implement the font changes and to close the Font dialog box.
6 To change the line properties or fill color of the text box, select the text box, 

then from the Markup menu, select Format, and then select the property or 
properties you want to change.
Note: From the respective line property lists on the Markup Properties 
toolbar, you can also modify the line style, line thickness, fill types, and fill 
colors.

7 Right-click outside the text area to complete the modification.
The text appears on the drawing and in the Markup Navigation Tree.

8 To move the text box click and drag it. 
9 Click and drag the frame handles of the text box to enlarge it.

Note: To edit the text, double-click the text box in the tree or in the 
workspace.

To hide the box surrounding the text:
1 Select the text box entity.
2 From the Markup menu, select Format, and then select Markup Entity 

Attributes.
The Markup Entity Properties dialog box appears.

3 From the Text Box Visibility list, select OFF.
4 Click OK.
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The dialog box closes and the text box is hidden. 
To undo, repeat steps 1 through 4, except select ON.

Adding a Note
You can attach longer comments as a markup sticky note on the drawing. A note 

displays in the workspace as a standard size graphical symbol . Each note is 
labelled as Note<n>—where n represents the numerical order of occurrence of 
the note (for example, the first note is labelled as Note1). To read the note, 
double-click the entity to open it or move the mouse over the entity to display the 
tooltip.
1 From the Markup menu, select Add Entity, and then select Note.

Note: From the Markup Entity toolbar, you can also click Note .
2 Click a point on the document where you want to insert the note. 

The Note applet appears.
3 Enter the text that you want in the note.
4 To change the default font, select Font and the type of font.
5 From the File menu, select Information.

The Note Information dialog box appears.
6 In Name, Author and Key Words fields, enter the required text for the note.
7 Click OK.
8 Close the Note applet.

The note appears on the drawing and in the Markup Navigation Tree.
9 Right-click outside the note area to complete the modification.
10 To move the note, click and drag it.

Note: To edit a note, double-click the note symbol  in the Markup 
Navigation Tree or in the workspace to open the Note dialog box.

Nesting Markup Entities
You can add the Attachment, Hyperlink, or Note markup entities as a nested child 
to any markup entity.
1 Add a markup entity to a 2D file (for example, a Line entity).
2 From the workspace or Markup Tree, select the Line entity.
3 From the Markup menu, select Attachment, Hyperlink, or Note.
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Note: From the Markup Entity toolbar, you can also click Attachment , 

Hyperlink , or Note .
In the Markup Tree, the selected markup entity appears as a child of the Line 
(parent) entity.

3D-Specific Markups
When marking up 3D files, you can attach text or a note, as well as create markup 
measure entities. The measure options in Markup mode work slightly different 
than in View mode.
Note: When you are creating a markup entity, you can press the Escape key to 
cancel.

See Also  Marking up 2D and 3D Files

3D Markup Entities
You can create many different types of markup entities. To access the markup 
entities, from the Markup menu, select Add Entity. 
The markup entities are:

Option Description

Note: To complete a markup entity (for example, to finish creating a box), simply 
right-click in the AutoVue workspace.

Text Add text to the markup.
From the Markup Entity toolbar, you can also click 3D Text 

.

See  Adding Text

Attachment Add an attachment entity to the markup.
From the Markup Entity toolbar, you can also click Arc 

.
See  Adding an Attachment
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Hyperlink Click the workspace to attach a hyperlink.
From the Markup Entity toolbar, you can also click Hyper-

link .
See  Adding a Hyperlink

Intellistamp Add a stamp on a document in a connected and discon-
nected environment. Includes specific document and 
user information (metadata) pulled directly from the 
DMS/ERP/PLM/UCM system.
From the Markup Entity toolbar, you can also click Intellis-

tamp .
Refer to the AutoVue Mobile User Manual.

Measurement Create markup measure entities.
From the Markup Entity toolbar, you can also click Distance 

, Area , Angle , Arc , or Minimum Distance 

.
See  Creating 3D Markup Measure Entities

Note Add a note to the markup.
From the Markup Entity toolbar, you can also click Note 

.
See  Adding a Note

Signoff Create an approval stamp containing information about the 
markup author, date and time of creation.
From the Markup Entity toolbar, you can also click Signoff 

.
See  Adding Signoff Entities

Stamp Click and drag a stamp to the markup.
From the Markup Entity toolbar, you can also click Stamp 

.
See  Adding a Stamp

Option Description
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Creating 3D Markup Measure Entities
When marking up 3D files, you can create markup measure entities. The measure 
options in Markup mode work slightly different than in View mode.
When measuring in Markup mode, the specified measurement lines and values 
are displayed on the current active markup layer as entities. These entities can be 
moved, resized, or deleted.
Note: If you manipulate a part of a model, the measure entity values do not 
update accordingly.
AutoVue provides the option to “snap” to different entity types on the model.
In Markup mode, you can choose from several measurement options to create 
markup measure entities. From the Markup menu, select Add Entity, and then 
select Measurement to access the following measure options:

Name Description

Angle Measure the precise angle between three vertices or any two 
edges, planes or faces.
From the Markup Entity toolbar, you can also click Angle 

.

Arc Measure the precise radius, length and angle of any arc and 
calculate the center point location.
From the Markup Entity toolbar, you can also click Arc 

.

Distance Measure the precise distance between any two Vertex, Edge, 
Midedge, Arc Center or Face.
From the Markup Entity toolbar, you can also click Distance 

.

Minimum Distance Measure minimum distance between any two Vertex, Edge, 
Midedge, Arc Center or Face.
From the Markup Entity toolbar, you can also click Mini-

mum Distance .
Note: You cannot create a markup measure entity when 
measuring minimum distance.
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3D Snapping Modes
The snapping modes available allow you to select or snap to different entity 
types on a model. For example, if you select Vertex, all vertices are highlighted 
and when you move the cursor over a vertex, a snap box appears.
The snapping modes allow you to snap to vertices, edges, faces, planes, and arcs.

Measuring Distance
Use the Distance option to measure the precise distance between two vertices, 
edges, mid-edges, arc centers, faces, or any combination of entity types.
Note: When measuring the distance between faces, if the faces are parallel, 
AutoVue compares the shortest distance between the parallel faces.
1 From the Markup menu, select Add Entity, and then select Distance.

The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Distance .
2 From the Measured Distance Units list, select the unit in which you want to 

measure the distance.
3 Select the snapping modes that you want to use for measuring.

Vertex Coordinates Provide the coordinates of each vertex.
From the Markup Entity toolbar, you can also click Vertex 

Coordinates .

Button Snap to Description

Vertex Vertices are highlighted on the model.
When moving the cursor over a vertex, a snap box 
appears.

Edge Edges are highlighted on the model.
When moving the cursor over an edge, a snap box 
appears. 

Face Faces are highlighted when you move the cursor 
over a face and a snap triangle appears.

Name Description
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See  3D Snapping Modes
All entities of the selected entity types are highlighted on the model.

4 On the model, select the entity you want to measure from.

The location of the entity appears in the From  field.
Note: If you want to take more than one measurement from the same 
starting point, select the Fix Position check box.

5 Click inside the To  field to select the entity type that you want to 
measure to.

6 Select the snapping modes that you want to select as the end point for the 
measurement.
All entities of the selected entity types are highlighted on the model.

7 On the model, select the entity you want to measure to.

The location of the entity appears in the To  field.
8 Click again to complete the measurement.

The measured line path appears in a value box entity on the current active 
markup. The measured distance, Delta-X, Delta-Y and Delta-Z appear in the 
Measurement Entities dialog box.

9 Drag to move the measured line path.
10 Click on the measured line path.
11 To move the value box, click and drag it to anywhere on the drawing.
12 To resize the value box, select it and then click and drag the frame handles. 

Note: Click Reset to take another measurement.
13 Click Close to close the Measurement Entities dialog box.

Calibrating Distance
1 Measure the distance between to points.

See  Measuring Distance
2 In the Measurement Entities dialog box click Calibrate.
3 The Distance Calibration dialog box appears displaying the measured 

distance.
4 In the Measured Distance list, select the unit to which you want to calibrate 

the distance.
5 Select Calibrate to and enter a value if you want to calibrate the distance to 

a value.
Select Set Factor and enter a value if you want to calibrate the distance by a 
factor.

6 Click OK. 
Oracle Corp.



AutoVue 239
The calibration result appears in the Measurement Entities dialog box.
7 Click Close to close the Measurement Entities dialog box.

Measuring an Angle
Use the Angle option to measure the precise angle between three vertices, any 
two edges, planes or faces or any combination of entity types.
1 From the Markup menu, select Add Entity, and then select Angle.

The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Angle .
2 Select the snapping modes that you want to use for measuring.

See  3D Snapping Modes
All entities of the selected entity types are highlighted on the model.

3 To measure the angle between an entity type and a plane, select the With 
Plane check box. From the Plane list, select the plane.

4 From the Measured Angle Units list, select the unit in which you want to 
measure the angle.

5 On the model, click points to define the angle.
Angle arms appear with an arc connecting them. 

6 Click again to complete the measurement.
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The measurement appears in the 
Measurement Entities dialog box.

7 To change the size of the arc, click and drag it to the desired size.
8 To move the value box, click and drag it to anywhere on the markup.
9 To resize the value box, select it and then click and drag the frame handles. 

Note: Click Reset to take another measurement.
10 Click Close to close the Measurement Entities dialog box.

Measuring an Arc
Use the Arc option to measure the precise radius, length and angles of any arc on 
the model. It also calculates the center point location.
1 From the Markup menu, select Add Entity, and then select Arc.

The Measurement Entities dialog box appears.

Note: From the Markup Entity toolbar, you can also click Arc .
2 Select Arc Entity if you want to measure a predefined arc.
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All arc and circles are highlighted on the model. Snapping modes are 
disabled.

3 Select From 3 Points if you want to measure the arc between three points. 
Snapping modes are displayed.
Select the snapping modes that you want to use for measuring.
See  3D Snapping Modes
All entities of the selected entity types are highlighted on the model.

4 From the Dist. Units list, select the unit in which you want to measure the arc 
distance.

5 From the Angles Units list, select the unit in which you want to measure the 
angle.

6 If you selected From 3 Points, click three points to define the arc.
The points are joined by an arc.
If you selected Arc Entity, click the edge of an arc.
The arc is highlighted.

7 Click to complete the measurement.
The measured line path, measurement and unit appear in a value box entity 
on the current active markup layer. The measurements for center point 
coordinates, radius, diameter, arc length, start and end of angle and sweep 
appear in the Measurement Entities dialog box.

8 To move the value box, click and drag it to anywhere on the markup.
9 To resize the value box, select it and then click and drag the frame handles. 

Note: Click Reset to take another measurement.
10 Click Close to close the Measurement Entities dialog box.

Calibrating an Arc
1 Measure an arc on the model.

See  Measuring an Arc
2 In the Measurement Entities dialog box, click Calibrate.

The Calibration dialog box appears displaying the measured distance.
3 From the Measured Rad. list, select the unit to which you want to calibrate 

the distance.
4 Select Calibrate to and enter a value if you want to calibrate to a value.

Select Set Factor and enter a value if you want to calibrate by a factor.
5 Click OK. 

The calibration result appears in the Measurement Entities dialog box.
6 Click Close to close the Measurement Entities dialog box.
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Measuring Minimum Distance
With the Minimum Distance option you can measure the minimum distance 
between model parts, as well as any two points from the selection sets: vertices, 
edges, mid-edges, arc centers, faces or any combination of entity types.
1 From the Markup menu, select Add Entity, and then select Minimum 

Distance.
The Measurement Entities dialog box appears.
Note: From the Markup Entity toolbar, you can also click Minimum 

Distance .

2 Click  Set 1.
3 Select Entity if you want to measure the distance between model parts. 

Snapping modes are displayed.
Select Geometry if you want to measure the distance between entity types. 

4 If you selected Entity, select a part or parts on the model.
The model part or parts appear in the list under Set 1 and are highlighted on 
the model and in the Model Tree.

5 If you selected Geometry, select the snapping modes that you want to use 
for measuring.
See  3D Snapping Modes
All entities of the selected entity type are highlighted on the model.

6 Select the entity or entities on the model.
The selected entities appears in the list under Set 1 and are highlighted on 
the model.
Note: To reset a Set, click Clear. To clear items from a Set, select the items 
and press the Delete key. To deselect a part or entity type on the model, press 
the Control key and left-click the part or entity type.

7 Click  Set 2.
8 Repeat steps 4 through 6.

The model part appears in the list under Set 2.
9 From the Measured Min. Distance Units list, select the unit in which you 

want to measure the distance.
10 Click Compute.

The minimum distance from the first set of entities to the second set is 
highlighted by a line. The measured line path, measurement and unit appear 
in a value box entity on the current active markup layer. The X, Y and Z 
coordinates for Position 1 and X, Y and Z coordinates for Position 2 appear 
in the Measurement Entities dialog box.
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11 Click and drag the value box anywhere on the markup.
12 To resize the value box, select it and then click and drag the frame handles. 

Note: Click Reset to take another measurement.
13 Click Close to close the Measurement Entities dialog box.

Measuring Vertex Coordinates
The Vertex Coordinates option provides the coordinates of vertices on the 
model.
1 From the Markup menu, select Add Entity, and then select Vertex 

Coordinate.
The Measurement Entities dialog box appears.
Note: From the Markup Entity toolbar, you can also click Vertex 

Coordinate .
Note: All vertices on the model are highlighted.

2 Scroll over the vertex whose coordinates you want to add to the markup.
The X, Y, and Z coordinates appear in a tooltip.

3 Click the vertex.
The X, Y, an Z coordinates and unit appear a value box entity on the current 
active markup layer and in the Measurement Entities dialog box.

4 Click and drag the value box anywhere on the markup.
Click and drag the frame handles to enlarge the value box.
Note: Click Reset to take another measurement.

5 To remove the highlighted vertices on the model, click Close in the 
Measurement Entities dialog box. 

Adding Text 
With AutoVue, you can add a 3D text box entity to a markup.
1 From the Markup menu, select Add Entity, and then select Text.

Note: From the Markup Entity toolbar, you can also click 3D Text .
2 The Attach To dialog box appears and provides six snapping options:

Option Description

None Does not snap to the model.

Vertex Snaps to a vertex on the model.
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3 To insert a text box that snaps to a part of the drawing with a leader line, 
select one of the snapping modes. 
See  3D Snapping Modes

4 Click and drag on the drawing to define the dimensions of the text box.
5 Click in the text box and enter the text you want to add.

Note: The height of the text box will change to accommodate the text.
6 To change text box font properties, from the Markup menu, select Format, 

and then select Font.
The Font dialog box appears allowing you to change the font type, style, and 
size.
Note: From the respective font property lists on the Markup Properties 
toolbar, you can also modify the font type, style, and size.

7 Click OK to implement the font changes and to close the Font dialog box.
8 To change the line properties or fill color of the text box, select the text box, 

then from the Markup menu, select Format, and then select the property or 
properties you want to change.
Note: From the respective line property lists on the Markup Properties 
toolbar, you can also modify the line style, line thickness, fill types, and fill 
colors.

9 Right-click outside the text area to complete the modification.
The text appears on the drawing and in the Markup Navigation Tree.

10 To move the text box, click and drag it to anywhere on the drawing. 
11 To resize the text box, select it and then click and drag the frame handles. 

Note: To edit the text, double-click the text box in the tree or in the 
workspace.

Edge Snaps to an edge on the model.

Face Snaps to a face on the model.

Mid Edge Snaps to the middle of an edge on the model.

Ar Center Snaps to the center point of an arc on the model.

Option Description
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Attaching a Note
You can attach longer comments as a markup sticky note on the drawing. A note 

displays in the workspace as a standard size graphical symbol . Each note is 
labelled as Note<n>—where n represents the numerical order of occurrence of 
the note (for example, the first note is labelled as Note1). To read the note, 
double-click the entity to open it or move the mouse over the entity to display the 
tooltip.
1 From the Markup menu, select Add Entity, and then select Note.

The Attach To dialog box appears.

Note: From the Markup Entity toolbar, you can also click Note .
2 In the Attach To dialog box, click the entity type that you want to attach the 

note to.
See  3D Snapping Modes

3 Select the entity on the model that you want to attach a note to. 
The Note applet appears.

4 Type the text that you want in the applet.
5 From the File menu, select Information.

The Note Information dialog box appears.
6 To change the default font, select Font and the type of font.
7 Close the Note applet.

The note symbol appears on the entity and in the Markup Navigation Tree.
8 Right-click outside the note area to complete the modification.

Note: To edit a note, double-click on the note.
Note: Whenever an entity is attached to a 3D model, the anchor point (the point 
at which the entity is attached) is highlighted by a small square. The square is 
visible only when the anchor point is visible. This feature allows you to precisely 
identify the location of the anchor point and whether the associated entities are 
visible or hidden.

Nesting Markup Entities
You can add the Attachment or Hyperlink markup entities as a nested child to any 
markup entity.
1 Add a markup entity to a 3D file (for example, a Text entity).
2 From the workspace or Markup Tree, select the Text entity.
3 From the Markup menu, select Attachment or Hyperlink.
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Note: From the Markup Entity toolbar, you can also click Attachment  

or Hyperlink .
In the Markup Tree, the selected markup entity appears as a child of the Text 
(parent) entity.

Working with Markup Entities
With AutoVue, you can assign a markup entity its own color, the same color as 
the current active layer, or a custom color. You also have the option of grouping 
markup entities. When you group markup entities, you can manage the group as 
you would a single entity. 
In Markup mode, there are several options for modifying an entity. You can apply 
these options to selected pre-existing entities or to new entities that you add. 
Note: You can edit certain markup entities after they have been created. To do 
so, in the Markup Navigation Tree, right-click the markup entity and then select 
Edit.

See  Go To a Markup Entity
Selecting Markup Entities
Moving a Markup Entity
Transforming Markup Entities
Hiding Markup Entities
Grouping and Ungrouping Markup Entities
Deleting Markup Entities

Go To a Markup Entity
Go To restores the view state to when an entity was first created. Opening an 
existing Markup file also restores the last saved view state.
From the Markup Navigation Tree, right-click the markup entity that you want to 
view and select Go To. 
AutoVue displays the markup page containing the entity.
If you selected a markup entity that is on another page of the Markup file, the 
page containing that entity will be displayed.
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Selecting Markup Entities
To select a markup entity, click the markup entity’s outer edge. 
Note: To select multiple entities, press the Shift or Control key while selecting.
The markup entity or entities are selected. You can also select the markup entities 
from the Markup Navigation Tree. To select multiple entities, press the Shift or 
Control key while selecting.

Moving a Markup Entity
• In the Markup Navigation Tree or in the workspace, select the markup entity 

or entities that you want to move. 
Note: To select multiple entities, press the Shift or Control key while 
selecting.
See  Selecting Markup Entities

• In the workspace, click and drag the selected markup entity or entities to 
anywhere in the workspace. 

Transforming Markup Entities
Note: This menu option is only available for 2D and EDA files.
AutoVue provides the option to flip or rotate markup entities. 

Rotating all Markup Entities
From the Markup menu, select Transform, and then select Rotate. From the 
menu that appears, you have one of two options to select from:
• Rotate Clockwise: Rotates the markup entity 90 degrees in the clockwise 

direction.
• Rotate Counter Clockwise: Rotates the markup entity 90 degrees in the 

counter-clockwise direction.
Note: The markup entities rotate with respect to the center point of the drawing.

Rotating a selected Markup Entity
Note: This feature only supports the Text and Stamp markup entities.
1 From the workspace or the Markup Navigation Tree, select the markup 

entity to rotate. 
Note: It is not possible to select multiple markup entities to rotate.
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2 From the Markup menu, select Object, and then select Rotate.
3 Rotate the markup entity by clicking and dragging its control points. 

Pressing the Shift key will dragging with snap the rotation to 45 degree 
intervals.

Flipping all Markup Entities
From the Markup menu, select Transform, and then select Flip. From the menu 
that appears, you have one of two options to select from:
• Flip Horizontal Axis: Flips the direction of the horizontal axis of the 

markup entity.
• Flip Vertical Axis: Flips the direction of the vertical axis of the markup 

entity.
Note: The horizontal and vertical axes are aligned with the center of the 
drawing.

Hiding Markup Entities
To hide all markup entities, do the following:
1 From the Markup menu, select Hide Markups.

Note: A check mark appears next to the Hide Markups option and the 
markup entities are hidden on the Markup file.

2 To undo the hide option, from the Markup menu, deselect Hide Markups.
To hide selected a Markup file, do the following:
3 In the Markup Navigation Tree, right-click the Markup file, then select 

Hide.
4 To undo the hide option, right-click the file name again and select Show.

Grouping and Ungrouping Markup Entities
When you group markup entities, you can move, delete, copy and paste, 
transform, or perform any modification on the group of entities that you would 
on a single markup entity.
Note: You can only group markup entities created on the same page. 

Grouping Markup Entities
1 In the Markup Navigation Tree or from the workspace, select the markup 

entities that you want to group.
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See  Selecting Markup Entities
2 From the Markup menu, select Object, and then select Group.

The group of entities appear in the tree under Group.
Note: You can also right-click the selected markup entities and then select 
Group.

3 Perform any modifications.
The modifications are applied to all the entities in the group.

Ungrouping Markup Entities
1 In the Markup Navigation Tree or the workspace, select the group that you 

want to ungroup.
2 From the Markup menu, select Object, and then select UnGroup.

The group of entities appear on the markup as individual entities.

Deleting Markup Entities
1 Select the markup entity that you want to delete. To select multiple markup 

entities, press the Shift or Control keys while selecting.
See  Selecting Markup Entities

2 From the Markup Properties toolbar, click Delete Markups .
The selected entity or entities are deleted from the current active file.
Note: You can also press the Delete key to delete the markup entities. 
Alternatively, right-click the entity in the workspace or Markup Navigation 
Tree, and select Delete.

Formatting Markup Entity Proper-
ties
With AutoVue, you can modify the formatting of a markup entity via the Format 
option from the Markup menu, or via the Markup Entity Properties dialog box.

See Also  Using the Markup Entity Properties Dialog Box
When creating a markup entity, you have the option to change the line color, line 
style, line thickness, arrow style, fill color, and fill type. Additionally, you can 
assign the markup entity the same color as the layer. 

See  Changing Line Color
Changing Line Style
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Changing Line Thickness
Changing Arrow Style
Changing Fill Type
Changing Fill Color
Assigning a Markup Entity the Same Color as the Layer

Changing Line Color
1 Select the markup entity or entities for which you want to change the line 

color.
See  Selecting Markup Entities

2 From the Markup menu, select Format, and then select Line Color.
The Line Color dialog box appears.
Note: From the Markup Properties toolbar, you can also click Line Color 

. Alternatively, right-click the entity in the workspace or Markup 
Navigation Tree, select Format, and then select Line Color.

3 From the Line Color list, select the color that you want for the entity.

Note: Selecting Bylayer  changes the markup entity color to the color 
of the layer.

4 To define a custom line color, from the Line Color list, select Custom Color 

.
5 From the Color dialog box that appears, select a color and click OK.
6 Click OK to close the Line Color dialog box.

The line color changes for the selected markup entity or entities.
Note: Any new entities that you create will have the new line color.

Changing Line Style
Note: The current line style is highlighted in the Line Style option.
1 Select the markup entity or entities for which you want to change the line 

style.
See  Selecting Markup Entities

2 From the Markup menu, select Format, and then select Line Style. Select 
the new line style from the options provided. The line style changes for the 
selected markup entity or entities.
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Note: From the Markup Properties toolbar, you can also click Line Style 

. Alternatively, right-click the entity in the workspace or Markup 
Navigation Tree, select Format, and then select Line Style.
Note: Any new entities that you create will have the new line style.

Changing Line Thickness
Note: The current line thickness is highlighted in the Line Thickness option.
1 Select the markup entity or entities for which you want to change the line 

thickness.
See  Selecting Markup Entities

2 From the Markup menu, select Format, and then select Line Thickness. 
Select the new line thickness from the options provided. The line thickness 
changes for the selected markup entity or entities.
Note: From the Markup Properties toolbar, you can also click Line 

Thickness . Alternatively, right-click the entity in the workspace or 
Markup Navigation Tree, select Format, and then select Line Thickness.

3 To define a custom line thickness, from the Markup menu, select Format, 
select Line Thickness, and then select Customize.
The Custom Thickness dialog box appears.

4 In the Line Thickness field, enter an integer value in pixels.
5 Click OK to close the Custom Thickness dialog box.

Note: Any new markup entities that you create will have the new line 
thickness.

Changing Arrow Style
AutoVue gives you the option to add an arrow head to certain markup entities. 
For example, you can change the arrow style of the line, polyline, arc, freestyle, 
and polygon markup entities.
1 Select the markup line entity or entities for which you want to change the 

arrow style.
See  Selecting Markup Entities

2 From the Markup menu, select Format, and then select Arrow Style. 
Select the new arrow style from the options provided. The arrow style 
changes for the selected markup line entity or entities. 
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Note: From the Markup Properties toolbar, you can also click Arrow Style 

. Alternatively, right-click the entity in the workspace or Markup 
Navigation Tree, select Format, and then select Arrow Style.
Note: Any new entities that you create will have the new arrow style.

Changing Fill Type
1 Select the markup entity or entities for which you want to change the fill 

type.
See  Selecting Markup Entities

2 From the Markup menu, select Format, and then select Fill Type.
The Fill Type dialog box appears.
Note: From the Markup Properties toolbar, you can also click Fill Type 

. Alternatively, right-click the entity in the workspace or Markup 
Navigation Tree, select Format, and then select Fill Type.

3 From the Fill Type list, select the fill type that you want for the markup 
entity:
•   Select Solid Fill, if you want the fill color to be solid.
•   Select Transparent Fill, if you want the fill color to be transparent.
•   Select No Fill, if you do not want any fill color.

4 Click OK. 
The fill type changes for the selected markup entity or entities.
Note: Any new markup entities that you create will have the new fill type.

Changing Fill Color
1 Select the markup entity or entities for which you want to change the fill 

color.
See  Selecting Markup Entities

2 From the Markup menu, select Format, and then select Fill Color.
The Fill Color dialog box appears.
Note: From the Markup Properties toolbar, you can also click Fill Color 

. Alternatively, right-click the entity in the workspace or Markup 
Navigation Tree, select Format, and then select Fill Color.

3 From the Fill Color list, select the color that you want for the markup entity.
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Note: Selecting Bylayer  changes the markup entity color to the color 

of the layer and selecting Line Color  assigns the same color as the 
markup entity’s line.

4 To define a custom line color, from the Line Color list, select Custom Color 

.
5 From the Color dialog box that appears, select a color and click OK.

The fill color changes for the selected markup entity or entities.
6 Click OK to close the Fill Color dialog box.

Note: Any new markup entities that you create will have the new fill color.

Assigning a Markup Entity the Same Color 
as the Layer
1 Select the markup entity or entities for which you want to assign the color of 

the layer that they belong to.
See  Selecting Markup Entities

2 To assign the line color:
•   From the Markup menu, select Format, and then select Line Color.

The Line Color dialog box appears.
Note: From the Markup Properties toolbar, you can also click Line Color 

. Alternatively, right-click the entity in the workspace or Markup 
Navigation Tree, select Format, and then select Line Color.

•   From the Line Color list, select Bylayer .
3 To assign the fill color:

•   From the Markup menu, select Format, and then select Fill Color.
The Fill Color dialog box appears.

Note: From the Markup Properties toolbar, you can also click Fill Color 

.

•   From the Fill Color list, select Bylayer .
4 Click OK.

The selected markup entity or entities change to the color of the layer that 
the entity belongs to.
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Changing Font
You can change the font of the text box, leader, and measurement entities.
1 Create the markup entity that you want.
2 From the workspace or the Markup Navigation Tree, select the markup 

entity for which you want to modify the font then do one of the following:
•   From Markup menu, select Format, and then select Font. The Font 

dialog box appears. From the lists select the font, font style, and font size. 
You also can select to add a strikeout and underline by selecting their 
check boxes. Click OK to the close the dialog box and implement the 
changes.

•   From the Markup Entity toolbar, select the font, font size, and font style 
(bold, italic, and underline) from their respective lists and buttons. The 
font changes are implemented. 

Changing Measurement Units and 
Symbols
You can change the unit of measure and add a symbol to a measurement and have 
it appear on the drawing.
1 Create the markup measure entity that you want.

See  Creating 2D non-Vector Markup Measure Entities
Creating 2D Vector Markup Measure Entities
Creating EDA Markup Measure Entities
Creating 3D Markup Measure Entities

2 Double-click the measurement that you want to change the unit of measure 
or add a symbol to. 
The appropriate Measure dialog box appears.

3 Deselect Display Unit check box if you want to hide the unit on the 
drawing. It is selected by default.

4 From the Units list, select the unit that you want to change the measurement 
to.

5 From the Symbol list, select the symbol that you want to add to the 
measurement.

6 Click OK.
The unit of measure changes and the selected symbol is added to the 
measurement and appears in the workspace.
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Using the Markup Entity Properties 
Dialog Box
You can use the Markup Entity Properties dialog box to modify markup entities. 
7 Select the markup entity you want to modify. To select multiple markup 

entities, press the Shift or Control key while selecting.
8 From the Markup menu, select Format, and then select Markup Entity 

Attributes.
The Markup Entity Properties dialog box appears.
Note: You can also right-click a markup entity in the Markup Navigation 
Tree or the workspace, select Format, and then select Markup Entity 
Attributes.

The following sections describe each option available in the Markup Entity 
Properties dialog box.

Line Color
Change the line color the selected markup entity or entities.
1 Select the markup entity or entities for which you want to change the line 

color.
See  Selecting Markup Entities

2 From the Line Color list, select the color that you want for the entity.

Note: Selecting Bylayer  changes the entity color to the color of the 
layer.

3 Click OK to close the Markup Entity Properties dialog box.
To define a custom line color, take the following steps:

1 From the Line Color list, select Custom Color .
The Color dialog box appears.

2 Select a color and click OK.
3 Click OK to close the Markup Entity Properties dialog box.

The line color changes for the selected markup entity or entities.
Note: Only selected markup entities that you create will have the new line color. 
To apply the new line color to any new markup entity you create, make sure no 
markup entity is selected before opening the Markup Entity Properties dialog 
box.

See Also  Changing Line Color
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Line Style
Change the line style for a selected markup entity or entities.
1 Select the markup entity you want to change the line style. To select multiple 

markup entities, press the Shift or Control key while selecting.
See  Selecting Markup Entities

2 From the Line Style list, select the required line style.
3 Click OK to close the Markup Entity Properties dialog box.

The line style changes for the selected markup entity or entities.
Note: Any new markup entities that you create will have the new line style.
See Also  Changing Line Style

Line Thickness
Change the line thickness for a selected markup entity or entities.
1 Select the markup entity you want to change the line thickness. To select 

multiple markup entities, press the Shift or Control key while selecting.
See  Selecting Markup Entities

2 From the Line Thickness list, select the required line thickness.
The line thickness changes for the selected markup entity or entities.

To define a custom line thickness, take the following steps:
1 From the Line Thickness list, select Customize.
2 In the Width (Pixels) field, enter the desired width.
3 Click OK to close the Markup Entity Properties dialog box.

The line thickness changes for the selected markup entity or entities.
Note: Any new markup entities that you create will have the new line 
thickness.
See Also  Changing Line Thickness

Width (Pixels)
Customize the line thickness when Customize is selected in the Line Thickness 
list. When other line thicknesses are selected, this field displays its value in 
pixels but cannot be edited.

See  Line Thickness
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Arrow Style
Add an arrow head at one or both ends of a markup line entity.
1 Select the markup line entity you want to change the arrow style. To select 

multiple markup line entities, press the Shift or Control key while selecting.
2 From the Arrow Style list, select the style of arrow that you want for the 

markup line entity. 
3 Click OK to close the Markup Entity Properties dialog box.

The arrow style changes for the selected markup line entity or entities.
Note: Any new markup line entities that you create will have the new arrow 
style.
See Also  Changing Arrow Style

Fill Type
Change the transparency for selected markup entity or entities.
1 Select the markup entity you want to change the fill type. To select multiple 

markup entities, press the Shift or Control key while selecting.
2 From the Fill Type list, select the fill type that you want for the markup 

entity:
•   Select Solid Fill, if you want the fill color to be solid.
•   Select Transparent Fill, if you want the fill color to be transparent.
•   Select No Fill, if you do not want any fill color.

3 Click OK to close the Markup Entity Properties dialog box.
The fill type changes for the selected markup entity or entities.
Note: Any new markup entities that you create will have the new fill type.
See Also  Changing Fill Type

Fill Color
Change the line color, fill color, and fill type for a selected markup entity or 
entities.
1 Select the markup entity you want to change the fill color. To select multiple 

markup entities, press the Shift or Control key while selecting.
2 From the Fill Color list, select the color that you want for the markup entity.

Note: Selecting Bylayer  changes the markup entity color to the color 
of the layer.

To define your own color, take the following steps:
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1 From the Fill Color list, select Custom Color .
The Color dialog box appears.

2 Select a color and click OK.
The fill color changes for the selected markup entity or entities.

3 Click OK to close the Markup Entity Properties dialog box.
The fill type changes for the selected markup entity or entities.
Note: Any new markup entities that you create will have the new fill color.
See Also  Changing Fill Color

Markup Layers
You can move selected markup entities to a specific layer—the markup entities 
will inherit the properties of the layer.
1 From the Markup Layer list, select the layer you want to make active.
2 Click OK to close the Markup Entity Properties dialog box.

The selected layer appears in the workspace.
See Also  Setting the Active Markup Layer

Leader Alignment
With the Leader markup entity, you can adjust the location of the leader line’s 
anchor point to the text box. The Leader Alignment list has the following option 
for anchor point location with respect to the text box: Top Left, Top Center, Top 
Right, Center Left, Center, Center Right, Bottom Left, Bottom Center, and 
Bottom Right.

Text Box Visibility
You can choose to hide the surrounding box for the Leader, Text, and 3D Text 
markup entities.
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Printing
With AutoVue, you can print and preview files. Original files can be printed on 
their own or with associated markups and overlays. You can also choose which 
markup layers to make visible so that they can print. 
With the Batch Print option, you can send a list of files to print at the same time.
When printing a file, there are print properties that you can define.From the File 
menu, select Print to display the following properties:

Print Options
From the Options tab of the Print Properties dialog, you can define options for 
the printed file.

Option Description

Print Define the print options.
See   Configuring the Print Options

Margins Define the margin settings.
See  Setting the Margins

Headers/Footers Define the headers/footers to be included on every page 
printed.
See   Adding a Header and Footer

Watermark Define the watermark to be included on every page printed.
See  Adding a Watermark

Pen Settings Change the thickness assigned to a pen.
See   Creating a New Pen Setting

Option Type Description

Printer Modify Select a printer and configure print proper-
ties, such as paper size, number of copies, and 
so on.

Paper size Displays selected paper size.
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Orientation • Portrait - Specify if file should be 
printed portrait 

• Landscape - Specify if the file should 
be printed landscape

• Auto - Specify if orientations should be 
printed as saved in the file
Note: Option is available with Java 2 
and is only enabled for PDF and word 
documents.

Units Select a unit from the drop-down list to set 
the unit for Scaling and Alignment/Off-
set. The available units are pixels, inches and 
millimeters.

Scaling Fit to Page Scales the image to fit on the output page.

Factor Scales the image according to the scaling fac-
tors that you have manually entered in the 
input fields.

Scale Scales the image according to a percentage. 
You can select a predefined scaling factor or 
manually enter a custom scaling factor.
Note:  Decimal places are accepted.

Alignment/Offset Specify where the drawing will appear on the 
printout. Some of the available options are 
Top-Left, Center-Right, Bottom-Center, and 
so on.
Note: You can define custom alignment by 
entering a X and Y value.

Document Pages Specify the document pages to print: All, 
Current or Range.

Page Area Select the page area to print.

Extents Print the extent of the document.

Displayed Print the area displayed in the View window.
Note: Option is only enabled when Current 
is selected for Document Pages.

Option Type Description
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Limits Prints the file limits instead of extents.
Note: Option is only enabled when Current 
is selected for Document Pages.

Selected Print selected area. When option is selected, 
the select button is enabled allowing you to 
select an area on the drawing.
Note: Option will only be enabled when 
Current is selected for Document Pages.

Force to Black Force all colors to black.

High Resolution Prints the file with more definition.
Note:  AutoVue Web Version is based on 
Java 1.1 to make it compatible with the 
current browsers. One drawback with Java 
1.1 is its limited support for printing -- the 
print resolution is limited to 72 dpi. AutoVue 
implements and delivers this limited print 
capability as part of the package. Oracle has 
identified the need for higher resolution and 
has implemented a solution for High 
Resolution and Large Format printers/ 
plotters output for client machines running on 
a Windows platform.

Output a single page Limits output to a single page when the scal-
ing options selected causes a single page to 
span over several pages.

Print Row Headers Print row headers.
Note: Option is only enabled for 
spreadsheets, archive and database files.

Print Column Head-
ers

Print column headers.
Note: Option is only enabled for 
spreadsheets, archive and database files.

Partial Preview Display a view of the printer page, highlight-
ing the printable area.

Option Type Description
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Configuring the Print Options
1 From the File menu, select Print.

The Print Properties dialog box appears.

Note: From the AutoVue toolbar, you can also click Print .
2 Click the Options tab.
3 Configure the print options.
4 Configure other print properties.
5 To view a partial view of the file, click Partial Preview. 

The Partial Preview dialog box appears.
See  Partial Preview of a File

6 Click OK to print.
The Print dialog box appears indicating the document is printing.

Print Margins
From the Margins tab of the Print Properties dialog, you can define the top, 
bottom, right and left margins for the printed file. You can define:

Setting the Margins
1 From the File menu, select Print.

The Print Properties dialog box appears.

Note: From the AutoVue toolbar, you can also click Print .
2 Click the Margins tab.
3 Enter the margin that you want for Left, Top, Right, and Bottom or click 

Minimum if you want to set the margins to the minimum acceptable for the 
selected printer.
Note: When you click Minimum, the minimum margins allowable 
automatically appear in the Margins.

Option Description

Margins Set the value for the Left, Top, Right, and Bottom margins.

Minimum Set the acceptable minimum margins for the selected printer.

Units Specify the unit for the margins.
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4 From the Units list, select the unit in which you want to set the margins at.
5 Configure other print properties.
6 To view a partial view of the file, click Partial Preview. 

The Partial Preview dialog box appears.
See  Partial Preview of a File

7 Click OK to print.
The Print dialog box appears indicating the document is printing.

Headers/Footers
From the Headers/Footers tab of the Print Properties dialog, you can define 
the headers and footers that you want to print on every page of the document. 
You can enter the text manually or choose from a list of Insert Codes.
The list of insert codes are:
• %f: Full path of document
• %v: Document Drive
• %d: Document Directory
• %b: Document Base name
• %e: Document file extension
• %n: Total document pages
• %p: Current page number
• %N: Total tiled-pages
• %P: Current tile number
• %Y: Date: Year
• %M: Date: Month
• %D: Date: Day
• %W: Date: Day of week
• %H: Time: Hour
• %U: Time: Minute
• %S: Time: Seconds
• %r: New line
• %F: Native Print Settings (Excel)
Note: A literal percentage mark is entered manually as %%.
You can also print system variables in headers and footers. Select a variable from 
the Insert Variable list. Some Insert Variable options are: user.name, browser 
and java.home.
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Adding a Header and Footer
In the Headers/Footers tab, you can manually enter text or choose from a list of 
Insert Codes to appear in the headers and footers. You can also print system 
variables.
1 From the File menu, select Print.

The Print Properties dialog box appears.

Note: From the AutoVue toolbar, you can also click Print .
2 Click the Headers/Footers tab.
3 Click in the Left, Center or Right field and enter the text that you want to 

appear in the header and footer, or choose an Insert Code or Insert 
Variable.

4 To Insert Code in the header or footer, click Left, Center or Right, then 
select a code from the list.

5 To Insert Variable in the header or footer, click Left, Center or Right, then 
select a variable from the list.

6 To change the Font, click Set Font. The Font dialog box appears.
From the Font list, select the type of font.
From the Size list, select the size of font.
To set the font Style, click Bold or Italic or both, then click OK.

7 In the Print Properties dialog box, configure other print properties.
8 To view a partial view of the file, click Partial Preview. 

The Partial Preview dialog box appears.
See  Partial Preview of a File

9 Click OK to print.
The Print dialog box appears indicating the document is printing.

Native Print Settings
You can choose to include predefined headers and footers when printing an Excel 
file from AutoVue. 
1 From the Print Properties dialog box, click the Headers/Footers tab.
2 Under Headers and Footers, click inside the Left, Center and Right fields 

corresponding to the header or footer position in the original file.
3 Select %F: Native Print Settings (Excel) from the Insert Code list.
4 Click OK to print.

The Excel file’s headers and footers are printed.
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Watermarks
From the Watermark tab of the Print Properties dialog box, you can specify a 
watermark that will appear on a printed file. When printing a watermark, it 
appears transparent on the file contents. You can choose a horizontally or 
vertically oriented watermark.
In addition to entering text, you can:
• set the type, size and style of font
• insert Watermark information
• print system variables
To insert Watermark information, AutoVue provides a list of codes that you can 
choose from. These codes are:
• %f: Full path of document
• %v: Document Drive
• %d: Document Directory
• %b: Document Base name
• %e: Document file extension
• %n: Total document pages
• %p: Current page number
• %N: Total tiled-pages
• %P: Current tile number
• %Y: Date: Year
• %M: Date: Month
• %D: Date: Day
• %W: Date: Day of week
• %H: Time: Hour
• %U: Time: Minute
• %S: Time: seconds
• %r: New line
Note: A literal percentage mark is entered manually as %%.
You can also print system variables in watermarks. Select a variable from the 
Insert Variable list. Some Insert Variable options are: user.name, browser and 
java.home.

Adding a Watermark
1 From the File menu, select Print.

The Print Properties dialog box appears.
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Note: From the AutoVue toolbar, you can also click Print .
2 Click the Watermark tab.
3 Enter the Watermark Text that you want to appear on the file.

To insert a code in the watermark, select a code from the Insert Code list.
For example, if you select %n: Total document pages, the total number of 
pages for the selected file will appear in the Watermark.
Note: You can insert more than one code.

4 To insert a system variable, select a variable from the Insert Variable list.
For example, if you select browser.version, the version of the browser that 
the file is displayed in will appear in the Watermark.
Note: You can insert more than one system variable.

5 To set the orientation of the watermark, click Diagonal, Horizontal or 
Vertical.

6 To change the Font, click Set Font.The Font dialog box appears.
From the Font list, select the type of font.
From the Size list, select the size of font.
To set the font Style, click Bold or Italic or both, then click OK.

7 In the Print Properties dialog box, configure other print properties.
8 To view a partial view of the file, click Partial Preview. 

The Partial Preview dialog box appears.
See  Partial Preview of a File

9 Click OK to print.
The Print dialog box appears indicating the document is printing.

Assigning Pen Settings
From the Pen Settings tab of the Print Properties dialog box, you can set the 
thickness of the color indices for the print file.
Note: AutoVue uses the default pen color indices of the native document for the 
vector file being viewed. You will not be able to change the color assigned to a 
pen with AutoVue.
1 From the File menu, select Print.

The Print Properties dialog box appears.

Note: From the AutoVue toolbar, you can also click Print .
2 Click the Pen Settings tab.
3 Under From/To, select the Color Index for which you want to assign a new 

pen thickness.
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Note: To change more than one color indices, press the Shift or Control 
key while selecting.

4 From the Units list, select the unit that you want to set for the thickness.
5 Click Thickness. The Modify Pen Thickness dialog box appears.

Enter the new thickness, then click OK.
The new Thickness appears beside the Color Index.
Note: To reset the thickness, click Reset.

6 In the Print Properties dialog box, configure other print properties.
7 To view a partial view of the file, click Partial Preview. 

The Partial Preview dialog box appears.
See  Partial Preview of a File

8 Click OK to print.
The Print dialog box appears indicating the document is printing.

Creating a New Pen Setting
1 Set the thickness for the color indices that you want.
2 Click Save As. The Save As dialog box appears.

Enter a pen Name for your pen setting, then click OK.
The new pen setting appears in the Current Pen Settings list.

3 In the Print Properties dialog box, click OK to print.
The Print dialog box appears indicating the document is printing.

Deleting a Pen Setting
1 Select the pen setting that you want to delete from the Current Pen 

Settings.
2 Click Delete.

The pen setting disappears from the list.
3 Click Cancel to close the Print Properties dialog box.

Partial Preview of a File
The Partial Preview dialog box displays the printable area on top of the page area 
so that users can have a clear idea of what will be printed.
Note: Option is only enabled when Current is selected from Document Pages.
1 Configure the print properties.
2 Click Partial Preview in the Print Properties dialog box.
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The Partial Preview dialog box appears.The Partial Preview dialog box 
highlights the area that will be printed. The Paper size, Printable Area and 
Drawing Area are displayed.

3 Click OK to close the Partial Preview dialog box.

Previewing a File Before Printing
You can preview a print copy of the current active file on screen according to 
your printer’s capabilities and the print property settings.
1 View the file in AutoVue.
2 From the File menu, select Print.

The Print Properties dialog box appears.

Note: From the AutoVue toolbar, you can also click Print .
3 Configure the print properties.
4 Click OK.

The file appears in Print Preview Mode in the Print Preview window.
Note: You can print the file from the Print Preview window by clicking 
Print. You can also zoom in and out of a file, as well as navigate from one 
page to another of a multi-page file.

5 Click Close to close the Print Preview window.

Printing a File
In AutoVue you can print original files along with their Markup files and selected 
Markup layers together so that they appear as one file.
1 Open the file you want to print in AutoVue.

To print the associated Markups, open the Markup file(s) you want to print.
2 If you are printing Markup file(s) and you want to print the visible layers, 

from the Markup menu, select Markup Layers.
The Markup Layers dialog box appears.

3 Select the Markup layers you want visible.
4 Click OK to close the Markup Layers dialog box.
5 From the File menu, select Print.

The Print Properties dialog box appears.

Note: From the AutoVue toolbar, you can also click Print .
6 Configure the print properties.
7 To view a partial view of the file, click Partial Preview. 
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The Partial Preview dialog box appears.
See  Partial Preview of a File

8 Click OK to print.
The Print dialog box appears indicating the document is printing.
See Also  Previewing a File Before Printing

Toggling between Markup Layers

Batch Printing
The Batch Print option lets you send a list of files to print at the same time. You 
can also generate a batch by simultaneously opening all the files included in the 
batch print.
1 From the File menu, select Batch Print.

The Batch Print dialog box appears.
2 To add a file to the List of Files to be Printed, click Add. The File Open 

dialog box appears.
Enter a file name or click Browse to locate the file you want to add, then 
click OK.
The files appears in the List of Files to be Printed.
Note: To add more files to the list, repeat steps 2 to 4. To remove a file, 
select the file from the List of Files to be Printed and click Remove.

3 Click Print in the Batch Print dialog box.
The Print Properties dialog box appears.

4 Configure the print properties.
5 Click OK to print.

The Print dialog box appears indicating the document is printing.
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Conversion
Sometimes you need to translate a file to be able to use it with an application it 
was not created from. AutoVue provides several conversion file formats for you. 

Conversion Options
Depending on the conversion type being performed, the available options in the 
Convert dialog box will vary. These options are:

Option Description

Color Depth Select an option from the list:
• 1 = Black and white
• 4 = 16 colors
• 8 = 256 colors
• 24 = True color
• auto = AutoVue selects the color depth that best 

matches the original file.

Convert to Format A list of all the possible types of output file formats 
currently available for conversion. The available formats 
are:
• CALS GP4
• Encapsulated Postscript (Raster)
• HP Laserjet Printer (HLP)
• PCX Bitmap
• PDF
• Run Length RLC File
• TIFF
• Windows Bitmap
• Compuserve GIF

Output Specify the name and path of the file in which the con-
version is to be stored.  This file is also known as the 
output file. You can use Browse to provide AutoVue 
with the file’s path.
Note: If writing onto an existing file, a warning 
message appears, asking if you want to overwrite the 
existing file.
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PDF
With AutoVue it is possible to convert Office, 2D and EDA formats to PDF. 
When converted from Markup Mode, markups are “burned” onto the PDF. 
When you open the PDF, you will see the base file along with all markups.

Sub-Format The Sub-Format list appears when you selected HP 
Laserjet Print, TIFF, or Compuserve GIF from the 
Convert to Format list. Specify the variety of convert-
to-format by selecting a sub-format.

Convert Region The area of the file to be converted. The available 
options are:
• Display - refers to the image to fit on the output 

page. 
For example, if you zoomed in on a particular 
region of the file, the zoomed portion of the file is 
converted.

• Extents - refers to the entire extents of the file.

Convert Pages The number of pages to be converted. The available 
options are:
• All - converts all pages.
• Current - converts the current page
• Range - converts the pages indicated in the range

X and Y Specify X and Y to define the resolution for the con-
verted file.
• X indicates the number of horizontal pixels
• Y is the number of vertical pixels for the current 

active file contents. 
At times, AutoVue will preset X and Y to match the 
specifications of the selected conversion file format. 
Other times, X and Y will be available and may be 
changed according to your preferences. Your selection 
here will not affect the current display but will affect the 
conversion file’s resolution.

Option Description
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X and Y
Three factors affect the resolution of an image: the type of image you are 
converting, the output device and the acceptable file size. High-resolution scans 
often require large files, causing longer processing and print time. Note that a 
high-resolution may not produce a better-quality printed image if your output 
device does not recognize the higher resolution information stored in the file. To 
keep file sizes manageable, select the lowest resolution that provides acceptable 
quality on your output device.
With some file types, the Size option appears giving you a choice between 
millimeters and inches. Page sizes can be selected from the Size list or you can 
customize page sizes by configuring the Initialization file. For more information, 
refer to the System Administration Guide.

Converting a File
1 From the File menu, select Convert.

The Convert dialog box appears.
Note: The Input area varies according to the type of file. A word-
processing file displays the file format; a raster file displays the file format 
and size; vector and database files display the size, file type and dimensions.

2 In the Save As field, enter the path and filename or click Browse to locate 
the directory where you want to save the converted file.
Note: If writing on to an existing file, the contents of the output file will be 
overwritten.

3 Specify the conversion options.
4 Click OK. The file is converted and appears in the specified directory.

Technical Drawing Page Sizes ISO Paper Format

A8.5” X 11.0” (216 mm X 279 mm) A4 285 mm X 198 mm

B11.0” X 17.0” (279 mm X 432 mm) A3 396 mm X 273 mm

C17.0” X 22.0” (432 mm X 559 mm) A2 570 mm X 396 mm

D22.0” X 34.0” (559 mm X 864 mm) A1 817 mm X 570 mm

E34.0” X 44.0” (864 mm X 1118 mm) A0 1165 mm X 817 mm
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Note: You can convert several selected pages of a multi-page file to a multi-
page TIFF.

Changing the Pen Settings
With AutoVue, you can specify a thickness for each pen color.
Note: This option only applies to vector files.
1 From the File menu, select Convert.

The Convert dialog box appears.
2 Click Pens.

The Pen Settings dialog box appears.
3 In the From/To section of the Pen Settings dialog box, select the Color 

Index for which you want to modify the thickness.
Note: To select more than one Color Index, press the Shift or Control keys 
while selecting.

4 From the Units list in the Change section of the Pen Settings dialog box, 
select the unit in which you want to set the thickness.

5 In the Thickness field, enter a thickness value.
6 Press the Enter key.

The new thickness value appears beside the selected Color Index in the 
From/To section of the Pen Settings dialog box.

7 To save the changes that you made, click Save As.
The Save As dialog box appears.

8 Enter a file name for the new pen settings.
9 Click OK.

The new pen settings are saved and appear in the Current Pen Settings list.
Note: To modify an existing pen setting, select the pen setting from the 
Current Pen Settings list, make the changes, then click Save.

10 Click OK to close the Pen Settings dialog box.
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AutoVue Mobile
AutoVue Mobile provides the ability to view and add markups to files in a 
disconnected environment. Whether you are travelling or need to share files with 
an external partner, you can still view files, markups, and add new markups. 
Additionally, when connected, you can update your backend DMS/PLM/ERP/
UCM system with edits you make offline.
Using the AutoVue Mobile feature in AutoVue, you can create a Mobile Pack (a 
"packaged" file that contains the base file, all the external resources—fonts, 
XRefs—needed to fully display the file, and existing markups for the file). The 
streaming files and renditions can also be included when creating the Mobile 
Pack.
Once a Mobile Pack is created, you can view your drawing and markups by 
viewing the Mobile Pack. You can create new markups, consolidate them with 
existing markups into one markup, or create a master Markup file that loads up 
automatically when you view the Mobile Pack.
In a disconnected environment, depending on the markup policy defined during 
Mobile Pack creation, you can add markups using AutoVue Desktop Version. 
Markup policies define whether or not users can create/save new or existing 
markups, modify/delete (DMS only) existing markups, or automatically upload 
markups.
When you have access to your backend system, from AutoVue Web Version, you 
can update all the markups into the backend system. These markups are imported 
into the system and are associated with the base file from which you originally 
created the Mobile Pack.
The following sections provide details on creating a Mobile Pack, creating 
markups in AutoVue Mobile, understanding markup policies, and updating 
Markup files from Mobile Pack.

Creating a Mobile Pack
The Mobile Pack includes the native file or streaming file, metadata, Intellistamp 
designs, all reference files (XRefs), and associated markups. Optionally, you can 
include renditions such as TIFF or PDF.
The following steps explain how to create a Mobile Pack for a file with attached 
Markup files:
1 Open the base file.
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2 From the AutoVue menu bar, select Collaborate, and then select Create 
Mobile Pack. 
The Create Mobile Pack dialog box appears. It displays the General and 
Advanced tabs, which contain the basic and advanced options for creating a 
Mobile Pack, respectively.
Click the General tab.

The following table lists the options available in the General tab:

Option Description

Base File Displays the file path of the base file.
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3 From the Select Resource File(s) box, select the resource files to include in 
the Mobile Pack.

4 From the Select Markup File(s) box, select the Markup files to include in 
the Mobile Pack.

5 If you wish to password protect the Markup files, select the Password check 
box next to the Markup file.
The Password dialog box appears.
a.  In the Password field, enter a password of any length and character. 
b.  In the Confirm Password field, re-enter the password.
c.  Click OK to close the Password dialog box.

6 To save the Mobile Pack locally, from the Output options, specify the 
location and name:
a.  Click Browse to locate the directory where you want to save, or in the 

Save As field, enter the file path.
b.  Specify a name for the Mobile Pack.

7 If you wish to send the Mobile Pack using your default e-mail client, select 
the E-Mail check box. 

8 If you wish to password protect the Mobile Pack, select the Password 
Protected check box.
The Password dialog box appears.
a.  In the Password field, enter a password of any length and character. 
b.  In the Confirm Password field, re-enter the password.
c.  Click OK to close the Password dialog box.

9 To select Advanced options such as including streaming file and setting an 
expiry date on the Mobile Pack, continue to the next step. 

Select Resource File(s) Lists all the fonts, XRefs, and other external resources that 
are used to fully display the base file.
As a default, all resource files are selected.

Select Markup File(s) Lists all Markup files associated with the base file.
You can password protect single or multiple Markup files. 

Output You can select the output location for the Mobile Pack, and 
also send the file using your default e-mail client.

Password Protected You can password protect the Mobile Pack. 

Option Description
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If you do not wish to modify advanced options, click Finish to complete 
Mobile Pack creation.

10 Click the Advanced tab.
Note: Depending on the Company Wide Policy settings, the Advanced tab 
options might be disabled. For more information on Company Wide Policy, 
refer to the Installation and Administration Manual.

The following table lists the options available in the Advanced tab:

Option Description

Publishing Lets you specify an expiry date for the Mobile Pack. After the 
expiry date, the content of the Mobile Pack will not be accessible. 
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11 If you wish to set an expiry date for the Mobile Pack, from the Publishing 
option, select the Expiry Date check box and then select a date. The Mobile 
Pack cannot be opened after this expiry date.

12 If you wish to include a streaming file, from the Streaming File option, 
select whether to include a native file or streaming file in the Mobile Pack.

13 If you wish, from the Rendition option, you can include a PDF or TIFF 
rendition in the Mobile Pack.

14 Click OK to complete Mobile Pack creation.
If you selected the E-Mail check box, your default e-mail client opens with 
the Mobile Pack (*.avp) as an attachment. Otherwise, the Mobile Pack is 
output to the specified location.

Viewing Mobile Packs
Mobile Packs are opened in the same way as ordinary files. Users have access to 
all the external reference files (XRefs), resource files, and markups bundled with 
the base file. Additionally, users have the option to modify existing markups or 
create new ones to be associated with the Mobile Pack.
You can open a Mobile Pack as you would open any other file in AutoVue:
1 From the AutoVue menu bar, select File, and then select Open. 

Streaming File Lets you choose to include the native file or the streaming file in the 
Mobile Pack.
There are certain limitations when loading streaming files:
• Streaming files do not support blocks and views options.
• Streaming file requirements change with each release of Auto-

Vue. As a result, a streaming file from a previous version of 
AutoVue cannot be loaded in the latest release.

• Streaming files are platform-specific. For example, a streaming 
file created on a Windows platform will not work on a UNIX 
platform, and vice versa.

Note: For 3D files, including the streaming file reduces the file size 
of the Mobile Pack. Also, since native files are not released, 
including the streaming file increases security.
See  Streaming File

Rendition Lets you choose to include a PDF or TIFF rendition in the Mobile 
Pack. 

Option Description
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The Open dialog box appears.
2 Browse to the location of the Mobile Pack (*.avp), and then select Open.
3 If the Mobile Pack is password-protected during creation, the Password 

dialog box appears. In the Password field, enter the password and then click 
OK.
The native file or streaming file opens in AutoVue with all associated XRefs, 
resource files, markups, and renditions. 

4 If the Rendition option is selected during the creation of the Mobile Pack, 
from the AutoVue menu bar, select Collaborate, and then select View 
Rendition from Mobile Pack.
The rendition appears in a new AutoVue window.
Note: It is not possible to add markups to a rendition.

5 If there are associated Markups files, the Markup Indicator icon  
appears in the status bar. To open the Markup files, click the Markup 

Indicator icon .

Note: From the menu bar, you can also click Open Markup(s) .
The Choose a New or an Existing Markup dialog box appears.

6 If you wish to create a new Markup file to include in the Mobile Pack, click 
Create a new Markup file.

7 If you wish to open Markup files included in the Mobile Pack, click Choose 
an existing Markup file, and then select the Markup files.

8 If the Markup file is password-protected during creation, The Password 
dialog box appears. In the Password field, enter the password and then click 
OK.

9 If you wish to import a Markup file from your local machine, click Import. 
The File Open dialog box appears. Select the Markup file and click Open.

Creating Markup Files
When marking up a Mobile Pack, you can create new markups or consolidate 
existing markups to a new markup. You cannot modify markups that are bundled 
during Mobile Pack creation.
To save a new Markup file with a Mobile Pack, do the following:
1 Create markups.

2 From the AutoVue toolbar, click Save Markup .
The Save Markup dialog box appears.
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3 Enter a name for the Markup file in the Name field. 
4 If you wish to password protect the Markup file, select the Password 

Protected check box.
5 If you wish to save the Markup file to a location on a local computer, click 

Export.
6 Click OK.
7 If you wish to send the updated Mobile Pack with your default e-mail client, 

from the AutoVue menu bar, select Collaborate, and then select Reply to 
Mobile Pack.
Your default e-mail client opens with the Mobile Pack (*.avp) as an 
attachment.

Defining Markup Policy
Markup policy defines a set of rules to determine certain restrictions and 
privileges for users of the Mobile Pack. If no markup policy is defined in the 
Mobile Pack, a default set of values are used. 
Note: The default markup policy file, MarkupPolicy.xml, can be found in the 
<AutoVue Web Version installation>\bin folder.
The following table explains the actions included in the markup policy, their 
default values, and which values can be modified.
Note: All the following actions can be combined with certain exceptions.

Action Description Default

SaveNewMarkup=
<TRUE|FALSE> 

If TRUE, new Markup file creation inside 
the Mobile Pack is allowed.
If FALSE, new Markup file creation inside 
the Mobile Pack is not allowed:
• For new/imported (local file) 

Markup file, Markup Save and 
Markup Save As are disabled.

• For an existing Markup file, 
Markup Save As is disabled.

TRUE
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SaveExistingMarkup=
<TRUE|FALSE>

If TRUE, the Markup file from the Mobile 
Pack is saved.
If FALSE, the Markup file from the 
Mobile Pack cannot be saved. The Markup 
Save command will be disabled for the 
existing Markup file.

TRUE

EditMarkup=
<TRUE|FALSE>

If TRUE, the Markup file can be edited.
If FALSE, the Markup file is opened as 
read-only. All manipulation commands at 
all levels—Markup file, markup layers, and 
markup entities—are disabled. 
Note: Setting EditMarkup=False is 
equivalent to the Hide Icon menu option. 

TRUE

DeleteMarkup=
<TRUE|FALSE>

Note: Only available for a Mobile 
Pack created with DMS files.
If TRUE, the Delete Markup menu option 
is enabled in the Markup File Open dialog 
box.
If FALSE, the Delete Markup menu option 
is disabled in the Markup File Open dialog 
box.

TRUE

OpenMarkup=
<TRUE|FALSE>

If TRUE, the Markup file is listed in the 
Markup File Open dialog box.
If FALSE, the Markup files is not listed in 
the Markup File Open dialog box.

TRUE

AutoOpenMarkup=
<TRUE|FALSE>

If TRUE, the Markup file opens 
automatically when opening the Mobile 
Pack.
If FALSE, the Markup file does not open 
automatically when opening the Mobile 
Pack.

FALSE

Action Description Default
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FilterAttrFromGUI.<G
UI>.<Prop>.<Value>=
<TRUE|FALSE>

If TRUE, the given property value is 
removed from the GUI definition.
If FALSE, the given property value is not 
removed from the GUI definition.
This action takes three parameters:
• GUI: GUI definition to be modified
• Prop: Property to be removed
• Value: Property value to be removed
Note: If no Value is specified, then the UI 
element that represents the given property 
in the GUI definition is removed.
For example:
<Action name="FilterAttr-
FromGUI.Edit.CSI_MarkupType.master" 
default="false">

FALSE

Action Description Default
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The following is an example of how to define a markup policy in XML. The 
actions are highlighted.

<MarkupPolicy>
<Action name="SaveExistingMarkup" default="true">
  <ExConditions>
    <OrOperator>
      <AndOperator>
        <AnyMarkupFileCondition Name="CSI_MarkupType" Value="master"/>
        <MarkupFileCondition name="CSI_MarkupType" value="consolidated"/>        
        <MarkupFileCondition name="CSI_DocAuthor" value="$CURRENT_USER"/>        
      </AndOperator>
      <NotOperator>
        <MarkupFileCondition name="CSI_DocAuthor" value="$CURRENT_USER"/>
      </NotOperator>
    </OrOperator>
  </ExConditions>
</Action>
<Action name="EditMarkup" default="true">
  <ExConditions>
    MarkupFileCondition name="Original" value="true"/>
  </ExConditions>
</Action>
<Action name="DeleteMarkup" default="true">
  <ExConditions>
    <OrOperator>
      <AndOperator>
        <AnyMarkupFileCondition name="CSI_MarkupType" value="master"/>
        <MarkupFileCondition name="CSI_MarkupType" value="consolidated"/>        
        <MarkupFileCondition name="CSI_DocAuthor" value="$CURRENT_USER"/>        
      </AndOperator>
      <NotOperator>
        <MarkupFileCondition name="CSI_DocAuthor" value="$CURRENT_USER"/>
      </NotOperator>
    </OrOperator>
  </ExConditions>
</Action>
<Action name="FilterAttrFromGUI.Edit.CSI_MarkupType.master" 
default="false">
  <ExConditions>
    <AnyMarkupFileCondition name="CSI_MarkupType" value="master"/>
  </ExConditions>
</Action> </MarkupPolicy>
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Updating from Mobile Pack
When you are finished working with the Mobile Pack, you can update your 
changes to the backend DMS/ERP/PLM/UCM system. You can synchronize all 
of the markups created in the Mobile Pack to your backend system. These 
markups will be associated with the file in the backend system from which you 
originally created the Mobile Pack.
To initiate the updating process, open the Mobile Pack and then do the following: 
1 From the Collaborate menu, select Update from Mobile Pack.

Note: If you are not connected to the backend system, you are prompted for 
your username and password.
The Update from Mobile Pack dialog box appears. It includes the Select 
Markup File(s) and Select Properties lists.

2 The Select Markup File(s) list displays the markups that can be imported 
back to the backend system. To select a Markup file to import, select the 
corresponding check box.

3 The Select Properties list displays new properties if a new Intellistamp is 
added. The modified value, original value, and current DMS value appear in 
their respective columns. The modified value contains the new Intellistamp 
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properties for the Mobile Pack. The original value contains the Intellistamp 
properties in the backend system when the Mobile Pack was created. The 
current DMS value lists current values in the backend system. 

4 To select a property to update, from the Select Properties list, select the 
corresponding check box.

5 Click Update.
The Markup files and attributes in the backend system updates from your 
local Mobile Pack.
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Real-Time Collaboration
The real-time collaboration option enables multiple users to review files 
interactively and simultaneously, thereby shortening the review process for 
documents.
Participants in a Collaboration Session assume different roles. Each 
Collaboration Session has a Host, a Controller and one or more users. These 
participants have varying privileges during the Collaboration Session.

Collaboration User Tree
When you are in a Collaboration Session, the bar on the left-hand side of the 
screen displays the Users tab, in addition to the tabs displayed when you are 
normally viewing a file. The Users tab displays the Username, the Layer Color 
representing the user, the In Session value and the user Status. 

The Host
The person who initiates the Collaboration Session is automatically the acting 
Host and Controller by default. The Host and Controller are not always the same 
person. The acting Host can assign another user to be the Host by selecting 
Assign Host from the Collaborate menu.
The Host is the only one who can save the Session Markup. When initiating a 
Collaboration Session, the Host can specify the Markup to open; the host can also 
open a Markup file during a session. The Host can invite other users to join the 
Collaboration Session during the session or at initiation of the session. 
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The Controller
The Controller is the person who controls the base file's view during the 
Collaboration Session. Other participants in the Collaboration Session can 
choose between displaying or hiding the Controller's View changes.
When a session is initiated, the Controller is also the Host. The Controller can 
change the base file anytime during the Collaboration Session. However, when 
the Controller is no longer the Host, opening a new file has to be approved by the 
acting Host.
At any time during a session, a participant who is not an Observer can request 
control of a Collaboration Session.

Lock
Any user who is not the Controller of the Collaboration Session can choose to 
display the Controller's View modifications on the base file and the other 
participants' modifications on the Markup file made during the Collaboration 
Session. To do so, from the Collaborate menu, select Lock View to Presenter, 

or from the Collaborate status bar, click Lock View to Presenter .
When you lock your view, the file displayed will have the same Configuration 
options the Controller has set in the Configure menu.
Note: For all users, except for the Controller, view options are disabled.
To unlock your view from the presenter’s, from the Collaborate menu, again 
select Lock View to Presenter, or from the Collaborate status bar, click Unlock 
View to Presenter .

Observer
Observers can take part in a Collaboration Session but cannot create Markup 
entities. They can observe and make comments in the Chat window. The Host 
can designate a user as an Observer when he invites him to the Collaboration 
Session. A user can also decide to take part as an Observer in the Collaboration 
Session by selecting Observer in the Join Session dialog box. There can be more 
than one Observer during a Collaboration Session.
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Open a File
The Controller is the only user who can open a file during a Collaboration 
Session. 
To open a URL, from the File menu, select Open URL. 
To open a local file, from the File menu, select Open Local File. 
The File Open dialog box appears, letting you specify the file to open. 
When AutoVue Web Version is integrated with a Document Management System 
(DMS), clicking Open URL opens a dialog box that lets you view a DMS file. 
You can work on this file opened through Open URL during the Collaboration 
Session. When the Host opens a URL, he or she is prompted to save the Session 
Markup from the Collaboration Session that was in session. When the Controller 
opens a URL, the Host still owns the Collaboration Session and is the only one 
who can save the Session Markup.

Pointer
The Pointer  is the cross-hair marker the Controller uses to point to a specific 
place in the file.

Session Information
The Session Information option is available from the Collaborate menu during 
a Collaboration Session. It displays the Session Subject (the name assigned to 
the Collaboration Session), the Session ID, the name of the base file viewed, the 
Host and the list of users participating.

Session Markup
This is the Markup file created during the Collaboration Session. All participants 
can add Markup entities to the Session Markup file.
Note: Only the Host can save the Session Markup. Save and Save As are 
disabled for all other users.
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Show Tracker
The Show Presenter Window option in the Collaborate menu is available to 
any user whose view is set to unlocked. When you select Show Tracker from the 
Collaborate menu, the Presenter Window appears displaying a bird's eye view 
of the base file viewed and the Markup changes done during the Collaboration 
Session.
When you use Show Presenter Window, you can simultaneously track the 
Controller's base file view changes and everyone's markup changes in the 
Presenter Window while your main window display remains unaffected by 
anyone’s modifications. It is like having a locked view and an unlocked view on 
hand at the same time.

Collaboration Session
The Collaborate menu provides you with a means to initiate a Collaboration 
Session or join an existing session. When you initiate a Collaboration Session, a 
session object is created on the server and you are the Host and Controller of the 
session. The Host owns the Session Markup and is the only one who can save it 
and open an existing Markup. The Host can also invite other users during a 
session.

Initiating a Collaboration Session
When you initiate a Collaboration Session, a session object is created on the 
server. The session object is maintained for the duration of the Collaboration 
Session. When you initiate a session from View mode, you are the Host and the 
Controller of the session.
1 From the Collaborate menu, select Start Collaboration Session.

The Initiate Session dialog box appears.
2 In the Session Subject field, enter a session name.
3 If you want to open a Markup for the Collaboration Session, click Browse. 

See  Opening a Markup While Initiating a Session
4 Select Public if you want the Collaboration Session visible to others who 

may want to join the session. 
Select Private if you want the Collaboration Session only visible to the 
participants.

5 If you want to set a password for the Collaboration Session, enter a 
Password, then enter it again to Confirm.
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Note: If you selected Private and chose not to set password, when you click 
OK, a confirmation dialog box appears asking if you are sure you do not 
want to set a password.

6 From the Users list, select the users that you want to invite.
Note: The Users list shows all users connected to the AutoVue server

7 Click Add.
The user you selected appears in the Invited list.
Note: To remove a user, select the user from the Invited list and click 
Remove.

8 To designate a user as an Observer, select the check box under Invited.
9 Click OK.

AutoVue goes into Collaboration mode and the session is started. The user 
or users that are invited receive a tooltip notification that he or she has been 
invited to join the session. The notification message indicates Session Name, 
File and Initiator.

Changing a User’s Layer Color of a 
Session
1 In the Initiate Session dialog box, click Layer Color.

The Layer Color dialog box appears.
2 Select a Layer Color from the list or select Let user choose if you want the 

user to choose their own color.
3 Click OK.

In the Initiate Session dialog box, the selected layers color appears beside the 
Username in the Invited list.

If you selected Let user choose, a custom color  appears beside the 
Username, indicating that the color can be changed By User.

Adding New Users to a Session
1 In the Initiate Session dialog box, click Add New.

The Add User dialog box appears.
2 Enter Username.
3 Select Observer if you want to designate the user as an Observer.
4 Select a Layer Color from the list or select Let user choose if you want the 

user to choose their own color.
5 Click OK.

The new user is added to the Invited list in the Initiate Session dialog box.
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Note: To add more than one user, repeat steps 1 to 5.

Opening a Markup While Initiating a 
Session
1 From the Collaborate menu, select Start Collaboration Session.

The Initiate Session dialog box appears.
2 Click Browse.

The Markup Files dialog box appears.
3 In the Select Markup File(s) list, select the check box beside the Markup that 

you want to open.
4 To import a Markup file, click Import.

The Select markup file to import dialog box appears.
5 Locate the file that you want to open.
6 Click Open.
7 Click OK in the Markup Files dialog box.
8 In the Initiate Session dialog box, select Session Markup if you want to 

open a Session Markup and keep the layer colors and markup entities from 
the Collaboration Session.

9 Click OK.
The selected Markup appears in the Initiate Session dialog box.

Opening a Markup During a Session
The Host can open Markups during a Collaboration Session. These Markups can 
be session markups created during Collaboration Sessions or any non-session 
Markup files.
1 During a Collaboration Session, from the Markup menu, select Open.

A confirmation dialog box appears, prompting you to save the current 
Session Markup.

2 Click Yes or No.
The Markup Files dialog box appears.

3 Select the check box beside the Markup that you want to open.
4 To import a Markup file, click Import.

The Select Markup File to Import dialog box appears.
5 Locate the file that you want to open.
6 Click Open.
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7 In the Markup Files dialog box, select Session Markup if you want to open 
a Session Markup and keep the layer colors and markup entities from the 
Collaboration Session.

8 Click OK.
The selected Markup appears in the Collaboration window.

Joining a Session
Note: If you do not want to receive any notifications to join Collaboration 
Sessions, from the Collaborate menu, select Do Not Disturb.
1 From the Collaborate menu, select Join Collaboration Session.

The Join Session dialog box appears.
2 From the Session ID list, select the active session you want to join.
3 Enter the Password if the Host has set one.
4 If you just want to be an Observer, select the check box.
5 If you want to select a layer color, click Layer Color.

The Layer Color dialog box appears.
Note: The Layer Color is disabled if the Host did not select Let user 
choose when initiating the Collaboration Session or when you are invited to 
join the session.

6 Select a color from the list.
7 Click OK.
8 Click OK in the Join Session dialog box.

You have joined the session.

Inviting Users During a Session
1 From the Collaborate menu, select Invite.

The Invite dialog box appears.
2 From the Online list, select the user or users that you want to invite.
3 Click Add.

The user or users you selected appears in the Invited list.
Note: You can add users that are going to join the session at a later time by 
clicking Add New and entering the Username.

4 Click OK.
The users receive a tooltip notification that he or she has been invited to join 
the session.
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Removing Users from a Session
1 From the Collaborate menu, select Invite.

The Invite dialog box appears.
2 From the Online list, select the user or users that you want to remove.
3 Click Remove.

The user or users you selected appear in the Online list.
4 Click OK.

The users receive a tooltip notification that he or she is no longer invited to 
the session. 

Assigning a Host During a Session
1 From the Collaborate menu, select Assign Host.

The Assign Host dialog box appears.
2 From the Users list, select the user that you want to assign as host.
3 Click OK.

The user you selected is now the host of the Collaboration Session.

Passing Control of a Session to Another 
User
When you initiate a Collaboration Session, you are the default Controller of the 
session until you relinquish control to another user. You may grant control to 
another user any time during the session. Once you grant control to another user, 
all other users will automatically lock their views to the new Controller.
1 From the Collaborate menu, select Pass Control.

The Grant Control dialog box appears.
2 From the Users list, select the user that you want to grant control to.
3 Click OK.

The user you selected has control of the Collaboration Session.

Saving a Session Markup
The Host owns the Session Markup and is the only one who can save it. 
1 At the end of the Collaboration Session, from the Markup menu, select 

Save As. 
The Save Markup File As dialog box appears.

2 Enter the Markup ID.
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Note: The Markup Information is optional.
3 Click OK.

The session Markup is saved and appears as a markup note entity with the 
control history and chat transcript.

Closing a Session
Only a Host can close a Collaboration Session.
1 From the Collaborate menu, select Close Collaboration Session.

The Save Markup dialog box appears prompting you to save the Session 
Markup.

2 Click Yes.
All users are notified that the Collaboration Session is closed.

Requesting Control of a Session
1 From the Collaborate menu, select Request Control.

Note: From the Collaboration status bar, you can also click Request 

Control .
The Controller receives a message that you have requested control.

2 The Controller clicks OK.
 You become the Controller of the Collaboration Session.
Note:  If the Controller does not respond within 10 seconds, control is 
automatically granted to the user who requested it.

Tracking Changes
The Show Presenter Window option allows you to simultaneously track the 
Controller’s base file view changes and everyone’s markup changes while your 
markup file remains unchanged.
Note:  You must be in an unlocked view state before selecting Show Presenter 
Window.
From the Collaborate menu, select Show Presenter Window.
You can now track changes without affecting your view. 

Unlocking a View
If you do not want to see the Controller’s view changes, clear the Lock View.
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1 From the Collaborate menu, and click Lock View to Presenter.
The Lock View to Presenter option is deselected. 

Note: From the Collaborate status bar, you can also click Unlock View .
2 From the Collaborate menu, select Show Presenter Window if you want to 

simultaneously track the Controller’s base file view changes and everyone’s 
markup changes while your markup file remains unchanged.
You can now track changes without affecting your view. 
Note: The Show Presenter Window option is only available when the view 
is unlocked.

Locking a View
The Lock View to Presenter option allows you view changes the Controller is 
making. When you select the Lock View to Presenter option, you are also 
propagating your markup modifications to the other participants in the session.
Note: Lock View to Presenter is the default for all participants in a session.
1 From the Collaborate menu, select Lock View to Presenter

Note: From the Collaborate status bar, you can also click Lock View to 

Presenter . 
The Lock View to Presenter option is highlighted.

Viewing Session Information
1 From the Collaborate menu, select Session Information.

The Session Information dialog box appears displaying the Session Subject, 
Session ID, File Name, Host, and Users of the session.

2 Click OK.

Leaving a Session
Only a Host can close a Collaboration Session. All other participants can leave a 
Collaboration Session and rejoin at a later time if it is still in session. 
From the Collaborate menu, select Leave Collaboration Session.
The other participants are notified that you left the Collaboration Session and 
AutoVue returns to View mode.
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Chat Window
The Chat Window, is a tool you can use to communicate with other users. You 
send each other messages via the Chat Window. The Chat Window is also useful 
in giving you Collaboration Session updates such as which users are present and 
which users have joined or left the session.
At the end of the Collaboration Session, a transcript of the Chat Window is saved 
as a Note entity along with the Markup as the Collaboration Session Markup file. 
The Note entity contains session information such who the Host was, who was 
invited and session time and duration.
The Chat Window contains these menu options:

Sending a Message to Selected Users
1 From the Collaborate menu, select Show Chat Window.

The Chat dialog box appears.
Note: From the Collaborate status bar, you can also click Show Chat 

Window .
2 Select Selected users.

A list of Users appear in the Chat dialog box.
3 Under Users, select the user or users that you want to send the message to.

Menu Option Description

File Send Message Sends text messages to other users.

Print Prints the contents of the Chat window.

Quit Closes the Chat window.

Edit Copy Copy text from the Chat window.

Clear Clears all the text in the Chat window.

Find Text Searches for text in the Chat window.

Select All Selects the entire text in the Chat window.

Options Users Displays the users in the Collaboration Ses-
sion.
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Note: To select more than one user, press the Shift or Control key while 
selecting.

4 In the Send Message to field, enter your message.
5 Click Send.

The private message is sent to the selected users of the Collaboration 
Session.

Sending a Message to All Users
1 From the Collaborate menu, select Show Chat Window.

The Chat dialog box appears.
Note: From the Collaborate status bar, you can also click Show Chat 

Window .
2 Select All Users.
3 In the Send Message to field, enter your message.
4 Click Send.

The message is sent to all users in the Collaboration Session.
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Feedback
Oracle products are designed according to your needs. We would appreciate your 
feedback, comments or suggestions. Contact us by fax, e-mail or telephone. 
There is a feedback button on our Web page that activates an easy-to-use 
feedback form. Let us know what you think.

General Inquiries

Sales Inquiries

Customer Support

Telephone: +1 514-735-3219

Fax: (514) 735-6440

E-mail: info@cimmetry.com

Web Site: http://www.oracle.com/applications/autovue/index.html

Telephone: +1 514-735-3219 or 1-800-361-1904

Fax: (514) 735-6440

E-mail: sales@cimmetry.com

Telephone: +1 514-735-9941

Web Site: http://www.cimmetry.com/support
Oracle Corp.
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